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Welcome to This Guide

Welcome to TestDirector for Quality Center, the Mercury Web-based test 
management tool. Quality Center helps you organize and manage all phases 
of the application testing process, including specifying testing requirements, 
planning tests, executing tests, and tracking defects.

Throughout the testing process, Quality Center projects are accessed by 
many users—including developers, testers, and quality assurance managers. 
In order to protect, maintain, and control information in a testing project, 
users are assigned to groups with different access privileges. Only a Quality 
Center project administrator (belonging to the TDAdmin user group) has 
full privileges in a Quality Center project.

As a Quality Center site administrator, you use Site Administration to create 
and maintain Quality Center domains and projects; manage Quality Center 
users, connections, and licenses; define database servers; and modify 
Quality Center configurations.

As a Quality Center project administrator, you use Project Customization to 
customize project entities and lists, set up user groups and permissions, 
configure mail, set traceability notification rules, and configure the 
workflow in the Quality Center modules.

Quality Center is shipped without any passwords defined. To protect your 
testing data from unauthorized access, it is highly recommended that you 
set passwords early in the Quality Center process.
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How This Guide is Organized

The Quality Center Administrator’s Guide provides information regarding 
the administration, maintenance, and customization of Quality Center. 

It contains the following parts:

 Part I Site Administration

Describes how the site administrator uses Site Administration to manage 
Quality Center projects. This includes maintaining projects, users, 
connections, licenses, servers, configuration parameters, and site analysis.

 Part II Project Customization

Describes how the project administrator uses the Project Customization 
window to control access to a project by defining the project users and their 
privileges. It also describes how to customize a project to meet the specific 
needs of the project users.

 Part III Workflow Customization

Describes how to create workflow scripts to customize the Quality Center 
user interface and to control the actions that users can perform.

 Part IV Appendix

Describes how to use Quality Center Checker, a diagnostic tool that tests 
many of the Quality Center server components that Quality Center uses. 
Running the Quality Center Checker can pinpoint the cause of many server 
side problems associated with accessing Quality Center.
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Documentation Library

The Documentation Library is an online help system that describes how to 
use Quality Center. You can access the Documentation Library in the 
following ways:

➤ Click Documentation Library in the Quality Center Help menu to open 
the Documentation Library home page. The home page provides quick 
links to the main help topics.

➤ Click Help on this page in the Quality Center Help menu to open the 
Documentation Library to the topic that describes the current page.

Documentation Library Guides

The Documentation Library consists of the following guides and references, 
available online, in PDF format, or both. PDFs can be read and printed using 
Adobe Reader which can be downloaded from the Adobe Web site 
(http://www.adobe.com).

Getting Started explains how to use the Documentation Library and how it 
is organized. (Available online.)

What’s New? describes the newest features in the latest versions of Quality 
Center. You can also access the What’s New? from the Quality Center Help 
menu. (Available online and in PDF format.)

Readme provides last-minute news and information about Quality Center. 

Quality Center Guides:

Mercury Quality Center User’s Guide explains how to use Quality Center to 
organize and execute all phases of the testing process. It describes how to 
define requirements, plan tests, run tests, and track defects. (Available 
online and in PDF format.)

Mercury Quality Center Administrator’s Guide explains how to create and 
maintain projects using Site Administration, and how to customize projects 
using Project Customization. (Available online and in PDF format.)

http://www.adobe.com
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Mercury Quality Center Tutorial is a self-paced guide teaching you how to 
use Quality Center to manage the software testing process. (Available in PDF 
format.)

Mercury Quality Center Installation Guide explains how to install Quality 
Center on a server machine in a cluster environment or as a stand-alone 
application. (Available in PDF format.)

Business Process Testing Guides:

Mercury Business Process Testing User’s Guide explains how to use Business 
Process Testing to create business process tests. (Available online and in PDF 
format.)

Mercury Business Process Testing Tutorial provides a self-paced guide that 
teaches you the basics of Business Process Testing in the Quality Center 
application. (Available in PDF format.)

API References:

Mercury Quality Center Database Reference provides a complete online 
reference for the project database tables and fields. (Available online.)

Mercury Quality Center Open Test Architecture API Reference provides a 
complete online reference for the Quality Center COM-based API. You can 
use the Quality Center open test architecture to integrate your own 
configuration management, defect tracking, and home-grown testing tools 
with a Quality Center project. (Available online.)

Mercury Quality Center Site Administration API Reference provides a 
complete online reference for the Site Administration COM-based API. You 
can use the Site Administration API to enable your application to organize, 
manage, and maintain Quality Center users, projects, domains, 
connections, and site configuration parameters. (Available online.)

Mercury Quality Center Custom Test Type Guide provides a complete online 
guide on how to create your own testing tool and integrate it into the 
Quality Center environment. (Available online.)
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Additional Online Resources

The following additional online resources are available from the Quality 
Center Help menu:

Knowledge Base uses your default Web browser to open the Mercury 
Customer Support Web Site directly to the Knowledge Base landing page.

Customer Support Web Site uses your default Web browser to open the 
Mercury Customer Support Web site. This site enables you to browse the 
Mercury Support Knowledge Base and add your own articles. You can also 
post to and search user discussion forums, submit support requests, 
download patches and updated documentation, and more. The URL for this 
Web site is http://support.mercury.com. 

Mercury Home Page uses your default Web browser to open Mercury’s home 
page. This site provides the most up-to-date information on Mercury and its 
products. This includes new software releases, seminars and trade shows, 
customer support, educational services, and more. The URL for this Web site 
is http://www.mercury.com. 

Add-ins Page opens the Mercury Quality Center Add-ins Page which offers 
integrations with Mercury testing tools as well as third-party, 
synchronization, and version control tools. For more information, refer to 
the Mercury Quality Center Installation Guide.

In addition, you can refer to Mercury Best Practices which contains 
guidelines for planning, creating, deploying, and managing a world-class IT 
environment. Mercury provides three types of best practices: Process Best 
Practices, Product Best Practices, and People Best Practices. Licensed 
customers of Mercury software can read and use the Mercury Best Practices 
available from the Customer Support site, http://support.mercury.com.

http://support.mercury.com
http://www.mercury.com
http://support.mercury.com


Welcome

xiv

Documentation Updates

Mercury is continuously updating its product documentation with new 
information. You can download the latest version of this document from 
the Customer Support Web site (http://support.mercury.com). 

This option is required if access to the Documentation Library is set to local 
access (default setting). Alternatively, the Quality Center site administrator 
can configure live Web access to the Documentation Library. For more 
information, see “Configuring Web Access to the Documentation Library” on 
page 9.

To download updated documentation:

 1 In the Customer Support Web site, click the Documentation link.

 2 Under Please Select Product, select TestDirector for Quality Center.

Note that if TestDirector for Quality Center does not appear in the list, you 
must add it to your customer profile. Click My Account to update your 
profile.

 3 Click Retrieve. The Documentation page opens and lists the documentation 
available for the current release and for previous releases. If a document was 
updated recently, Updated appears next to the document name.

 4 Click a document link to download the documentation.

http://support.mercury.com
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Typographical Conventions 

This guide uses the following typographical conventions:

UI Elements This style indicates the names of interface elements on 
which you perform actions, file names or paths, and 
other items that require emphasis. For example, “Click 
the Save button.”

Arguments This style indicates method, property, or function 
arguments and book titles. For example, “Refer to the 
Mercury User’s Guide.”

<Replace Value> Angle brackets enclose a part of a file path or URL 
address that should be replaced with an actual value. 
For example, <MyProduct installation folder>\bin.

Example This style is used for examples and text that is to be 
typed literally. For example, “Type Hello in the edit 
box.”

CTRL+C This style indicates keyboard keys. For example, “Press 
ENTER.”

Function_Name This style indicates method or function names. For 
example, “The wait_window statement has the 
following parameters:”

[ ] Square brackets enclose optional arguments.

{ } Curly brackets indicate that one of the enclosed values 
must be assigned to the current argument. 

... In a line of syntax, an ellipsis indicates that more items 
of the same format may be included. In a 
programming example, an ellipsis is used to indicate 
lines of a program that were intentionally omitted.

| A vertical bar indicates that one of the options 
separated by the bar should be selected.
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1
Site Administration at a Glance

Using Site Administration, you create and maintain Quality Center projects, 
users, and servers. You can also define site administrators and change site 
administrator passwords.

This chapter describes:

➤ Starting Site Administration

➤ Understanding Site Administration

➤ Defining Site Administrators

➤ Configuring Web Access to the Documentation Library

Starting Site Administration

Using Site Administration, you create and maintain your Quality Center 
projects. 

To start Site Administration:

 1 To start Site Administration, you can:

➤ Open your Web browser and type your Quality Center URL:
http://<Quality Center server name>[<:port number>]/qcbin 
For example, http://lab1:8080/qcbin. The Mercury Quality Center Options 
window opens. Click the Site Administration link.

➤ Alternatively, open your Web browser and type your Site Administration 
URL: http://<Quality Center server name>[<:port number>]/sabin
For example, http://lab1:8080/sabin.
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The first time you run Site Administration, files are downloaded to your 
workstation. Subsequently, Quality Center carries out a version check. If 
there is a newer version on the server, updated files are downloaded to your 
workstation. 

Note: To download files to your computer, you must log in with site 
administrator privileges. This applies if you are running Quality Center for 
the first time, upgrading to a newer version, or applying a service pack.

After the Quality Center version has been checked and updated if necessary, 
the Mercury Quality Center Site Administration Login window opens.

 2 In the User Name box, type the name of a user who is defined as a site 
administrator. The first time you log in to Site Administration, you must use 
the site administrator name that you specified during the installation of 
Quality Center. After you log in to Site Administration, you can define 
additional site administrators. For more information, see “Defining Site 
Administrators” on page 7.
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 3 In the Password box, type your site administrator password. The first time 
you log in to Site Administration, you must use the site administrator 
password that you specified during the installation of Quality Center.

To define or change the site administrator password, see “Changing 
Passwords” on page 79.

 4 Click Login. Site Administration opens.

Understanding Site Administration

As a Quality Center site administrator, you create and maintain Quality 
Center projects, users, and servers using Site Administration. Site 
Administration contains the following tabs:

➤ Click the Site Projects tab to manage your Quality Center projects. This 
includes adding new domains and projects, querying project data, restoring 
projects, renaming projects, and activating or deactivating projects. For 
more information, see Chapter 2, “Managing Quality Center Projects.”

You can also upgrade projects from a previous Quality Center version to the 
current version. For more information, see Chapter 3, “Upgrading and 
Migrating Projects.”

➤ Click the Site Users tab to add new users and define user properties, 
including changing passwords. For more information, see Chapter 4, 
“Managing Quality Center Users.”

➤ Click the Site Connections tab to monitor the users currently connected to a 
Quality Center server. For more information, see Chapter 5, “Managing User 
Connections and Licenses.”

➤ Click the Licenses tab to monitor the total number of Quality Center 
licenses in use and to modify the license key number. For more information, 
see Chapter 5, “Managing User Connections and Licenses.”

➤ Click the Servers tab to modify Quality Center server information, such as 
the log file and mail protocol. For more information, see Chapter 6, 
“Configuring Servers and Parameters.”
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➤ Click the DB Servers tab to manage your database servers. This includes 
adding a new database server, editing a server’s connection string, changing 
a server’s default administrator user name and password, and changing a 
user password. For more information, see Chapter 6, “Configuring Servers 
and Parameters.”

Note: If you are working with the Quality Center Starter Edition, the 
DB Servers tab is not available.

➤ Click the Site Configuration tab to modify Quality Center configuration 
parameters. For more information, see Chapter 6, “Configuring Servers and 
Parameters.”

➤ Click the Site Analysis tab to monitor the number of licensed Quality Center 
users connected to your projects at specific points over a period of time. For 
more information, see Chapter 7, “Analyzing Site Usage.”

Site Administration also includes the Tools button on the upper-right corner 
of the Site Administration window. Choose Migration Tool to migrate any 
projects you created in TestDirector to Quality Center. For more 
information, see Chapter 3, “Upgrading and Migrating Projects.”
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Defining Site Administrators

You can define Quality Center users as site administrators. Only users 
defined as site administrators can access Site Administration.

To secure the information in Site Administration, you should ensure that 
each user you add as a site administrator has a password defined. For more 
information, see “Changing Passwords” on page 79. 

To define site administrators:

 1 In Site Administration, click the Site Users tab.

 2 Click the Site Administrators button. The Site Administrators dialog box 
opens displaying the Site Administrators list.

To change the sort order of the Site Administrators list from ascending to 
descending, click the User Name or Full Name column heading. Click the 
column heading again to reverse the sort order.

You can search for a user in the Site Administrators list by typing the name 
of a user in the Find box, and clicking the Find button.
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 3 Click the Add Site Administrators button. The Quality Center Users list is 
displayed in the right pane.

 4 Select the users that you want to assign as site administrators. You can 
search for users by typing a search string in the Find box above the Users list, 
and clicking the Find button.

 5 Click the Add Selected Users button. The selected users are moved to the 
Site Administrators list in the left pane.

 6 To remove a site administrator from the Site Administrators list, select the 
user and click the Remove Selected Site Administrators button. Click OK to 
confirm. The user is removed from the Site Administrators list.

 7 To refresh the Site Administrators list or Users list, click the Refresh button 
above the appropriate list.
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Configuring Web Access to the Documentation Library

Users access the Documentation Library by choosing Help > Documentation 
Library. By default, Quality Center is set to local access and users are 
connected to the version installed on the Quality Center server machine. 
You can configure Quality Center to connect to the most updated version of 
the Documentation Library through the Web, from Mercury servers. 

To configure Web access to the Documentation Library:

 1 In Site Administration, click the Site Configuration tab. For more 
information on the Site Configuration tab, see “Setting Quality Center 
Configuration Parameters” on page 107.

 2 Select the ACCESS_WEB_DOCUMENTATION parameter and click the Edit 
Parameter button. The Edit Parameter dialog box opens. 

 3 Change the value to Y and click OK.
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2
Managing Quality Center Projects 

Site Administration enables you to manage and maintain Quality Center 
domains and projects.

This chapter describes:

➤ About Managing Quality Center Projects

➤ Understanding the Quality Center Project Structure

➤ Creating Quality Center Domains

➤ Creating Quality Center Projects

➤ Copying Quality Center Projects

➤ Exporting and Importing Projects

➤ Updating Project Details

➤ Assigning Users to Projects

➤ Querying Project Tables

➤ Deactivating and Activating Projects

➤ Pinging Projects

➤ Renaming Projects

➤ Removing Projects

➤ Deleting Projects

➤ Deleting Domains
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➤ Editing the Connection String

➤ Restoring Access to Quality Center Projects

➤ Backing Up and Restoring Quality Center Projects

➤ Renaming the Defects Module for a Project

About Managing Quality Center Projects

Before you start working in Quality Center, you need to create a Quality 
Center project. A Quality Center project collects and stores data relevant to a 
testing process. You can create a Quality Center project that works on 
Oracle, Microsoft SQL, or Microsoft Desktop Engine (MSDE). You can either 
create an empty Quality Center project, copy the contents of an existing 
project to a new project, or import an exported Quality Center project file to 
a new project. You can also restore access to an existing project.

After you create a project, you can add and remove users from the project, 
query the contents of a project by defining and running SQL statements, 
and deactivate/activate access to a project. You can also migrate a project 
from TestDirector to the current version of Quality Center

Quality Center projects are grouped by domain. A domain contains a group 
of related Quality Center projects and assists you in organizing and 
managing a large number of projects.

Note: If you are working with the Quality Center Starter Edition:

➤ Only MSDE is supported.

➤ Only five users can connect concurrently to each Quality Center server.
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Understanding the Quality Center Project Structure

When you install Quality Center, the installation program creates a base 
repository on the application server's file system. The Site Administration and 
Quality Center directories are subfolders of this repository. 

The Site Administration directory is called SA by default. This directory 
stores global XML files, style sheets, templates, and reports to be used by all 
projects in the base repository.

The Quality Center directory is called QC by default. It is a working area for 
a group of domains that are shared by multiple users. Each domain stores 
Quality Center projects. The QC directory includes a default domain that 
stores the QualityCenter_Demo project. When you create a new project, you 
can add it to the default domain or to a user-defined domain.

The following diagram shows the structure of the repository. 

For each project, you can store data such as test scripts, reports, and 
attachments in the QC directory or in the project’s database.



Part I • Site Administration

14

This section describes:

➤ Storing Project Data in the Project’s Database

➤ Storing Project Data in the File System

Storing Project Data in the Project’s Database

When you create a new project, you can store the project data in the 
REPOSITORY table in the project’s database. Storage in this table is an 
alternative to storage on the application server's file system. 

By storing project data in the project's database, you can consolidate your 
data-handling procedure. For example, when you back up or restore a 
project. You can also perform hot backups on your database. In addition, 
security and manageability issues caused by storing data in the file system 
are eliminated. For example, you no longer have to share files. 

To query specific data that is stored in the REPOSITORY table, double-click a 
project in the Site Projects tab. Select the REPOSITORY table. For more 
information on querying, see “Querying Project Tables” on page 38. For 
more information on the REPOSITORY table, refer to the Mercury Quality 
Center Database Reference.
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Storing Project Data in the File System

When you create a new project, you can store the project data under the QC 
directory in the file system. Storage in this directory is an alternative to 
storage in the REPOSITORY table in the project’s database. 

The following diagram shows the project data stored in a project 
subdirectory. 

A project directory contains the following subdirectories:

➤ attach: A subdirectory for storing attachments.

➤ components: A subdirectory for storing business component scripts. 

➤ script_templates: A subdirectory for storing template workflow scripts.
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➤ StyleSheets: A subdirectory for storing style sheets that are used when 
mailing defects, requirements, or tests.

➤ tests: A subdirectory for storing automated tests.

➤ dbid.xml: An initialization file that stores project information required for 
restoring a connection to a project. For more information on restoring a 
connection to a project, see “Restoring Access to Quality Center Projects” on 
page 45.

Note that the dbid.xml file is stored in the project directory irrespective of 
where the project data is stored.

Creating Quality Center Domains 

You can add new domains to Site Administration. Quality Center organizes 
projects in the Projects list by domain. 

To create a domain:

 1 In Site Administration, click the Site Projects tab.

 2 Click the Create Domain button. The Create Domain dialog box opens.
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 3 Type a Domain Name and click OK.

The new domain is added to the Projects list in alphabetical order. In the 
right pane, under Directories, you can view the location of the domain.

 4 To add a person’s name as a contact when there are questions or problems 
with the domain and/or its projects, click the Contact Name link. In the Set 
Contact Name dialog box, type the name of the contact person and click 
OK.

 5 To add the e-mail address of the contact person for the domain, click the 
Contact E-mail link. In the Set Contact E-mail dialog box, type the e-mail 
address and click OK.
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 6 To change the number of users allowed to connect concurrently to the 
domain, click the User Quota link. The Domain User Quota dialog box 
opens.

Choose Maximum Connections and type the maximum number of 
concurrent connections allowed. Click OK. 

Notes: 

➤ In addition to changing the number of users allowed to connect 
concurrently to a domain, you can also change the number of users 
allowed to connect concurrently to a project. For more information, see 
“Updating Project Details” on page 31.

➤ If you are working with the Quality Center Starter Edition, only five users 
can connect concurrently to each Quality Center server.

 7 To select a default database server when creating projects in the domain, 
select a default database server from the Default DB Server list.
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Creating Quality Center Projects 

You can create Quality Center projects in Oracle, Microsoft SQL, or MSDE. 
When you create a new project, you can:

➤ create an empty project

➤ copy the contents of an existing project. For more information, see 
“Copying Quality Center Projects” on page 25.

➤ import data from an exported Quality Center project file. For more 
information, see “Importing a Project” on page 29.

Notes: 

➤ For information on the Oracle or Microsoft SQL permissions required by 
Quality Center, refer to the Quality Center Knowledge Base 
(http://support.mercury.com). For Oracle permissions, search for Problem 
ID 32903. For Microsoft SQL permissions, search for Problem ID 32905.

➤ If you are working with the Quality Center Starter Edition, only MSDE is 
supported. 
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To create a project:

 1 In Site Administration, click the Site Projects tab.

 2 Click the Create Project button. The Create Project dialog box opens.

 3 Choose the Create an empty project option and click Next. The following 
dialog box opens.

 4 In the Project Name box, type a name for your Quality Center project.
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 5 In the In Domain box, select a domain. 

Tip: After the project has been created, you can move it to a different 
domain in the Projects list using a drag-and-drop operation.

 6 Click Next. The following dialog box opens.

 7 Under Database Type, select Oracle or MS-SQL. If you are working in MSDE, 
select MS-SQL.

 8 By default, values defined during the Quality Center installation are 
displayed for Server Name, DB Admin User, and DB Admin Password. If 
additional database servers are defined, you can select another name from 
the Server Name list. 

Note: For more information on defining database servers, see “Defining 
New Database Servers” on page 97.
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 9 Click Next.

If your selected database server does not have the text search feature 
enabled, a message box opens. It indicates that after this process completes, 
you can enable the text search feature. For more information on enabling 
the text search feature, see “Configuring Text Search” on page 102.

 10 If you are creating a Microsoft SQL project, proceed to step 11. For an Oracle 
project, the following dialog box opens.

In the Create in TableSpace box, select a storage location from the list. 

In the Temporary TableSpace box, select a temporary storage location for 
the new project. 
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 11 Click Next. The Add Project Administrators dialog box opens.

Selected Project Administrators lists Quality Center users that are assigned 
as project administrators. Available Users lists Quality Center users available 
in the project. When you assign project administrators, they are moved 
from the Available Users list to the Selected Project Administrators list. 

➤ Refresh: Click the Refresh button to refresh the list of available users.

➤ Find: Type the name of a user in the Find box, and click the Find button 
to search the Available Users list.

➤ Add Selected Users: Select the users you want to assign as project 
administrators, and click the Add Selected Users button. The selected 
users are displayed in the Selected Project Administrators list.

➤ Delete: To remove a user from the Selected Project Administrators list, 
right-click the user and click Delete.

Note: You can also assign project administrators after you have created the 
project. For more information, see “Assigning Project Administrators” on 
page 37.
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 12 Click Next. The following dialog box opens.

Verify the project details. To change any of the details, click Back.

 13 You can select Activate Project to instruct Quality Center to activate the new 
project. For more information, see “Deactivating and Activating Projects” 
on page 40.

 14 You can select Store project’s repository in the database to store project data 
in the project’s database instead of in the file system. For more information 
on storing project data, see “Understanding the Quality Center Project 
Structure” on page 13.

Note: When importing a Quality Center project, the Store project’s 
repository in the database is not displayed. You can import a project only if 
its project repository is stored in the database. For more information on 
importing projects, see “Importing a Project” on page 29.

 15 Click Create. The new project is added to the Projects list.
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Copying Quality Center Projects 

When you create a new Quality Center project, you can copy the contents 
of an existing project to the new project.

Note: If your Quality Center server becomes unavailable while copying, you 
can resume the copying process at a later stage. To resume copying, reopen 
Site Administration and select the project from the Projects list. In the right 
pane, click the Click Here link.

To copy a Quality Center Project:

 1 Deactivate the project you want to copy. For more information, see 
“Deactivating and Activating Projects” on page 40.

 2 In Site Administration, click the Site Projects tab.

 3 Click the Create Project button. The Create Project dialog box opens.
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 4 Choose the Create a project by copying data from an existing project 
option and click Next. The following dialog box opens.

 5 In the From Project box, select the project you want to copy. 

 6 Select Customization to copy project lists, host data, system and 
user-defined fields, and transition rules to the new project. If this option is 
selected, you can also choose to copy any of the following:

Option Description

Requirements Copies requirement data from the project. Selecting this 
option enables you to choose Include History.

Tests Copies test data from the project. If this option is selected, 
you can also choose to copy the following options:

• Test Sets: Copies test set data from the project.

• Runs: Copies test run data from the project.

Selecting this option enables you to choose Include History. 

Defects Copies defect data from the project. Selecting this option 
enables you to choose Include History.
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 7 Select Users and Groups to copy user and group information and permission 
settings. If this option is selected, you can also copy any of the following:

 8 To clear all options, click Clear All.

 9 To select all options, click Select All.

 10 Click Next to continue, and perform steps 4 - 15 in “Creating Quality Center 
Projects” on page 19. 

After you successfully complete these steps, the contents of the existing 
project is copied to a new project, and the new project is added to the 
Projects list.

Include History Copies history data for the options that are selected. 

Public Favorite 
Views

Copies public favorite view data from the project. For more 
information, refer to the Mercury Quality Center User’s Guide.

Option Description

Private Favorite 
Views

Copies private favorite view data from the project. For more 
information, refer to the Mercury Quality Center User’s Guide.

Mail Conditions Copies the mailing configuration data. For more information, 
see “Configuring Automail” on page 179.

Alerts and Follow 
up Flags

Copies alerts and follow up flags. For more information, refer 
to the Mercury Quality Center User’s Guide.

Option Description
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Exporting and Importing Projects

Exporting Quality Center projects enables you to take project data from a 
Quality Center server, and back it up to another location or on some other 
media device. For example, you may want to create self-contained project 
image files that are backed up on a USB key or DVD. You can send the media 
device to a Quality Center server in another location, and import the project 
files. For more information on exporting projects, see “Exporting a Project” 
on page 28.

You can import data from exported Quality Center project files or from 
customized projects created by content providers. For example, you can 
import customized tests, requirements, and test sets for SAP testing, Siebel 
testing, and SOX compliance testing created by Mercury content providers. 
For more information on importing projects, see “Importing a Project” on 
page 29.

Exporting a Project

You can export Quality Center project data to other locations or media 
devices. When you export a project file, it is saved and exported in ZIP 
format.

Note: You can export a Quality Center project only if its project repository is 
stored in the database. To export a project repository stored in the file 
system, you must upgrade it and move its repository to the database.

To export a Quality Center Project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project, and click the Export Project to QC 
Project File button. Alternatively, right-click the project and choose Export 
Project. If the project is active, you are prompted to deactivate it. For more 
information, see “Deactivating and Activating Projects” on page 40.
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 3 The Save As dialog box opens. Select the directory where you want to save 
the project data. Enter a name for the project in the File name box. By 
default, the data is saved as a Quality Center Project Export file (.qcp).

 4 Click Save to save the project data as a Quality Center Project Export file.

Importing a Project

You can import Quality Center project data from exported Quality Center 
project files or from customized project files created by content providers.

To import a Quality Center Project:

 1 In Site Administration, click the Site Projects tab.

 2 You can do one of the following:

➤ Select the domain to which you want to import a project, and click the 
Import Project from QC Project File button. Alternatively, right-click the 
domain and choose Import Project.

➤ Click the Create Project button, and choose the Create a project by 
importing data from an exported Quality Center project file option. 
Click Next.

 3 The Create Project: Select File for Import dialog box opens.
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Click the browse button to the right of the Import Quality Center project 
from box to locate the project that you want to import. The Open dialog 
box opens.

 4 Locate the directory.

 5 Select the Quality Center Project Export file that you want to import, and 
click Open. The selected file is displayed in the Import Quality Center 
project from box.

 6 Click Next, and continue with steps 4 - 15 in “Creating Quality Center 
Projects” on page 19.

After you successfully complete these steps, the data is imported to a new 
project, and the new project is added to the Projects list.
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Updating Project Details 

You can update project details such as database type and project directory 
from the Project Details tab. You can also enable the automatic sending of 
defect e-mail. Updated project details are written to the dbid.xml file, so that 
if a project is restored, the updated project data is used. For more 
information, see “Restoring Access to Quality Center Projects” on page 45.

Tip: You can move a project to a different domain in the Projects list using a 
drag-and-drop operation. Note that this does not change the physical 
location of the project.

To update project details:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project. In the right pane, select the Project 
Details tab. The project’s details are displayed.
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Note: If a project is inactive, the project icon is displayed in red. To activate, 
see “Deactivating and Activating Projects” on page 40.

 3 Under Project Database, view the following project details:

Field Description

Database Type The database type can be MS-SQL or Oracle.

Database Name The project name, as defined in the database. 

Database Server The name of the database server on which the database 
is located.

Created From Project The project was copied from this project. An Empty 
Database value indicates that the project was not 
copied. For more information, see “Copying Quality 
Center Projects” on page 25.

Restored From Project The project was restored from this project. For more 
information, see “Restoring Access to Quality Center 
Projects” on page 45.

Note that this field is displayed instead of Created From 
Project.

Created From Domain The project was copied from this domain. 

Restored From 
Domain

The project was restored from this domain. For more 
information, see “Restoring Access to Quality Center 
Projects” on page 45.

Note that this field is displayed instead of Created From 
Domain.

Connection String The connection string. To modify the connection string, 
see “Editing the Connection String” on page 44.

DB User Password The user password for the Oracle server on which the 
database is located. To modify this password, see 
“Modifying Database Server Properties” on page 100.
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 4 Select Send mail automatically to enable the mail configuration settings for 
a project. This instructs Quality Center to send e-mail to specified users 
every time set defect fields are updated. For more information on 
configuring mail, see Chapter 12, “Configuring Automail.” 

Quality Center sends the defect messages automatically, at specified time 
intervals. To edit the time interval, refer to the MAIL_INTERVAL parameter in 
the Site Configuration tab. You can also specify if you want the e-mail to 
include attachments and/or history. For more information, see “Setting 
Quality Center Configuration Parameters” on page 107.

To manually send the defect messages that have accumulated during the 
current time interval, click the Send E-mail Now button.

Repository in DB Indicates where the project’s repository is stored. If Yes, 
the project’s repository is stored in the database. If No, 
the project’s repository is stored in the file system. For 
more information, see “Understanding the Quality 
Center Project Structure” on page 13.

Project Directory The location of the project repository in the file system.

Search Language Indicates the search languages for performing a text 
search. For more information, see “Selecting a Text 
Search Language for a Project” on page 104.

Enable/Rebuild Text 
Search

If you enable the Text Search link in the DB Servers tab 
after you have added a project to the Projects list in the 
Site Projects tab (for example, after creating, upgrading, 
or migrating a project), you must also click the 
Enable/Rebuild Text Search button. For more 
information, see “Enabling Text Search for the Database 
Server” on page 103.

Field Description
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 5 To change the number of users allowed to connect concurrently to the 
project, click the User Quota link. The Project User Quota dialog box opens.

Choose Maximum Connections and type the maximum number of 
concurrent connections allowed. Click OK. 

Notes: 

➤ The maximum number of users allowed to connect concurrently to the 
project should not exceed the number of users allowed to connect to its 
domain. For more information, see “Creating Quality Center Domains” 
on page 16.

➤ If you are working with the Quality Center Starter Edition, only five users 
can connect concurrently to each Quality Center server.

 6 To add a description for the project, click the Description link. In the Edit 
Project Description dialog box, type your description and click OK.

 7 Click the Refresh Projects List button to refresh the projects in the selected 
domain. To refresh projects in all domains, click the Refresh Projects List 
arrow and choose Refresh All Domains.

 8 To assign users to a project, see “Assigning Users to Projects” on page 35.
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Assigning Users to Projects 

As a site administrator, you can control access to Quality Center projects by 
defining the users that can log on to the project. You can assign users to 
projects from the Quality Center Users list, or copy users from existing 
Quality Center projects. You can also assign users as project administrators. 
For more information on assigning project administrators, see “Assigning 
Project Administrators” on page 37.

When a user is no longer working on a project, you should remove the user 
from the project to ensure project security. Note that removing a user from a 
project does not delete the user from the Quality Center Users list.

Note: 

➤ As a Quality Center project administrator, you can assign and remove 
users from projects, and change user privileges from the Project 
Customization window. For more information, see Chapter 9, “Managing 
Users in a Project”.

➤ You can assign projects to users from the Site Users tab. For more 
information, see “Assigning Projects to Users” on page 82.
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To assign users to a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project. In the right pane, select the Project Users 
tab. 

The users for the selected project are displayed. 

You can click the User Name or Full Name column to change the sort order 
of user names or full names in the Project Users list from ascending to 
descending. You can also click the Project Administrator column to group 
users by project administrators.
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 3 Click the Add button, and choose one of the following options:

➤ Add From The Users List: The Users list is displayed to the right of the 
Project Users tab. Select the users that you want to assign to the project. 
You can search for users by typing a search string in the Find box above 
the Users list, and clicking the Find button. 

➤ Copy From Another Project: The Projects list is displayed to the right of 
the Project Users tab. To copy a user, click a project to expand the project 
directory, and select the user name check box. To copy all users from a 
project, select the project’s check box. To clear all selected users, click 
Clear All.

 4 Select users from the Users list or Projects list, and click the Add Selected 
Users To The Project button. The selected users are displayed in the Project 
Users list.

 5 To remove a user from a project, select the user in the Project Users list and 
click the Remove button. Click Yes to confirm. The user is removed from the 
Project Users list.

 6 To refresh the Project Users list or Users list, click the Refresh button above 
the appropriate list.

Assigning Project Administrators

After you add users to projects you can assign users as project administrators 
(belonging to the TDAdmin user group). Project administrators have full 
privileges in the Quality Center project from the Project Customization 
window. For more information, see Chapter 10, “Managing User Groups 
and Permissions”.

When you copy users from other projects, they are added with the same user 
group privileges they had in the project from which they were copied, 
provided the user group exists in this project. If the user group does not 
exist in this project, the users are added with Viewer group privileges. If you 
copy a user from another project in which he/she is a project administrator, 
the user is automatically assigned as a project administrator in this project. 
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When you add users to the project from the Users list, those users are added 
with Viewer group privileges (read-only privileges). 

Note: You can also assign project administrators when you create a new 
project. For more information, see “Creating Quality Center Projects” on 
page 19.

To assign Project Administrator privileges to a user:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project. In the right pane, select the Project Users 
tab.

 3 In the Project Users list, select the Project Administrator check box for each 
user you want to assign as a project administrator.

 4 To remove a user from the Project Administrator group, clear the Project 
Administrator check box, and confirm you want to remove the user from 
the group.

Querying Project Tables 

You can query specific data that is stored in your project. You query a project 
by defining and running SQL statements. The following examples show SQL 
queries and the results that they return.

Query Results

select * from BUG
where BG_STATUS = ‘Open’

All defects that are open.

select * from BUG
where BG_RESPONSIBLE = ‘james_qc’ 
or BG_RESPONSIBLE = ‘mary_qc’

All defects assigned to either 
James or Mary.
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Using the first query example, the SQL query returns the following:

To query a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, double-click a project.

 3 Select a table. Quality Center automatically runs the “SELECT *” query for 
this table and displays all the data for the table in the SQL Query Results 
grid. 

 4 Define a query by typing an SQL statement in the SQL pane.

 5 Click the Execute SQL button or press Alt+Q. The data returned by the query 
appears in the SQL Query Results grid.

select count (*) from BUG
where BG_RESPONSIBLE = ‘mary_qc’

The number of defects assigned to 
Mary.

select * from BUG
where BG_RESPONSIBLE=‘james_qc’ 
and BG_STATUS=‘open’

All open defects assigned to 
James.

Query Results
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Deactivating and Activating Projects 

You can deactivate or activate a Quality Center project. When you 
deactivate a project, the project name is removed from the Projects box in 
the Mercury Quality Center Login window. The project is not deleted from 
the server. Any users currently connected to the project are forced to log out 
when you deactivate.

Note: It is recommended that you deactivate a project before you change 
any data that may cause inconsistency for a connected user.

To deactivate a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Deactivate Project button. A message box indicates that all 
connected users will be disconnected. 

 4 Click OK to confirm. The project is deactivated and the project icon is 
changed in the Projects list.

To activate a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Activate Project button. The project is activated and the project 
icon is changed in the Projects list.
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Pinging Projects 

You can check whether a project is connected to Site Administration.

To ping a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Ping Project button.

 4 Click OK when prompted with a message that the ping was successful.

Renaming Projects 

You can rename a project in the Projects list.

To rename a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Rename Project button. If the project is active, you are prompted 
to deactivate it. For more information, see “Deactivating and Activating 
Projects” on page 40.

 4 In the Rename Project dialog box, enter the new name for the project and 
click OK. The project is renamed in the Projects list.
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Removing Projects 

You can remove a project from the Projects list in Site Administration. Note 
that this does not delete the project from the server and you can restore the 
project if necessary. For more information on restoring access to a project, 
see “Restoring Access to Quality Center Projects” on page 45.

To remove a project from the Projects list:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Remove Project button.

 4 Click OK to confirm. Note that if the project is still active, you are prompted 
to deactivate it. For more information, see “Deactivating and Activating 
Projects” on page 40.

 5 Click OK.

Deleting Projects 

You can delete a project from the Projects list in Site Administration. Note 
that this deletes the contents of the project from the server and you cannot 
restore the project.

To delete a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Delete Project button. 

 4 Click OK to confirm. Note that you are prompted if there are active users 
connected to the project. 

In addition, if you did not specify a database administrator user name or 
password, the Database Admin Password dialog box opens. Enter the 
database administrator’s user name and password and click OK.

 5 Click OK.
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Deleting Domains 

You can delete a domain. It is removed from the Projects list, and its 
contents are deleted from the server. 

Note: You cannot delete a domain if it contains projects. To delete the 
domain, you must first delete the projects. For more information, see 
“Deleting Projects” on page 42.

To delete a domain:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a domain.

 3 Click the Delete Domain button.

 4 Click Yes to confirm.
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Editing the Connection String 

You can edit a project’s connection string. For more information on 
connection strings, see “Defining New Database Servers” on page 97.

To edit the connection string:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Edit Connection String button. If the project is still active, you are 
prompted to deactivate it. For more information, see “Deactivating and 
Activating Projects” on page 40.

The Connection String Editor dialog box opens.

 4 In the Connection String box, modify the attributes of the connection 
string. 

 5 To test the connection string, click Test Connection.

 6 Click OK to save your connection string modification and close the 
Connection String Editor.
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Restoring Access to Quality Center Projects 

You can restore access to a Quality Center project that is not in your current 
Projects list in Site Administration. For example, you may want to access a 
project from another server. After you restore access to a project, it is added 
to the Projects list in Site Administration.

Note: To restore a TestDirector 7.6 or 8.0 project, you must migrate the 
project to Quality Center 9.0. For more information, see Chapter 3, 
“Upgrading and Migrating Projects.”

To restore access to a Quality Center project:

 1 In Site Administration, click the Site Projects tab.

 2 Click the Restore Project button. The Restore Project dialog box opens.

 3 To locate the file that includes the project that you want to restore, click the 
browse button to the right of the dbid.xml file location box. The Open File 
dialog box opens.

 4 Locate the file.
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 5 Select the dbid.xml file and click Open. The Restore Project dialog box 
opens and displays the database name, type, and server, and the directory 
path of the project.

 6 In the Restore Into Domain box, select the domain in which you want the 
restored project to be located.

 7 Click Restore.

 8 If your database server does not have the text search feature enabled, a 
message box opens. You can enable the text search feature before or after 
this process completes. 

➤ Click Yes to continue this process. After the process completes, you can 
enable the text search feature. 

➤ Click No to stop this process. Enable the text search feature and then 
restart the process. 

For more information on enabling the text search feature, see “Configuring 
Text Search” on page 102.

 9 When the restore process completes, click OK.

 10 Click Close to close the Restore Project dialog box and view the restored 
project in the Projects list.
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Backing Up and Restoring Quality Center Projects 

You can protect data stored in your databases by backing up your projects. It 
is recommended that you back up your projects before you uninstall, 
upgrade, or migrate from a previous version.

To back up a Quality Center project:

 1 Back up the database schema on the database.

➤ For Oracle: Use the exp command.

➤ For Microsoft SQL and MSDE: From the SQL Server Enterprise Manager, 
choose Tools > Backup Database.

 2 If the project repository is stored in the file system, back up the project 
repository by copying it.

To restore a backed up Quality Center project:

 1 Restore the database schema on the database.

➤ For Oracle: Use the imp command.

➤ For Microsoft SQL and MSDE: From the SQL Server Enterprise Manager 
choose Tools > Restore Database.

 2 If the project repository is stored in the file system, copy the backed up 
repository to the Quality Center repository.

 3 In Site Administration, restore the project. Note that if you are restoring 
your project from a different directory, or if you renamed your schema, you 
must update the dbid.xml file accordingly. For more information on 
restoring projects, see “Restoring Access to Quality Center Projects” on 
page 45.
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Renaming the Defects Module for a Project

You can rename the Defects module for a specific project. For example, you 
can change the name of the Defects module from Defects to Bugs. You 
rename the Defects module by adding a parameter to the DATACONST table 
of the project. For more information on modifying project tables, see 
“Querying Project Tables” on page 38.

Note: You can rename any Quality Center module for all your projects by 
adding the REPLACE_TITLE parameter in the Site Configuration tab. For 
more information, see “Setting Quality Center Configuration Parameters” 
on page 107.

To rename the Defects module for a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, double-click the project for which you want to rename 
the Defects module.

 3 Select the DATACONST table.

 4 In the SQL pane, type an SQL INSERT statement to insert a row into the 
table with the following values:

➤ In the DC_CONST_NAME column, insert the parameter name 
REPLACE_TITLE.

➤ In the DC_VALUE column, insert a string that defines the new name for 
the Defects module, in the following format:

original title [singular];new title [singular];original title [plural];new title [plural]

For example, to change the name of the module from Defects to Bugs, type 
the following SQL statement into the SQL pane:

insert into dataconst values ('REPLACE_TITLE', 'Defect;Bug;Defects;Bugs’)

 5 Click the Execute SQL button. The new row is added to the DATACONST 
table. The Quality Center project displays the new Defects module name.
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Upgrading and Migrating Projects 

To work with previously created projects, you must upgrade or migrate them 
to your current version of Quality Center.

This chapter describes:

➤ About Upgrading and Migrating Projects

➤ Upgrading Quality Center Projects

➤ Migrating TestDirector Projects to Quality Center

About Upgrading and Migrating Projects

To work with a project from a previous version, you may need to upgrade or 
migrate your project to Quality Center. The following table describes the 
process required for working with a previously created project.

From Quality Center or 
TestDirector:

To Quality Center 9.0:

Quality Center 8.x You must upgrade the project to Quality Center 9.0 
using Quality Center 9.0 Site Administration. For 
more information, see “Upgrading Quality Center 
Projects” on page 50.

TestDirector 7.6 or 8.0 You must migrate the project to Quality Center 9.0 
using the Quality Center 9.0 Migration Tool. For 
more information, see “Migrating TestDirector 
Projects to Quality Center” on page 54.



Part I • Site Administration

50

Upgrading Quality Center Projects

This section describes how to upgrade projects from Quality Center 8.x to 
Quality Center 9.0. You can choose to upgrade one project at a time, or 
several projects in a domain concurrently. 

If your project’s repository is currently stored in the file system, you can 
upgrade the project and store its repository in the database, or you can 
continue to store it in the file system. For more information, refer to 
“Understanding the Quality Center Project Structure” on page 13.

After you have upgraded, you can no longer use your projects with a 
previous Quality Center version. 

It is recommended that you back up your Quality Center projects before 
commencing the upgrade process. For more information, see “Backing Up 
and Restoring Quality Center Projects” on page 47.

To upgrade a single project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Upgrade Project button. 

 4 If your database server does not have the text search feature enabled, a 
message box opens. You can enable the text search feature before or after 
this process completes.

➤ Click Yes to continue this process. After the process completes, you can 
enable the text search feature. 

➤ Click No to stop this process. Enable the text search feature and then 
restart the process. 

For more information on enabling the text search feature, see “Configuring 
Text Search” on page 102.

 5 If the project is active, you are prompted to deactivate it. For more 
information, see “Deactivating and Activating Projects” on page 40.
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 6 If the project’s repository is currently stored in the file system, you can:

➤ Click Yes to confirm that you want to move the repository to the 
database.

➤ Click No to confirm that you want to keep the repository in the file 
system.

For more information on project repositories, see “Understanding the 
Quality Center Project Structure” on page 13.

 7 Click Yes to confirm that you want to upgrade your project. The upgrading 
process starts.

 8 When the upgrade process completes, you are prompted to activate the 
project. Click Yes.

To upgrade several projects in a domain concurrently:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a domain.
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 3 Click the Upgrade Multiple Projects button. The Upgrade Multiple Projects 
dialog box opens.

 4 Under After the upgrade, choose whether you want Quality Center to leave 
all projects deactivated after the upgrade, activate only the previously active 
projects, or activate all projects. Note that by default, only the currently 
active projects are activated after the upgrade is performed.

 5 Under Project Repository, if any of the projects that you are about to 
upgrade contain project repositories in the file system, you can select Move 
project’s repository from the file system to the database to move the 
repositories to the project databases. For more information on project 
repositories, see “Understanding the Quality Center Project Structure” on 
page 13.
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 6 You can view the current version numbers of your projects. You can view the 
version numbers for all the projects in the domain, or select specific projects 
for which you want to view the version numbers:

➤ To view the version numbers for all projects, click Select All and then 
click the Display Versions button.

➤ To view the version numbers for specific projects only, select the boxes 
beside the project names  and click the Display Versions button. 

The project version number appears in the Version column. 

 7 You can upgrade all projects in the domain, or select specific projects to 
upgrade:

➤ To upgrade all projects, click Select All and then click the Upgrade 
Projects button.

➤ To upgrade specific projects only, select the boxes beside the project 
names  and click the Upgrade Projects button.

 8 If your database server does not have the text search feature enabled, a 
message box opens. You can enable the text search feature before or after 
this process completes.

➤ Click Yes to continue this process. After the process completes, you can 
enable the text search feature. 

➤ Click No to stop this process. Enable the text search feature and then 
restart the process. 

For more information on enabling the text search feature, see “Configuring 
Text Search” on page 102.

 9 If a project is active, you are prompted to deactivate it. For more 
information, see “Deactivating and Activating Projects” on page 40.

 10 The upgrading process and results are displayed in the Upgrade Results box. 
Click Close to close the Upgrade Multiple Projects dialog box.
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Migrating TestDirector Projects to Quality Center

To work with TestDirector 7.6 or 8.0 projects, you must migrate the projects 
to Quality Center 9.0. Projects are migrated to Quality Center using the 
Migration Tool. You must specify the source and target servers. The source 
server is the TestDirector server from which you want to migrate the project. 
The target server is the Quality Center server to which you want to migrate 
the project. When migrating from TestDirector, you can use the same 
repository used in TestDirector, or you can copy the repository to Quality 
Center.

Note: If you are working with the Quality Center Starter Edition:

➤ You can only migrate Microsoft Access projects.

➤ UNIX and Linux are not supported.

This section describes the migration prerequisites, the migration workflow, 
the repository migration options, and the migration process.

Migration Prerequisites 

Before you start the migration process, make sure that you consider the 
following issues:

➤ It is recommended that you back up your TestDirector project before you 
start the migration process. For more information, refer to the TestDirector 
for Quality Center Knowledge Base (http://support.mercury.com) and search 
for Problem ID 18859. You can also refer to the TestDirector 8.0 
Administrator’s Guide.

➤ The user account that is running the Quality Center (target) server must 
have the same read and write permissions as the user account used to run 
the TestDirector (source) server.
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➤ To specify the maximum number of projects that can be migrated from 
TestDirector to Quality Center at one time, set the 
MIGRATION_MAX_NUMBER_OF_PROJECTS parameter. By default, you can 
migrate up to 50 projects at a time. For more information, see “Setting 
Quality Center Configuration Parameters” on page 107.

➤ For more information on the migration process, refer to the TestDirector for 
Quality Center Knowledge Base (http://support.mercury.com) and search for 
Problem ID 37306.

Migration Workflow

When you migrate projects from TestDirector to Quality Center, the 
following events occur:

➤ The TestDirector project is upgraded to Quality Center. 

➤ The project is removed from the TestDirector server but it remains on the 
database server. The project can now be accessed only from the Quality 
Center server.

➤ The users are imported from TestDirector to Quality Center.

➤ The Site Configuration parameters are imported from TestDirector to 
Quality Center.

➤ One of the following migration options is performed:

➤ If you choose the Use the current repository option, the repository path 
is updated so that it can be accessed by Quality Center. 

➤ If you choose the Create a copy of all repository data on the target 
server database option, the repository is copied to Quality Center and is 
stored in the database. 

➤ If you choose the Create a copy of all repository data on the target 
server file system option, the repository is copied to Quality Center and 
is stored in the file system. 

For more information on migration options, see “Choosing a Repository 
Migration Option” on page 56.
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Choosing a Repository Migration Option

The Migration Tool provides the following options for migrating the 
repository:

➤ Use the current repository: Uses the same repository used in TestDirector. 
You need to define the path to be accessed by Quality Center.

➤ Create a copy of all repository data on the target server database: Copies 
the repository to Quality Center and stores it in the database. 

➤ Create a copy of all repository data on the target server file system: Copies 
the repository to Quality Center and stores it in the file system. 

Note: 

➤ When migrating Microsoft SQL Server or Oracle-based TestDirector 
projects, the databases of these projects are not copied to Quality Center.

➤ If you are working with the Quality Center Starter Edition, when 
migrating Microsoft Access-based TestDirector projects, the databases of 
these projects are copied to MSDE.
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The following table compares the migration options:

Use the current 
repository

Create a copy of all 
repository data on the 
target server database

Create a copy of all 
repository data on the 
target server file 
system

The repository is 
unchanged.

The repository is copied 
to Quality Center and 
stored in the database.

The repository is copied 
to Quality Center and 
stored in the file system.

Additional 
configurations may be 
required on the 
TestDirector and Quality 
Center servers. See table 
below.

No additional 
configurations are 
required.

No additional 
configurations are 
required.

This option is faster than 
the two other available 
options.

This option is slower 
than the Use the current 
repository option.

This option is slower 
than the Use the current 
repository option.
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To work with the Use the current repository option, the following 
additional configurations may be required:

When choosing the Create a copy of all repository data on the target server 
database or Create a copy of all repository data on the target server file 
system options, the Migration Tool uses the HTTP protocol to copy the 
repository from the TestDirector server to the Quality Center server. If the 
TestDirector repository is larger than 3 GB or if it contains over 200 projects, 
the migration process may take a long time to complete. 

To improve performance, instead of using these options, you can copy the 
repository at the operating system level. For more information on copying 
from the operating system level, refer to the TestDirector for Quality Center 
Knowledge Base (http://support.mercury.com) and search for Problem ID 
38780.

Configure the repository for 
Quality Center on Windows

Configure the repository for 
Quality Center on UNIX or 
Linux

Repository is on 
the same computer 
as the TestDirector 
server

On the TestDirector server, 
share the repository 
directory so that it can be 
accessed from Quality 
Center by a UNC path by 
the user running Quality 
Center.

Configure the repository 
and the Quality Center 
computer settings so that 
the repository on the 
TestDirector computer can 
be accessed from the 
Quality Center computer by 
a UNIX/Linux-based path. 

Repository is on a 
different computer 
than the 
TestDirector server

No need to modify the UNC 
path. The same path can be 
used by Quality Center. 
Note that the user running 
Quality Center must have 
permissions to this shared 
path.

Configure the repository 
and the Quality Center 
computer settings so that 
the repository on a 
computer other than 
TestDirector can be accessed 
from the Quality Center 
computer by a 
UNIX/Linux-based path. 
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Migrating Projects

This section describes how to migrate a project from TestDirector to Quality 
Center. Before you start the migration process, it is recommended that you 
review “Migration Prerequisites” on page 54, and “Choosing a Repository 
Migration Option” on page 56.

To migrate a project:

 1 On the TestDirector machine, insert the Quality Center CD-ROM into the 
CD-ROM drive. Install the MercuryQualityCenter_MigrationTool.exe file.

Note: Make sure that the executable is installed using the same user account 
that is used for running the TestDirector server.

 2 On a separate machine, open the Mercury Quality Center Site 
Administration (http://<Quality Center server name>[<:port number>]/sabin), 
and log in. Site Administration opens.
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 3 To open the Migration Tool, click the Tools button on the upper-right corner 
of the Site Administration window. Choose Migration Tool. The Login 
Servers page opens. 

 4 Under Source Login, specify the following:

➤ In TestDirector URL, specify the TestDirector URL from which you want 
to migrate the project (http://<TestDirector server name>/tdbin). 

➤ In the Password box, type the TestDirector password for logging in to the 
Site Administrator. 

 5 Under Target Login, specify the following:

➤ In Quality Center Site Admin URL, specify the Quality Center Site 
Administration URL to which you want to migrate the project 
(http://<Quality Center server name>[<:port number>]/sabin).

➤ In the User Name box, type the Quality Center site administrator user 
name.

➤ In the Password box, type the Quality Center site administrator 
password.
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 6 Click Next. The Domains and Projects page opens.

 7 Select the projects to be migrated. To select all projects, click Select All. 

Note that you cannot migrate a project in the following situations:

➤ A project of that name already exists on the Quality Center server.

➤ The project database server is not defined on the Quality Center server. 
On the Quality Center target server, define the database server 
configuration to be identical to that defined on the TestDirector source 
server. For more information on defining a database server, see “Defining 
New Database Servers” on page 97.

➤ If you are working with the Quality Center Starter Edition, you cannot 
migrate Oracle or Microsoft SQL Server projects. You can only migrate 
Microsoft Access projects.

 8 To clear all selected projects, click Clear All.

 9 To refresh the projects list, click Refresh List.
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 10 If the migration process was previously interrupted before completion, you 
can resume the process. To resume, select a resumable project from the 
projects list or click Select All Resumable to select all resumable projects. 
Click Resume to continue the migration process. Note that these buttons are 
available only if you have resumable projects.

 11 Click Next. The Repository page opens.

 12 Choose a repository migration option:

➤ Create a copy of all repository data on the target server database: 
Copies the repository to Quality Center and stores it in the database. 

➤ Create a copy of all repository data on the target server file system: 
Copies the repository to Quality Center and stores it in the file system. 

➤ Use the current repository: Defines the repository path to be used by 
Quality Center. You will continue to work with the same repository used 
in TestDirector. 

For more information on the repository migration options, see “Choosing a 
Repository Migration Option” on page 56.
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 13 If you chose Create a copy of all repository data on the target server 
database or Create a copy of all repository data on the target server file 
system, proceed to step 15 on page 66.

If you chose Use the current repository, modify the target repository path in 
the Repository Path on Target Server After Migration box, as follows:

➤ If the target server runs on a Windows platform, modify the path from an 
absolute path to a UNC path. For example, change the target path from 
F:\Td_dir to \\<source_server>\Td_dir.

➤ If the target server runs on a UNIX or a Linux platform, modify the 
Windows-based path to the UNIX-based path. For example, to modify an 
absolute path to a UNIX/Linux-based path, change the target path from 
F:\Td_dir to /net/<source_server>/td_dir.

To undo all changes, click Restore All and then click Yes to confirm.
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 14 To modify or verify the physical path of a project on the Quality Center 
server, click Advanced. 

If your database server does not have the text search feature enabled, a 
message box opens. After this process completes, you can enable the text 
search feature. For more information, see “Configuring Text Search” on 
page 102.

The Repository Path page opens. 

The following columns are available:

Column Name Description

Projects Indicates the project name.

DB Server Name Indicates the name of the database server used for 
the project. The database server name used on the 
Quality Center machine must be the same as the 
name on the TestDirector machine.
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Physical Location Indicates the physical path of the project on the 
Quality Center server. To modify, double-click a 
physical location path or click Modify, and edit the 
path. If the Quality Center server runs on a UNIX 
or a Linux platform, modify the Windows-based 
path to the UNIX-based path. If the Quality Center 
server runs on a Windows platform, modify the 
path from an absolute path to a UNC path. 

• To verify the availability of the paths, click 
Verify Paths.

• To undo a change, click Restore and then click 
Yes to confirm.

• To undo all changes, click Restore All and then 
click Yes to confirm.

Test Repository Location The path is displayed if the test folder is not stored 
in the project repository. To modify, double-click a 
repository location path or click Modify, and edit 
the path. If the Quality Center server runs on a 
UNIX or a Linux platform, modify the 
Windows-based path to the UNIX-based path. If 
the Quality Center server runs on a Windows 
platform, modify the path from an absolute path to 
a UNC path. 

• To verify the availability of the paths, click 
Verify Paths.

• To undo a change, click Restore and then click 
Yes to confirm.

To undo all changes, click Restore All and then 
click Yes to confirm.

Column Name Description
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 15 Click Next. 

If your database server does not have the text search feature enabled, a 
message box opens. After this process completes, you can enable the text 
search feature. For more information, see “Configuring Text Search” on 
page 102.

The Migration Summary page opens.

 16 Click Migrate to start the migration process. An information box opens.

 17 Click OK to confirm.

 18 When the migration process ends, an information box opens. Click OK.

 19 To save the log file of the migration process as an HTML file, click Save to 
File.

 20 Click Close to exit the Migration Tool.
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4
Managing Quality Center Users

You manage Quality Center users in Site Administration. You can add new 
Quality Center users, define user details, change user passwords, and define 
site administrators. You can also import users from LDAP and enable LDAP 
authentication for users. After you add users, you can assign projects to 
users. 

This chapter describes:

➤ About Managing Users

➤ Adding a New User

➤ Importing Users from LDAP

➤ Updating User Details

➤ Changing Passwords

➤ Enabling LDAP Authentication for Users

➤ Assigning Projects to Users

➤ Exporting User Data

➤ Deleting Users
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About Managing Users

You use Site Administration to manage the users connected to your Quality 
Center projects. You begin by adding or importing new users to the Users 
list in Site Administration. You can then define user details and change or 
override a user’s password. Note that you can also enable users to log in to 
Quality Center using their LDAP passwords. 

For each Quality Center user, you can select projects that the user can access. 
You can also define Quality Center users as site administrators. For more 
information, see “Defining Site Administrators” on page 7.

Note: You can monitor the users currently connected to a Quality Center 
server. For more information, see Chapter 5, “Managing User Connections 
and Licenses.”

Adding a New User 

You can add new users to the Users list in Site Administration. After the user 
is added, you can view users and define user details. For more information 
on updating user details, see “Updating User Details” on page 78.

You can also import new users from LDAP directories. For more information, 
see “Importing Users from LDAP” on page 70.

Note: Creating a new user for a Quality Center project consists of two steps:

➤ Adding the user to the Users list in Site Administration (as described in 
this section).

➤ Assigning the user to a user group using Project Customization. Each user 
group has access to certain Quality Center tasks. For more information, 
see Chapter 9, “Managing Users in a Project,” and Chapter 10, 
“Managing User Groups and Permissions.”
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To add a new user:

 1 In Site Administration, click the Site Users tab. 

 2 Click the New User button. The New User dialog box opens.

 3 Type a User Name (maximum length 60 characters) and Full Name.
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 4 Type additional user information: E-mail, Phone Number, and a Description. 
Note that the e-mail information is important, as it enables users to receive 
project information directly to their mailboxes. 

Note: You can update user information in the User Details tab. For more 
information, see “Updating User Details” on page 78.

 5 Click OK. The new user is added to the Users list.

Importing Users from LDAP 

You can import users from an LDAP directory to the Users list in Site 
Administration.

Notes:

➤ To work with LDAP through SSL requires that you perform additional 
steps. For more information, refer to the TestDirector for Quality Center 
Knowledge Base (http://support.mercury.com) and search for Problem ID 
34793. 

➤ The LDAP_TIMEOUT parameter enables you to define a connection time-
out between Quality Center and an LDAP server. By default, the value is 
set to 10 minutes. For more information, see “Setting Quality Center 
Configuration Parameters” on page 107.

To import a user from LDAP:

 1 In Site Administration, click the Site Users tab.

 2 Ensure that the LDAP import settings are defined. For more information, see 
“Defining LDAP Settings for Importing Users” on page 72.
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 3 Click the Import Users button. The Import Users dialog box opens.

 4 To filter the LDAP directory base, click the Filter All button. If you have 
preselected users, a warning message box opens. Click OK to clear all 
selections and continue. The Filter dialog box opens. Type a filter condition 
to display specific records from your LDAP directory base and click OK.

 5 To view LDAP details for a user, select an item and click the Show LDAP 
Details button. The LDAP User Details dialog box opens and displays the 
user attributes. 

 6 You can use the following options to import users:

➤ To import a user, expand a directory and mark the user name by selecting 
the check box.

➤ To import a group of users, use Ctrl or Shift to highlight users to include. 
Click the Mark All Items arrow and choose Mark Selected Items to select 
the check boxes of the highlighted users.

➤ To import all users, click Mark All Items.
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 7 To clear the check boxes of highlighted users, click the Mark All Items arrow 
and choose Clear Selected Items. To clear all check boxes, click the Mark All 
Items arrow and choose Clear All. 

 8 Click Import. A confirm message box opens. Click Yes to continue.

➤ If the users were imported successfully, a message box opens. Click OK. 
Proceed to step 9.

➤ If the same user names exist in the Users list, the Handle Conflict dialog 
box opens. For more information, see “Handling User Name Conflicts” 
on page 76.

 9 Click Close to close the Import Users dialog box.

Defining LDAP Settings for Importing Users

To enable you to import users from an LDAP directory to the Users list in 
Site Administration, you must define your LDAP import settings. 

When you import users from an LDAP directory, Quality Center copies 
attribute values from an LDAP directory into Quality Center. For each 
imported user, the following attribute values are copied:

➤ Distinguished name (DN): A unique name that is made up of a sequence of 
relative distinguished names (RDN) separated by commas. 

For example: CN=John Smith, OU=QA, O=Mercury

where CN is the common name; OU is the organizational unit; and O is the 
organization.

➤ Userid (UID): The name that identifies a user as an authorized user. The UID 
attribute value is mapped to the User Name field in Quality Center. 

➤ Full Name, Description, E-mail and Phone: Optional attributes that are used 
to populate the Full Name, Description, E-mail, and Phone Number fields 
for each user imported from an LDAP directory.
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To define LDAP settings for importing users:

 1 In Site Administration, click the Site Users tab.

 2 Click the User Settings button and choose LDAP Import Settings. The LDAP 
Import Settings dialog box opens.

 3 In the Directory provider URL box, type the URL of the LDAP server 
(ldap://<server name>:<port number>).

 4 Under LDAP authentication type:

➤ Select Anonymous to enable you to import users from the LDAP server 
using an anonymous account.

➤ Select Simple to enable you to import users from the LDAP server using 
an authorized user account and password. 

 5 If you select Simple, the following options are enabled: 

➤ In the Authentication principal box, type the authorized user name.

➤ In the Authentication credentials box, type the password.

 6 Click the Test Connection button to test the URL of the LDAP server.

 7 Choose one of the following options:

➤ To define additional LDAP settings, proceed to step 8.

➤ To close the LDAP Import Settings dialog box, click Finish.
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 8 To define additional LDAP settings, click Next. The following dialog box 
opens. 

 9 In the Directory base box, type the LDAP directory name.

 10 In the Base filter box, define filter criteria.

 11 To set the default values for the Active Directory, click the Set Default for 
Active Directory button.

 12 To set the default values for LDAP, click the Set Default for LDAP button.

 13 Choose one of the following options:

➤ To populate optional attributes in Quality Center for each user imported 
from an LDAP directory, proceed to step 14.

➤ To close the LDAP Import Settings dialog box, click Finish.
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 14 To populate optional attributes in Quality Center for each user imported 
from an LDAP directory, click Advanced. The following dialog box opens. 

 15 Define the corresponding LDAP field names. Note that User Name is a 
required field.

 16 Click Finish to close the LDAP Import Settings dialog box.
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Handling User Name Conflicts

When importing users from an LDAP directory to the Users list in Site 
Administration, you may encounter the following conflicts:

➤ Same user: A user with the same LDAP distinguished name already exists. 

➤ Same user name: A user with the same user name already exists.

To resume the process of importing users, you can choose to ignore the user, 
rename a user name, or update user information.

To handle user name conflicts:

 1 Import users (see step 8 in “Importing Users from LDAP”). If conflicts occur, 
the Handle Conflict dialog box opens. 
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 2 If the conflict is listed under Conflict: Same User, you can choose one of the 
following options to resume the process:

 3 If the conflict is listed under Conflict: Same User Name, you can choose one 
of the following options to resume the process:

 4 Click Continue. 

Option Description

Update Updates existing user information. Click the corresponding 
Solution box. Click the browse button and choose Update.

Skip Does not import the selected user (default).

Option Description

Rename Assigns a new name to the selected user. Click the 
corresponding Solution box. Click the browse button and 
choose Rename. In the New User Name box, type the new 
name.

Auto Rename Assigns a new name to the selected user by adding a suffix. 
Click the corresponding Solution box. Click the browse 
button and choose Auto Rename. The new name is displayed 
in the New User Name box.

Update Updates existing user information. Click the corresponding 
Solution box. Click the browse button and choose Update.

Skip Does not import the selected user (default).
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Updating User Details

After you add a user, you can update user details. For example, you may 
need to update a user’s full name or contact details. You can also define 
Quality Center users as site administrators. For more information, see 
“Defining Site Administrators” on page 7.

To update user details:

 1 In Site Administration, click the Site Users tab. In the right pane, click the 
User Details tab. 

 2 Select a user from the Users list.

To change the sort order of the Users list from ascending to descending, 
click the User Name or Full Name column heading. Click the column 
heading again to reverse the sort order.

You can search for a user in the Users list by typing the name of a user in the 
Find box, and clicking the Find button. The first user that matches the 
searched text is highlighted. Click the button again to search for other users 
containing the searched text.
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 3 Edit the user detail fields. Note that the User Name is read-only.

Note: If the user was imported from an LDAP directory to Site 
Administration, the Domain Authentication box displays the LDAP 
authentication properties of the imported user. If the user was not imported, 
the Domain Authentication box is not displayed. For more information, see 
“Importing Users from LDAP” on page 70.

 4 Click Apply to save your changes.

Changing Passwords 

The site administrator can change or override a user’s password. 

Notes: 

➤ You can only change passwords for users that are set to log in to Quality 
Center using their Quality Center passwords. If LDAP passwords are in 
use, this option is unavailable. For more information on LDAP 
authentication, see “Defining LDAP Settings for Importing Users” on 
page 72.

➤ Non-administrators can change their passwords using the Change User 
Properties link in the Project Customization window. For more 
information, refer to the Mercury Quality Center User’s Guide. 
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To change a password:

 1 In Site Administration, click the Site Users tab.

 2 Select a user from the Users list.

 3 Click the Password button. The Set User Password dialog box opens. 

 4 In the New Password box, type a new password (maximum length 20 
characters).

 5 In the Retype Password box, retype the user’s new password.

 6 Click OK.
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Enabling LDAP Authentication for Users

You can allow users to log in to Quality Center using their LDAP passwords, 
instead of Quality Center passwords.

Note that working with LDAP through SSL requires that you perform 
additional steps. For more information, refer to the TestDirector for Quality 
Center Knowledge Base (http://support.mercury.com) and search for Problem 
ID 34793.

Note: When using LDAP authentication, users are authenticated against 
LDAP using the distinguished names (DN) that are stored in the Domain 
Authentication property in the Quality Center database. When the user 
attempts to log in, and the DN information in Quality Center is invalid, the 
user is unable to log in to Quality Center.

You can enhance the search so that when the DN information is invalid, 
Quality Center will also search on the LDAP server, using the LDAP import 
settings defined in Site Administration. If the user is found, the DN is 
updated in Quality Center, and an automatic login attempt is performed.

To set this extended search, define a comma-separated list for the 
LDAP_SEARCH_USER_CRITERIA Site Configuration parameter. The possible 
values are username, email, fullname, phone, description. The order of the 
properties defines their priority if multiple results are found. 

For example, if the parameter is set to username and email, and two users are 
found with the same user name on the LDAP server, their e-mail addresses 
are checked. If more than one user is found answering the set properties, an 
error message is returned. If the search for the user succeeds, the user is 
logged in to Quality Center.

For more information, see “Setting Quality Center Configuration 
Parameters” on page 107.
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To enable LDAP authentication for users:

 1 In Site Administration, click the Site Users tab.

 2 Click the User Settings button and choose Authentication Settings. The 
Authentication Settings dialog box opens.

 3 Under Authentication type, select LDAP to set the authentication type as 
LDAP for all users.

 4 In the Directory provider URL box, type the URL of the LDAP server 
(ldap://<server name>:<port number>).

 5 Click the Test Connection button to test the URL of the LDAP server.

 6 Click OK.

Assigning Projects to Users

As a Quality Center site administrator, you can control user access to Quality 
Center projects by defining the projects to which a user can log on. When a 
user is no longer working on a project, you should remove the user from the 
User Projects list. 

Note that when you add a user to a project, the user is automatically 
assigned to the project with Viewer privileges. For more information on user 
groups and group privileges, see Chapter 9, “Managing Users in a Project,” 
and Chapter 10, “Managing User Groups and Permissions.”
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Note: You can assign users to projects from the Site Projects tab. For more 
information, see “Assigning Users to Projects” on page 35.

To assign projects to a user:

 1 In Site Administration, click the Site Users tab. In the right pane, select the 
User Projects tab. The Projects list for the selected user is displayed. 

You can click the Domain column to change the sort order from ascending 
to descending domain names. You can also click the Project column to sort 
according to project instead of domain name.

 2 In the Users list in the left pane, select a user. You can search for a user by 
typing the name of a user in the Find box, and clicking the Find button. 

The selected user’s projects are displayed in the User Projects list.

To group user projects by domain, select Group By Domain. Clear the check 
box to remove the group by settings.



Part I • Site Administration

84

 3 In the User Projects tab, click the Select Projects button. The Quality Center 
Projects list is displayed in a new pane to the right of the User Projects tab.

 4 To select projects from the Projects list, expand the directory, and select the 
projects that you want to assign to the user.

To clear all selected projects, click Clear All.

 5 Click the Add current user to the selected projects button. The selected 
projects are added to the User Projects list.

 6 To remove a project from the User Projects list, select the project and click 
the Remove button. Click OK to confirm. The project is removed from the 
User Projects list. Note that this does not delete the project from the server.

 7 To refresh the User Projects list, click the Refresh Users List button.
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Exporting User Data

You can export the user name and full name of all site users from the Users 
list to a text file.

To export user data:

 1 In Site Administration, click the Site Users tab. 

 2 Click the Export To File button. The Export Data To File dialog box opens.

 3 Select the directory where you want to save the parameters, and enter a 
name for the file in the File name box. 

 4 Click Save to export the data to a text file.

Deleting Users

You can delete a user from the Users list.

To delete a user:

 1 In Site Administration, click the Site Users tab. 

 2 Select a user from the Users list.

 3 Click the Delete User button. 

 4 Click Yes to confirm.
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5
Managing User Connections and Licenses

In Site Administration, you can monitor user connections and modify 
license information.

This chapter describes:

➤ About Managing User Connections and Licenses

➤ Monitoring User Connections

➤ Managing Quality Center Licenses

About Managing User Connections and Licenses

You use the Site Connections tab in Site Administration to monitor and 
manage the users connected to your Quality Center projects. For more 
information, see “Monitoring User Connections” on page 88.

You use the Licenses tab in Site Administration to view Quality Center 
license information and to modify the license key, if needed. For more 
information, see “Managing Quality Center Licenses” on page 91.

Note: If you are working with the Quality Center Starter Edition, only five 
users can connect concurrently to each Quality Center server.
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Monitoring User Connections 

You can monitor the users currently connected to a Quality Center server. 
For each user, you can view the domain and project being used, the user’s 
machine name, the time the user first logged in to the project, and the time 
the most recent action was performed. You can also view the client type 
connection to the Quality Center server.

You can also view the licenses that are currently being used by each user. 
The Mercury Quality Center license  indicates that the user can access all 
modules in a specific project. The Defects Module license  indicates that 
the user can access only the Defects module.

You can send messages to users connected to your Quality Center projects. 
You can also disconnect users from projects.

Note that you can modify access to a Quality Center project using the 
Customize Module Access link. For more information, see “Customizing 
Module Access for User Groups” on page 163.

Note: 

➤ To view the total number of licenses that are in use for each Quality 
Center module, click the Licenses tab. For more information, see 
“Managing Quality Center Licenses” on page 91.

➤ To view and analyze the number of licensed Quality Center users 
connected to your projects at specific points over a period of time, click 
the Site Analysis tab. For more information, see “Monitoring Site Usage” 
on page 120.
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To monitor user connections:

 1 In Site Administration, click the Site Connections tab.

You can click any column heading to change the sort order of the column 
from ascending to descending.

 2 To refresh the Connections list, click the Refresh Connections List button.

To instruct Quality Center to automatically refresh the Connections list, 
click the Refresh Connections List arrow and choose Automatic Refresh. By 
default, the Connections list is automatically refreshed every 60 seconds. To 
change the automatic refresh rate, click the Refresh Connections List arrow 
and choose Set Refresh Rate. In the Set Refresh Rate dialog box, specify a 
new refresh rate in seconds.

 3 You can group connected users by clicking the Group By arrow, and 
choosing a Group By option. To group connected users by project, choose 
Group By Project. To group connected users by user, choose Group By User. 
To clear the Group By settings, click the Group By arrow and choose Clear 
Group By.

 4 You can send a message to a connected user or group of users by selecting 
the Send Message button. For more information on sending messages, see 
“Sending Messages to Connected Users” on page 90.

 5 To disconnect a user or group of users from a project, select the row of the 
user or group and click the Disconnect Users button. Click Yes to confirm.
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Sending Messages to Connected Users

You can send messages to users connected to your Quality Center projects. 
This enables you to routinely inform connected users about important 
maintenance activities. For example, disconnecting a project, or restarting a 
Quality Center server. 

When you send a message, a pop-up window automatically opens on the 
user’s machine displaying the message text. The message box is displayed 
until the user closes it or disconnects from Quality Center. For more 
information, refer to the Mercury Quality Center User’s Guide.

To send messages to connected users:

 1 In Site Administration, click the Site Connections tab.

 2 Select the users to whom you want to send a message:

➤ To send a message to a user or group of users, select the row of the user or 
group.

➤ To send a message to multiple users, use Ctrl or Shift to highlight users to 
include.

 3 Click the Send Message button. The Send Message dialog box opens.

The To box displays the intended recipients of the message in the format 
[DOMAIN:Project Name:User Name].
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 4 In the Message Text box, type a message.

 5 Click Send. Quality Center will send the message to user machines within 
five minutes.

Managing Quality Center Licenses 

You can view the total number of licenses in use and the maximum number 
of licenses that you have for each Quality Center module. When other 
Mercury tools, such as QuickTest Professional, are connected to a Quality 
Center project, you can view the total number of licenses in use for these 
tools. You can also modify your license file.

Note: 

➤ To view the Quality Center licenses that are currently being used by each 
user, click the Site Connections tab. For more information, see 
“Monitoring User Connections” on page 88. 

➤ To view and analyze the number of licensed Quality Center users 
connected to your projects at specific points over a period of time, click 
the Site Analysis tab. For more information, see “Monitoring Site Usage” 
on page 120.
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To manage Quality Center licenses:

 1 In Site Administration, click the Licenses tab. 

 2 To refresh the license information displayed in the Licenses tab, click the 
Refresh Licenses List button.

 3 To modify the license, click the Modify License button. The License Edit 
dialog box opens. To load the license file, click Load License and select the 
file. Alternatively, copy the license file and click Paste License. Click OK.
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6
Configuring Servers and Parameters

You use Site Administration to configure Quality Center and Site 
Administration servers, define and modify database servers, configure the 
text search, set configuration parameters, and define the Quality Center 
mail protocol.

This chapter describes:

➤ About Configuring Servers and Parameters

➤ Configuring Server Information

➤ Defining New Database Servers

➤ Modifying Database Server Properties

➤ Configuring Text Search

➤ Setting Quality Center Configuration Parameters

➤ Setting the Quality Center Mail Protocol

About Configuring Servers and Parameters

You use the Servers tab to configure Quality Center and Site Administration 
server information. You can set the server log file and maximum number of 
database handles. For more information, see “Configuring Server 
Information” on page 94.

You use the DB Servers tab to define database servers that were not defined 
during installation. For each database server, you enter the database type, 
database name, default connection string, and administrator user and 
password. For more information, see “Defining New Database Servers” on 
page 97. 
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You also use the DB Servers tab to modify existing database server 
definitions. For more information, see “Modifying Database Server 
Properties” on page 100. In addition, you can configure the text search 
option for a specified database server that has the Oracle text search feature 
installed and configured. For more information, see “Configuring Text 
Search” on page 102.

Note: If you are working with the Quality Center Starter Edition, the DB 
Servers tab is not supported.

You use the Site Configuration tab to add and modify Quality Center 
configuration parameters. For more information, see “Setting Quality 
Center Configuration Parameters” on page 107. In addition, you can set the 
mail protocol to be used by all the server nodes in your Quality Center site. 
For more information, see “Setting the Quality Center Mail Protocol” on 
page 117.

Configuring Server Information

You can configure Quality Center and Site Administration server 
information. This includes:

➤ Setting the Quality Center server log file: The Quality Center server can 
write all Quality Center events—API functions that send requests to a 
Quality Center project—to a log file. The log file displays the date and time a 
function was executed. This enables Mercury Customer Support to trace 
where errors occur, if necessary. By default, the Quality Center server does 
not automatically record events. 

➤ Setting the maximum number of database connections: The Quality Center 
server can open a number of connections for each project on a database 
server. You can set the maximum number of concurrent connections that 
can be opened by the Quality Center server for each project.
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To configure Quality Center server information:

 1 In Site Administration, click the Servers tab.

 2 In the Server list, expand a server.

 3 To set Site Administration server information, select Site Administrator. To 
set Quality Center server information, select Quality Center.

The General Settings area displays the server address and virtual directory 
name. For the Site Administration server, the virtual directory name is sabin. 
For the Quality Center server, the virtual directory name is qcbin.

 4 Under Log File Settings, click the Log Level link to configure the type of log 
file you want the server to create. Select one of the following options in the 
Log Level dialog box:

➤ None: Does not create a log file.

➤ Errors: Records error events.

➤ Warnings: Records potentially harmful situations.

➤ Flow: Records informational messages that highlight the application 
flow. 

➤ Debug: Records events that are most useful for debugging.
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 5 Click the Max. Log Lines link to open the Maximum Log Lines dialog box 
and configure the maximum number of lines that the Quality Center server 
can write to the log file. Quality Center creates a new log file after the log 
file reaches the maximum number of lines. The default value is 10,000.

 6 Click the Max. Log Days link to open the Maximum Log Days dialog box 
and configure the maximum number of days that the Quality Center server 
keeps the log file. Quality Center automatically deletes the log files once the 
maximum number of days has been reached. The default value is Unlimited, 
which is displayed as -1. 

 7 Click the Log File Location link to change the directory path of the log file. 
In the Log File Location dialog box, type the new location for the log file. 

 8 If you are setting the Quality Center server information, you can also set the 
maximum number of concurrent connections that can be opened by the 
Quality Center server for each project. Click the Max. Database Connections 
link to open the Maximum Database Connections dialog box and set the 
maximum number of concurrent connections.

 9 To delete a Quality Center server from the Server list, select it and click the 
Delete QC Server button. Click Yes to confirm.

 10 Click the Refresh QC Servers List button to refresh the servers list.



Chapter 6 • Configuring Servers and Parameters

97

Defining New Database Servers 

You can define additional database servers that were not defined during the 
installation process.

Notes: 

➤ For information on Oracle or Microsoft SQL permissions required by 
Quality Center, refer to the TestDirector for Quality Center Knowledge 
Base (http://support.mercury.com). For Oracle permissions, search for 
Problem ID 32903. For Microsoft SQL permissions, search for Problem ID 
32905.

➤ If you are working with the Quality Center Starter Edition, the DB Servers 
tab is not supported.

To define a new database server:

 1 In Site Administration, click the DB Servers tab.
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 2 Click the New Database Server button. The Create Database Server dialog 
box opens.

 3 Under Database Type, select the type of database server you want to define:

➤ MS-SQL (SQL Auth.): Uses SQL authentication.

➤ MS-SQL (Win Auth.): Uses Microsoft Windows authentication.

➤ Oracle

 4 Under Database Values, in the Database Name box, type the database 
name.
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 5 In the DB Admin User box, type the login name of the database 
administrator.

➤ For an Oracle database type, the default administrator user account 
enabling you to create Quality Center projects is system. 

➤ For an MS-SQL (SQL Auth.) database type, the default administrator user 
account enabling you to create Quality Center projects is sa. 

➤ For an MS-SQL (Win Auth.) database type, the DB Admin User box is 
unavailable. The login name of the database administrator is the 
Windows user that is set to run Quality Center as a service. 

 6 In the DB Admin Password box, type the password of the database 
administrator. Note that this field is unavailable if you selected the MS-SQL 
(Win Auth.) database type.

 7 Under Default Connection String, you can edit the default connection string 
parameters or the connection string, as follows: 

➤ To edit the default connection string parameters, choose Connection 
String Parameters and define the following parameters:

➤ To edit the connection string, choose Connection String and edit the 
connection string.

 8 To check whether you can connect to the database server, click the Ping 
Database Server button. The DB admin user and password you entered are 
displayed in the Ping Database Server dialog box. Click OK.

 9 Click OK to close the Create Database Server dialog box. The new database 
server you defined appears in the Database Servers list.

 10 Click the Refresh Database Servers List button to refresh the database 
servers list.

Parameter Description

Server Host The server name.

Port The port number of the database server.

SID The service ID for an Oracle database server.
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Modifying Database Server Properties

You can modify the database server properties.

Note: If you are working with the Quality Center Starter Edition, the 
DB Servers tab is not supported.

To modify database server properties:

 1 In Site Administration, click the DB Servers tab.

 2 Select a database server in the Database Servers list.

 3 To modify the connection string, click the Edit Connection String button, or 
click the Connection String link. Edit the connection string in the 
Connection String Editor and click OK. For more information on 
connection strings, see “Defining New Database Servers” on page 97.

 4 To modify the database administrator’s login name, click the DB Admin User 
link. In the Default Admin User dialog box, type the new login name and 
click OK. 

For more information on defining a new login name for a database 
administrator, see “Defining New Database Servers” (step 5) on page 99.
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 5 To modify the database administrator’s password, click the Password 
button, or click the DB Admin Password link. In the Set Database Admin 
Password dialog box, type the new password and then retype it. Click OK.

 6 If you selected an MS-SQL server, click the QC User Password link to modify 
the default password for the user QC. This is the user that creates projects in 
Quality Center. In the Change Default QC User Password dialog box, type 
the new password and retype it. Click OK.

Note: If you have existing Quality Center projects on an MS-SQL server, 
after you change the Quality Center user password, you must also update 
the password for each project.

 7 If you selected an Oracle server, click the Default DB User Password link to 
modify the default user password. In the Change Default Database User 
Password dialog box, type the new password and retype it. Click OK. 

Note: Projects and users are identical on an Oracle database server. If you 
want each project or user to have its own password, you must define a new 
database server, with its own unique database name and user password, for 
each project you create.

 8 To enable text search capabilities in the Requirements, Test Plan or Defects 
modules, click the Text Search link. For more information, see “Enabling 
Text Search for the Database Server” on page 103.

 9 If the text search is enabled, you can set the default text search language for 
the database server in the Default Search Language list. For more 
information, see “Enabling Text Search for the Database Server” on 
page 103.

 10 To check whether you can connect to the database server, click the Ping 
Database Server button. The DB admin user and password you entered are 
displayed in the Ping Database Server dialog box. Click OK.
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 11 To delete a database server from the Database Servers list, select it and click 
the Delete Database Server button. Click Yes to confirm.

 12 Click the Refresh Database Servers List button to refresh the database 
servers list.

Configuring Text Search

Text search allows users to enter keywords and search specific project fields 
in the Requirements, Test Plan and Defects modules. For information on 
working with the text search feature, refer to the Mercury Quality Center User’s 
Guide.

To configure text search, perform the following steps:

➤ In Site Administration, enable text search and define the default search 
language for a specified database server in the DB Servers tab. For more 
information, see “Enabling Text Search for the Database Server” on 
page 103.

➤ To specify a different search language for a specific project, change the 
search language from the Site Projects tab. For more information, see 
“Selecting a Text Search Language for a Project” on page 104.

➤ For a specific project, define the project fields to be included in the search 
from Project Customization. For more information, see “Defining 
Searchable Fields” on page 105.

Note: The Text Search link is available only if you install and configure the 
Oracle text searching feature. The text search feature is not supported in 
Microsoft SQL 2000. For more information, refer to the TestDirector for 
Quality Center Knowledge Base (http://support.mercury.com) and search for 
Problem ID 43393.
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Enabling Text Search for the Database Server

You can enable text search for a specified database server that has the text 
search feature installed and configured. You can enable text search on a 
database server before or after you add any projects to your Projects list. 

When you enable text search on a database server before you add projects, 
the projects that you add afterwards are text search enabled. When you 
enable text search on a database server after you have added projects, you 
must manually enable text search for each existing project.

After you have enabled the text search for a specified database server, you set 
the default search language for the database server. You can change the 
default search language for a specific project from the Site Projects tab. For 
more information, see “Selecting a Text Search Language for a Project” on 
page 104.

To enable text search on a database server before adding projects:

 1 In Site Administration, click the DB Servers tab.

 2 In the Database Servers list, select a database server.

 3 Click the Text Search link and click Yes to confirm. Type the password for 
the CTXSYS user in the Set CTXSYS Password dialog box and click OK.

The Text Search value changes from Disabled to Enabled. Note that you 
cannot disable it.

 4 In the Default Search Language list, set the default text search language for 
the database server.

To enable text search on a database server after adding projects:

 1 In Site Administration, click the DB Servers tab.

 2 In the Database Servers list, select a database server.

 3 Click the Text Search link and click Yes to confirm. Type the password for 
the CTXSYS user in the Set CTXSYS Password dialog box and click OK.

The Text Search value changes from Disabled to Enabled. Note that you 
cannot disable it.

 4 In the Default Search Language list, set the default text search language for 
the database server.
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 5 Click the Site Projects tab.

 6 For each project for which you want to enable text search, click the 
Enable/Rebuild Text Search button. Click Yes to confirm.

Selecting a Text Search Language for a Project

For each project, you can specify a search language other than the default 
search language you set for the database server. For more information on 
enabling the text search and setting the default search language, see 
“Enabling Text Search for the Database Server” on page 103.

Note: Search languages are not available for a project created on a database 
server that does not have the text search feature enabled.

To select a search language for a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project. In the right pane, click the Project 
Details tab.

 3 In the Search Language field, select a language for the project. For more 
information on updating project details in the Project Details tab, see 
“Updating Project Details” on page 31.
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Defining Searchable Fields

For each project, you must define the fields to be included in the search. The 
searchable option is only available in the Requirement, Test, Test Step (for 
design steps only), and Defect entities. Note that only user-defined fields 
with field type Memo or String, or the following system fields are available 
as searchable fields:

Entity Searchable Fields

Requirement Creation Time

Description

Name

Test Description

Path

Template

Test Name

Test Step (Design steps only) Description

Expected

Step Name

Defect Comments

Description

Reproducible

Summary
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To define a searchable field:

 1 In the Project Customization window, click the Customize Project Entities 
link. The Customize Project Entities page opens. For more information on 
customizing project entities, see “Customizing Project Entities” on 
page 166.

 2 Under Project Entities, expand an entity, and select a system or user-defined 
field that can be made searchable. 

 3 Select the Searchable check box.

 4 Click Save to save your changes to the Customize Project Entities page. 
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Setting Quality Center Configuration Parameters 

You use the Site Configuration tab to modify existing Quality Center 
configuration parameters and add new ones.

You can modify the following default Quality Center configuration 
parameters:

Parameter Description

ACCESS_WEB_
DOCUMENTATION

If this parameter is set to “N” (the default), Quality 
Center uses the locally installed Documentation 
Library.

If this parameter is set to “Y”, Quality Center 
connects to the Documentation Library via the Web, 
from Mercury servers. The Web-based 
documentation is updated on an ongoing basis. 

ADD_NEW_USERS_FROM
_PROJECT

(formerly 
CUSTOM_ENABLE_USER_
ADMIN)

If this parameter is set to “N”, you can add new 
Quality Center users from Site Administration 
(Site Users tab) only. If this parameter is set to “Y” 
(the default), new Quality Center users can also be 
added from Project Customization. In the Set Up 
Project Users page, click Add User. The Add User to 
Project dialog box opens. If this parameter is set to 
“Y”, a New button is available for adding new 
Quality Center users. For more information, see 
“Adding a User to a Project” on page 134.

ATTACH_MAX_SIZE The maximum size (in kilobytes) of an attachment 
that can be sent with e-mail from Quality Center. If 
the attachment size is greater than the specified 
value, the e-mail will be sent without the 
attachment. By default, the maximum e-mail 
attachment size is 3,000 KB.
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AUTO_MAIL_WITH_
ATTACHMENT

(formerly SAQ_MAIL_
WITH_ATTACHMENT)

If this parameter is set to “Y” (the default), defect 
e-mail is sent with attachments. This applies only if 
you select Send defect e-mail messages 
automatically in the Site Projects tab. For more 
information, see Chapter 12, “Configuring 
Automail”.

Note: The former parameter name is supported for 
purposes of backward compatibility.

AUTO_MAIL_WITH_
HISTORY

(formerly SAQ_MAIL_
WITH_HISTORY) 

If this parameter is set to “Y” (the default), defect 
e-mail is sent with the history. This applies only if 
you select Send defect e-mail messages 
automatically in the Site Projects tab. For more 
information, see Chapter 12, “Configuring 
Automail”.

Note: The former parameter name is supported for 
purposes of backward compatibility.

BASE_REPOSITORY_PATH The base repository path. The Quality Center and 
Site Administration repositories are subfolders of this 
repository. If you change this parameter value, you 
must copy the repository to its new location and 
then restart all servers in the cluster.

CREATE_HTTP_SESSION If this parameter is set to “Y”, Quality Center creates 
an HTTP session. This is useful for session stickiness 
when load balancing Quality Center in a cluster.

By default, this parameter is set to “N”.

LDAP_SEARCH_USER_
CRITERIA

A comma-separated list of Quality Center user 
properties to be used as LDAP search criteria, if the 
Domain Authentication property does not contain 
the user’s distinguished name (DN). The order of the 
properties defines their priority if multiple results are 
found. The following are the possible values: 
username, email, fullname, phone, description. For 
more information on LDAP, see “Enabling LDAP 
Authentication for Users” on page 81.

Parameter Description
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LICENSE_ARCHIVE_
PERIOD

The time interval in days during which license usage 
is archived. License usage information before this 
period is removed from the archive. 

By default, the value is set to 365 days. If you set the 
value to -1, the license archive period is unlimited. 

LOCK_TIMEOUT The maximum number of hours that Quality Center 
objects can remain locked. After this time, the lock is 
removed. By default, the value is set to 10 hours. 

MAIL_FORMAT The format Quality Center uses to send e-mail. By 
default, the format is set to “HTML”. To instruct 
Quality Center to send e-mail as plain text, change 
the value to “Text”. Quality Center uses e-mail to 
send defects, requirements, tests, and test set 
notifications to Quality Center users. 

MAIL_INTERVAL The time interval in minutes for sending defect 
e-mail according to your mail configuration settings. 
By default, the value is set to 10 minutes. Note that 
this applies only if you select Send defect e-mail 
messages automatically in the Site Projects tab. For 
more information, see Chapter 12, “Configuring 
Automail”.

MAIL_MESSAGE_
CHARSET

The character set used by Quality Center to send 
e-mail to users. By default, the value is set to UTF-8.

SITE_ANALYSIS If this parameter is set to "Y" (the default), you can 
track Quality Center license usage over time from 
the Site Analysis tab. If this parameter is set to "N", 
the Site Analysis tab is unavailable. For more 
information, see Chapter 7, “Analyzing Site Usage”.

Parameter Description
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VC If this parameter is set to “Y”, version control is 
enabled. If you enable version control, you can 
create a version control database for any project. 

If it is set to “N” (the default), version control is 
disabled. 

Note: To work with version control, you must install 
a supported version control tool and the Mercury 
Quality Center Version Control Add-in on your 
Quality Center server. For more information on 
Mercury Quality Center add-ins, refer to the Mercury 
Quality Center Installation Guide.

WAIT_BEFORE_
DISCONNECT

The time interval in minutes that the Quality Center 
client can be inactive before it is disconnected from 
the Quality Center server. Disconnecting the client 
enables the license to be used by another Quality 
Center user. By default, the value is set to 600 
minutes. The minimum value for this parameter is 
15 minutes; Quality Center ignores values lower 
than this. If you set the value to -1, Quality Center 
will not disconnect, regardless of how long the 
client is inactive.

Parameter Description
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You can add the following Quality Center configuration parameters: 

Parameter Description

AUTO_MAIL_SUBJECT_
FORMAT

(formerly SAQFORMAT)

This parameter enables you to customize the subject 
line of defect e-mail sent automatically to users.

For example, you can define a subject line such as 
Defect no. 4321 has changed by providing the value 
Defect no. ?BG_BUG_ID has changed, where Defect 
no. and has changed are strings, and BG_BUG_ID is a 
Quality Center field name.

To customize the subject line for a specific project, 
see “Customizing the Subject of Defect Mail” on 
page 183.

Note: The former parameter name is supported for 
purposes of backward compatibility.

BACKWARD_SUPPORT_
ALL_DOMAINS_PROJECTS

This parameter enables the use of DomainsList and 
ProjectsList properties for the purposes of backward 
compatibility. If this parameter is set to “Y”, then 
the DomainsList and ProjectsList properties are 
supported. If the parameter does not exist or is 
empty, the default value is “N”, and these properties 
are not supported.

BACKWARD_SUPPORT_
SA_DEFAULT_USER

This parameter enables the use of the old connection 
method to Site Administration for the purposes of 
backward compatibility. To work with scripts that 
use the old connection method (where the site 
administrator only required a password to log in), a 
user should be defined, and this user’s password will 
be used during login. The value of this parameter is a 
user name, whose password will be used. If the 
parameter does not exist or is empty, an empty 
string is used.
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COPY_CHANGES_
USER_FIELDS

(formerly COPY_PASTE_
CHANGES_OWNER)

This parameter enables you to specify that the user 
who copies a record is listed in the specified User List 
fields of the copy. For more information on fields 
that have User List as their Field Type, see 
“Customizing Project Entities” on page 166.

The value of this parameter is a comma-separated list 
of User List fields.

For example, set the value of the parameter to 
BG_DETECTED_BY. Assume defect 10 is detected by 
user Cecil_qc, and user Shelly_qc copies defect 10. 
Quality Center creates a copy of the defect with 
Shelly_qc as the user who detected the defect, not 
Cecil_qc. 

LDAP_TIMEOUT

(formerly 
DIRECTORY_TIME_LIMIT_
CONSTRAINT)

The length of time, in seconds, that Quality Center 
waits before canceling an LDAP operation.

The time limit on LDAP operations prevents a 
situation where LDAP encounters a problem and 
causes Quality Center to wait indefinitely. The 
default timeout value is 10 minutes (600 seconds).

For more information about using LDAP, see 
Chapter 4, “Managing Quality Center Users”.

DISABLE_COMMAND_
INTERFACE

If this parameter is set to “Y” (the default), only users 
belonging to the TDAdmin group can use the OTA 
Command object.

If it is set to “N”, any user can use it.

For more information, refer to the Mercury Quality 
Center Open Test Architecture API Reference.

Parameter Description
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DISABLE_EXTENDED_
STORAGE

This parameter controls user access to the OTA 
ExtendedStorage object. This is a security feature 
that can be used to limit access to the file system of 
the project.

If this parameter is set to "Y" (the default), the 
ExtendedStorage object cannot be accessed from 
TDConnection. Users can access the object from a 
specific entity for read-only, but no changes can be 
made.

If it is set to "N", the ExtendedStorage object can be 
accessed by all users, from a specific entity or from 
TDConnection.

For more information about the ExtendedStorage 
object, refer to the Mercury Quality Center Open Test 
Architecture API Reference.

HEBREW If this parameter is set to “Y”, it indicates that the 
Quality Center server is Hebrew-enabled. On a per 
project basis, you can then enable Hebrew by 
selecting Allow Hebrew language in the Site Projects 
tab. When users work in a Hebrew-enabled project, 
they can toggle between English and Hebrew by 
choosing Tools > Reading Order > Right to Left.

LR DIRECTFILEACCESS This parameter applies if you are integrating with 
Mercury LoadRunner. If set to “Y”, it enables the 
direct accessing of scripts located within the same 
LAN as your Quality Center client/server.

Note: In a UNIX or Linux environment, you must 
also set the UNIX_SERVER parameter.

MIGRATION_MAX_
NUMBER_OF_PROJECTS

The maximum number of projects that can be 
migrated from TestDirector to Quality Center at one 
time. By default, you can migrate up to 50 projects at 
a time.

For more information on migration, see “Migrating 
TestDirector Projects to Quality Center” on page 54.

Parameter Description
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NLS_SEARCH_LOCALE The language used by the Find Similar Defects 
command to tokenize the defect summary. This 
parameter is needed only if the default locale on the 
server does not match the language in which the 
defect summary is written, in terms of whether 
spaces are used to separate words.

The value should be a string value that matches a 
language code listed in ISO 639 
(http://www.w3.org/WAI/ER/IG/ert/iso639.htm). 

For example, if the default locale is English and the 
text is in Japanese, which does not use spaces to 
separate words, set NLS_SEARCH_LOCALE=ja. 

If this parameter is not defined or is invalid, the 
default locale of the server is used.

REPLACE_TITLE This parameter enables you to change the names of 
Quality Center modules across all your projects. 

Rename one or more modules by entering the 
following parameter value: 
<original title1 [singular]>;<new title1 [singular]>;
<original title1 [plural]>;<new title1 [plural]>;
<original title2 [singular]>;<new title2 [singular]>;...

For example, if you want to change the name of the 
Defects module to Bugs, and the Requirements 
module to Goals, enter the following: 
Defect;Bug;Defects;Bugs;Requirement;Goal; 
Requirements;Goals

Note: To rename the Defects module for a specific 
project only, see “Renaming the Defects Module for 
a Project” on page 48.

REQUIREMENT_
REVIEWED_FIELD_
AUTOMATIC_UPDATE

If this parameter is set to “Y” (the default), then any 
change to a requirement field automatically sets the 
Reviewed (RQ_REQ_REVIEWED) field to “Not 
Reviewed”. 

If it is set to “N”, then a change to a requirement 
field does not affect the value of the Reviewed field. 

Parameter Description
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SECURED_QC_URL When Quality Center generates e-mail, it includes a 
link to Quality Center in the e-mail. 

If this parameter is set to “Y”, the Quality Center 
URL uses an SSL connection (starting with https:).
If it is set to “N” (the default), SSL is not used. 

UNIX_SERVER If this parameter is set to “Y”, it enables direct file 
access from a testing tool on a Windows machine to 
a UNIX based repository. 

You must then add a new parameter for each 
directory on the UNIX server machine you want to 
be able to access externally and specify the 
corresponding Windows path, as follows:

• Parameter name is FOLDER_MAPPING_n where 
n is an identifying number. For example, 
FOLDER_MAPPING_1

• Parameter value is in the format 
UNIXpath->Windowspath 
For example, 
/opt/Mercury/repository/qc/->\\netapp\qc\repository\

Note: This parameter applies to the following testing 
tools: WinRunner and LoadRunner.

WR DIRECTFILEACCESS This parameter applies if you are integrating with 
Mercury WinRunner. If set to “Y”, it enables the 
direct accessing of scripts located within the same 
LAN as your Quality Center client/server.

Note: In a UNIX or Linux environment, you must 
also set the UNIX_SERVER parameter.

Parameter Description
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To set Quality Center parameters:

 1 In Site Administration, click the Site Configuration tab.

 2 To add a new parameter to the list, click the New Parameter button. The 
New Parameter dialog box opens. Type a name, value, and description for 
the parameter you want to add. Click OK.

 3 To delete a parameter from the list, select it and click the Delete Parameter 
button. Click Yes to confirm.

 4 To edit a parameter, select it from the list and click the Edit Parameter 
button. The Edit Parameter dialog box opens. Type a new value and value 
description, and click OK.

 5 To export parameters from the site configuration grid to a text file, click the 
Export button. The Export Data To File dialog box opens. Select the 
directory where you want to save the parameters, and enter a name for the 
file in the File name box. Click Save.

 6 You can click the Refresh Parameters List button to refresh the parameter 
list.

 7 Users must reconnect to any open projects to work with the new settings.
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Setting the Quality Center Mail Protocol

Quality Center uses e-mail to send project information to users. You can 
select the mail service to be used by all the server nodes in your Quality 
Center site. Quality Center supports the SMTP mail protocols.

For more information on setting the Quality Center mail protocol, refer to 
the Mercury Quality Center Installation Guide.

To set the Quality Center mail protocol:

 1 In Site Administration, click the Site Configuration tab.

 2 Click the Settings button and choose Set Mail Protocol. The Set Mail 
Protocol dialog box opens.

 3 Select one of the following options:

➤ None: Quality Center does not send e-mail.

➤ SMTP Server: Quality Center sends e-mail from an SMTP server on the 
network. Type the address of an SMTP server available on your local area 
network.

➤ Microsoft IIS SMTP Service: Quality Center sends e-mail from the Quality 
Center server machines. This option is available if you installed Microsoft 
IIS SMTP Service on your Quality Center server machines during IIS 
installation.

 4 Click Test to send a test e-mail to your mailbox. The Test Mail dialog box 
opens. Type your e-mail address and click Send.

 5 Click OK to close the Set Mail Protocol dialog box.
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7
Analyzing Site Usage

In Site Administration, you can track the number of licensed users that have 
connected to your Quality Center site at specific points over a period of 
time. You can also analyze Quality Center usage by filtering the number of 
licensed users by projects or users.

This chapter describes:

➤ About Analyzing Site Usage

➤ Monitoring Site Usage

➤ Filtering Site Usage

➤ Exporting Site Analysis Data to a File

➤ Customizing the Site Analysis Line Chart Graph

About Analyzing Site Usage

You use the Site Analysis tab in Site Administration to monitor license usage 
for each time interval displayed. You can specify the time interval displayed 
along the x-axis. You can also specify what information appears in the graph 
by filtering the graph content by projects or users. 

For example, you may want to charge each department in your organization 
according to license usage. You can filter by projects in a specific department 
to view license usage for the department. You can also view license usage for 
a specific group of users by filtering according to selected users.
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If the Site Analysis tab is not displayed, you can make it available by 
changing the SITE_ANALYSIS parameter in the Site Configuration tab. For 
more information, see “Setting Quality Center Configuration Parameters” 
on page 107.

Monitoring Site Usage 

You can monitor the number of licensed users that have connected to a 
Quality Center site over a period of time. You can view site usage for the last 
seven days, the last five weeks, the last twelve months, or for all days that 
users were connected to a Quality Center server. 

You can also monitor usage of different license types. Users with Full 
Licenses can access all modules in a specific project. Users with Defect 
Licenses can access only the Defects module. This data can be displayed in 
line graphs or data grids.

In addition, you can filter records by projects or users, refresh and clear filter 
settings, and save data to a file.

Note: You can monitor the users currently connected to a Quality Center 
server. For more information, see Chapter 5, “Managing User Connections 
and Licenses.”
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To monitor site usage:

 1 In Site Administration, click the Site Analysis tab.

 2 In the Type box, select a display type:

➤ Line Chart: Displays the data as a line graph.

➤ Data Grid: Displays the data as a grid.

 3 In the right pane under Period, select the period of time you want the line 
graph or data grid to show.

 4 Click the Filter button to open the Set Filter dialog box and filter the graph 
contents. For more information, see “Filtering Site Usage” on page 122.

 5 To customize the appearance of a Line Chart graph, see “Customizing the 
Site Analysis Line Chart Graph” on page 124.

 6 If you chose Data Grid, you can save the contents of a data grid as a text file, 
Microsoft Excel spreadsheet, Microsoft Word document, or HTML 
document. To save, click the Save As button. For more information, see 
“Exporting Site Analysis Data to a File” on page 123.

 7 To refresh data in the graph, click the Refresh button.
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Filtering Site Usage

You can analyze the number of users that have connected to your Quality 
Center site at specific points over time by filtering by projects or users.

To filter site usage:

 1 Click the Filter button. The Set Filter dialog box opens.

 2 Under Filter by, select the category that you want to filter:

➤ Projects: Displays all the Quality Center domains and projects.

➤ Users: Displays all the Quality Center site users.

 3 Click the items you want to include in the filter.

➤ For Projects, double-click the domain folder to display the domain’s 
projects, and select the projects you want to include. To filter all projects 
in the domain, select the domain folder.

➤ For Users, select the users you want to include.

 4 To clear the selected projects or users in a filter, click the Clear button.

 5 Click OK to apply the filter and close the Set Filter dialog box. The new line 
chart or data grid is displayed.



Chapter 7 • Analyzing Site Usage

123

Exporting Site Analysis Data to a File 

You can export site analysis data in a Data Grid as a text file, Microsoft Excel 
spreadsheet, Microsoft Word document, HTML document, or XML 
document.

To export Site Analysis data to a file:

 1 In Site Administration, click the Site Analysis tab.

 2 In the Type field, select the Data Grid display type.

 3 Select the graph period and filter.

 4 Click Save as, and select one of the following formats:

➤ Text Format: Saves the data as a Text file.

➤ Excel Sheet: Saves the data as an Excel sheet.

➤ Word Document: Saves the data as a Word document.

➤ HTML Document: Saves the data as an HTML document.

 5 In the Save in box, choose a location for the file.

 6 In the File name box, type a name for the file.

The Save as type box is automatically filled according to the format you 
selected.

 7 Click Save.
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Customizing the Site Analysis Line Chart Graph

You can determine how information appears in the Line Chart graph using 
the line chart toolbar. The toolbar includes the following buttons:

Show Total Values: Toggles between displaying and hiding a total value in 
the graph.

Scroll to the Left: Scrolls the graph to the left. (This button is enabled when 
the Zoom In and Zoom Out buttons are in use.)

Scroll to the Right: Scrolls the graph to the right. (This button is enabled 
when the Zoom In and Zoom Out buttons are in use.)

Show All: Returns the graph to its normal size. (This button is enabled when 
the Zoom In and Zoom Out buttons are in use.)

Zoom In: Increases the magnification of the selected portion of the graph.

Zoom Out: Decreases the magnification of the selected portion of the graph.

Rotate Bottom Labels: Toggles between displaying the text on the x-axis 
vertically and horizontally.

Set 2D/3D Graph: Toggles the graph from two to three dimensions.

Copy Graph to Clipboard: Copies the graph to the Clipboard.

Print Graph: You can choose to print the graph in portrait or landscape view.
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8
Project Customization at a Glance

As a Quality Center project administrator, you use Project Customization to 
control access to a project by defining the users who can access the project 
and by determining the types of tasks each user can perform. You can also 
customize a project to meet the specific requirements of your testing team. 
Non-project administrators can also use Project Customization, however, 
the customization functions available are limited depending on the user 
group to which they belong.

This chapter describes:

➤ Starting Project Customization

➤ Understanding the Project Customization Window

Starting Project Customization 

You can customize your Quality Center projects using the Project 
Customization window.

Note: Users belonging to the Viewers group cannot view or change any 
settings in the Project Customization window.
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To start project customization:

 1 Open your Web browser and type your Quality Center URL
http://<Quality Center server name>[<:port number>]/qcbin. The Mercury 
Quality Center Options window opens.

 2 Click the Quality Center link.

The first time you run Quality Center, files are downloaded to your 
workstation. Subsequently, Quality Center carries out a version check. If 
there is a newer version on the server, updated files are downloaded to your 
workstation. 

Note: To download files to your computer, you must log in with 
administrator privileges. This applies if you are running Quality Center for 
the first time, upgrading to a newer version, or applying a service pack.
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After the Quality Center version has been checked and files have been 
updated if necessary, the Mercury Quality Center Login window opens.

 3 In the User Name box, type your user name. 

If you type a user name that does not have administrator privileges for a 
particular project, you are restricted to the customization functions available 
for that user group. For more information, see “About Managing User 
Groups and Permissions” on page 140.

 4 In the Password box, type your password. 

After you log in to Quality Center, you can change your password from the 
Project Customization window. For more information, refer to the Mercury 
Quality Center User’s Guide. In addition, site administrators can change their 
password from Site Administration. For more information, see “Changing 
Passwords” on page 79.
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 5 Select the Automatically log in to my last domain and project on this 
machine check box if you want Quality Center to automatically log in to the 
last project in which you were working.

 6 Click Authenticate. Quality Center verifies your user name and password 
and determines which domains and projects you may access. If you 
specified automatic login, Quality Center opens.

 7 In the Domain list, select a domain. By default, the last domain in which 
you were working is displayed.

 8 In the Project list, select a project. By default, the last project in which you 
were working is displayed.

 9 Click Login. Quality Center opens and displays the module (Requirements, 
Test Plan, Test Lab, and Defects) in which you last worked during your 
previous session.

 10 Choose Tools > Customize on the upper-right corner of the window. The 
Project Customization window opens and displays the customization 
functions available for the user group to which the user belongs. For more 
information, see “Understanding the Project Customization Window” on 
page 131.

 11 To exit the Project Customization window and return to your Quality 
Center project, click the Return button located on the upper-right corner of 
the window.
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Understanding the Project Customization Window

As a Quality Center project administrator, you can customize a project to 
meet the specific requirements of your testing team in the Project 
Customization window.

The Project Customization window contains the following links:

➤ Change User Properties: Non-project administrators can use this option to 
change their user properties and password. For more information, refer to 
the Mercury Quality Center User’s Guide. 

In Site Administration, a site administrator can override and change a user’s 
properties and password from the Site Users tab. For more information, see 
“Updating User Details” on page 78, and “Changing Passwords” on page 79.

➤ Set Up Project Users: You can add and remove users from a Quality Center 
project. You can also assign users to user groups to restrict user access 
privileges. For more information, see Chapter 9, “Managing Users in a 
Project.”

Note that you create Quality Center users and define user properties from 
Site Administration. For more information, see Chapter 4, “Managing 
Quality Center Users.”
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➤ Set Up Groups: You can assign privileges to user groups by specifying 
permission settings. This includes specifying transition rules and hiding 
data. For more information, see Chapter 10, “Managing User Groups and 
Permissions”.

➤ Customize Module Access: You can control the modules that each user 
group can access. By preventing users from accessing unnecessary modules, 
you can better utilize your Quality Center licenses. For more information, 
see “Customizing Module Access for User Groups” on page 163.

➤ Customize Project Entities: You can customize your Quality Center project 
to suit your testing environment. A project can contain system fields and 
user-defined fields. System fields can be modified. User-defined fields can be 
added, modified, and deleted. For more information, see “Customizing 
Project Entities” on page 166.

➤ Customize Project Lists: You can add customized field lists to a project. A 
field list contains values that the user can enter in system or user-defined 
fields. For more information, see “Customizing Project Lists” on page 175.

➤ Configure Automail: You can set up automatic mail notification rules to 
inform users via e-mail about defect repair activity. For more information, 
see Chapter 12, “Configuring Automail”.

➤ Set Traceability Notification Rules: You can activate traceability notification 
rules for your project. This instructs Quality Center to create alerts and send 
traceability notification e-mail when changes occur in the project. For more 
information, see Chapter 13, “Setting Traceability Notification Rules”.

➤ Set Up Workflow: You can generate scripts to perform commonly needed 
customizations on the fields of the Defects module dialog boxes. For more 
information, see Chapter 14, “Generating Workflow Scripts”. 

In addition, you can write scripts to customize dialog boxes in any module, 
and to control the actions that users can perform. For more information, see 
Chapter 15, “Workflow Customization at a Glance”.
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Managing Users in a Project

As a Quality Center project administrator, you can control access to a 
project by defining the users who can log in to the project and by specifying 
the types of tasks each user may perform. 

This chapter describes:

➤ About Managing Users in a Project

➤ Adding a User to a Project

➤ Assigning Users to a User Group

➤ Removing a User from a Project

About Managing Users in a Project

For each Quality Center project, you must select a list of valid users from the 
overall Quality Center users list. (The users list is created in Site 
Administration. For more information, see Chapter 4, “Managing Quality 
Center Users”.) 

You then need to assign each project user to a user group. Each group has 
access to certain Quality Center tasks. 
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Adding a User to a Project 

You add new users to a Quality Center project by selecting them from the 
Quality Center users list created in Site Administration.

To add a user to a project:

 1 In the Project Customization window, click the Set Up Project Users link. 
The Set Up Project Users page opens.

You can click the User Name column to change the sort order from 
ascending to descending user names. You can also click the Full Name 
column to sort according to full names instead of user names.
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 2 Click the Add User button. The Add User to Project dialog box opens.

 3 Click the New button to add new Quality Center users to the list of available 
users. Note that if this button is not available, you can enable it by setting 
the ADD_NEW_USERS_FROM_PROJECT parameter in Site Administration 
(Site Configuration tab). For more information, see “Setting Quality Center 
Configuration Parameters” on page 107.

 4 Select a user name from the list and click OK. 

The user is added to the Project Users list and the user details are displayed. 
User details are defined in Site Administration. For more information, see 
“Updating User Details” on page 78.

 5 Click Save to save your changes to the Set Up Project Users page.
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Assigning Users to a User Group 

After you add a user to the project, you can assign the user to one or more 
user groups. You can assign a user to a default user group, or to a customized 
user group. For more information on customizing a user group, see 
Chapter 10, “Managing User Groups and Permissions”. You can change the 
access privileges for existing users at any time by changing the user group to 
which they are assigned.

To assign a user to a user group:

 1 In the Project Customization window, click the Set Up Project Users link. 
The Set Up Project Users page opens.

 2 In the Project Users list, select the user you want to assign to a user group. 
The user properties are displayed (name, e-mail, phone, and description). 

Note that the e-mail information is important as it enables a user to receive 
defects, tests, requirements, and test set notifications directly to their 
mailbox.

The user details are defined in Site Administration. For more information, 
see “Updating User Details” on page 78.
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 3 To assign the selected user to a user group, click a user group name in the 
Not Member Of list and click the left arrow button.

 4 To remove the user from the currently selected user group, click a user group 
name in the Member Of list and click the right arrow button.

 5 To move all the user groups from one list to the other, click the double arrow 
buttons.

 6 Click Save to save your changes to the Set Up Project Users page.

Removing a User from a Project 

To ensure the security of a project, you should remove any users who are no 
longer working on the project. Note that removing a user from a project 
does not delete the user from the Quality Center users list in Site 
Administration.

To remove a user from a project:

 1 In the Project Customization window, click the Set Up Project Users link. 
The Set Up Project Users page opens.
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 2 In the Project Users list, select the user you want to remove and click the 
Remove User button.

 3 Click OK to confirm. The user is removed from the Project Users list.

 4 Click Save to save your changes to the Set Up Project Users page.
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Managing User Groups and Permissions

You can control access to Quality Center projects and modules by defining 
the user groups that can enter them, and by determining the types of tasks 
each user group performs.

This chapter describes:

➤ About Managing User Groups and Permissions

➤ Adding User Groups

➤ Setting User Group Permissions

➤ Setting Transition Rules

➤ Hiding Data for a User Group

➤ Assigning Existing Sets of Permissions to User Groups

➤ Renaming User Groups

➤ Deleting User Groups

➤ Understanding the Permission Settings Tasks

➤ Customizing Module Access for User Groups
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About Managing User Groups and Permissions

To enable each team member to do his/her job and protect a project from 
unauthorized access, Quality Center lets you assign each member to a 
specific user group. Quality Center includes predefined user groups with 
default privileges. Each group has access to certain Quality Center tasks.

When a project requires that certain user groups have privileges that are 
outside the scope of their default permissions, you can add your own 
customized user groups and assign each group a unique set of privileges.

After you set user group permissions, you can also define the Quality Center 
modules to which you want to give a user group access. When a user group 
member logs in to a project, only the authorized modules are displayed.

User Group Permissions

TDAdmin 
(Project 
Administrator)

Group members have full privileges in a Quality Center project 
and in Project Customization.

Project 
Manager

Group members have full privileges in the following Quality 
Center modules: Requirements, Test Plan, Test Lab, and Defects. 
In Project Customization, the group has privileges to change 
user properties and password, customize project lists, and set 
traceability notification rules.

QATester Group members have full privileges in the following Quality 
Center modules: Requirements, Test Plan, and Test Lab. In the 
Defects module, the group can only add and modify defects, but 
not delete them. In Project Customization, the group has 
privileges to change user properties and password, customize 
project lists, and set traceability notification rules.

Developer Group members are limited to modifying attachments or 
requirement details in the following Quality Center modules: 
Requirements, Test Plan, and Test Lab. In the Defects module, 
group members can only add and modify defects, but not delete 
them. In Project Customization, the group has privileges to 
change user properties and password.

Viewer Group members have read-only privileges in a Quality Center 
project, and no privileges in Project Customization.
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Adding User Groups

If you determine that the default user groups do not meet the needs of your 
project, you can create additional user groups for your project.

To add a user group:

 1 In the Project Customization window, click the Set Up Groups link. The Set 
Up Groups page opens.

 2 Click the New button. The New Group dialog box opens.
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 3 In the Name box, type a name for the group.

 4 In the Create As list, assign the new group the privileges of an existing user 
group. 

Tip: Choose an existing user group that has similar access privileges to the 
new user group you want to create. This minimizes the level of 
customization you will need to do.

 5 Click OK. 

 6 Click Yes to confirm. The new group name is added to the Groups list in the 
Set Up Groups page.

 7 Click Save to save your changes to the Set Up Groups page.

Setting User Group Permissions 

Every user group has a set of privileges, or permissions, which are defined by 
the Quality Center project administrator. You generally set the permissions 
for custom user groups at the beginning of the project, but you can modify a 
user group’s permissions at any time. 

For example, suppose a group of users called DOC has Viewer permissions. 
In order to work more effectively on the project, they need to add, modify, 
and delete defects. As the Quality Center project administrator, you can 
assign these privileges to the DOC group by specifying permission settings.

Note: You cannot modify the privileges of a default user group. To view 
permissions for a default user group, in the Set Up Groups page, select the 
user group in the Groups list and click the View button. For more 
information, see “Understanding the Permission Settings Tasks” on 
page 153.
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To set user group permissions:

 1 In the Project Customization window, click the Set Up Groups link. The Set 
Up Groups page opens.

 2 In the Groups list, choose the user group for which you want to set 
permissions. 

 3 Click the Change button. The Permission Settings dialog box opens.
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 4 Click a permission tab. For example, click Defects. The tab displays the tasks 
available in the Defects module. 

 5 Select the tasks that the selected user group can use. For more information 
on the available tasks, see “Understanding the Permission Settings Tasks” on 
page 153.

 6 When you select a task with a sublevel, a list of associated fields appears 
below. Select the check boxes of the fields that the selected user group can 
use.

 7 To limit the capabilities of modifying a field, do any of the following:

➤ To ensure that only the person who originally created the entry can 
change that value, select Can be modified by owner only. For more 
information, see the following section, “Owning Quality Center 
Objects”.

➤ To limit the values a user group can select from a lookup list type field, 
set transition rules of permissible field values. For more information, see 
“Setting Transition Rules” on page 146.

Transition 
rules for a 
selected field

Permission tab

Field

Data-hiding 
filter

Field
modification
by owner only

Task
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 8 For deleting tasks, you can ensure that only the person who originally 
created the entry can delete the value by selecting Can be deleted by owner 
only. For more information, see the following section, “Owning Quality 
Center Objects”.

 9 You can click the Data-Hiding Filter link to hide data from the current user 
group in the Test Plan, Test Lab, and Defects modules. For more 
information, see “Hiding Data for a User Group” on page 149.

 10 Click OK to close the Permission Settings dialog box.

 11 Click Save to save your changes to the Set Up Groups page.

Owning Quality Center Objects

When setting group permissions, you can limit the capabilities of modifying 
or deleting a field value, so that only the person who originally created the 
entry can change or delete the value. The following table describes the 
objects in Quality Center and the users that are defined as the default 
owners of the objects.

Note: You can change the owner of a Quality Center object by modifying 
the value of TB_OWNER_FIELD_NAME in the Tables table. For more 
information on the Tables table, refer to the Mercury Quality Center Database 
Reference.

Quality Center Object Owner

Requirement The Author field (RQ_REQ_AUTHOR).

Test in the Test Plan module The Designer field (TS_RESPONSIBLE).

Test in the Test Lab module The Responsible Tester field 
(TC_TESTER_NAME).

Test run in the Test Lab 
module

The Tester field (RN_TESTER_NAME).

Defect The Assigned To field (BG_RESPONSIBLE).
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Setting Transition Rules 

You can limit a group’s modifying privileges by setting transition rules for 
modifying values in fields. These rules determine the values that the group 
can modify in fields that you specify. Note that transition rules can be set 
only for lookup list fields.

For example, when modifying defect information, you can limit the items a 
user group can select in the Status field of a defect record. You can set a 
transition rule that only allows a user group to edit the Status field from 
“Fixed” to “Closed”.

Note: When Set Up Workflow has been used to change a list of values for a 
field that is set with transition rules, the field may only be modified in a way 
that satisfies both the workflow script and the transition rules. For more 
information, see Chapter 17, “Workflow Event Reference.”

To set transition rules:

 1 In the Project Customization window, click the Set Up Groups link. The Set 
Up Groups page opens.

 2 In the Groups list, choose the user group for which you want to set 
permissions. 

 3 Click the Change button. The Permission Settings dialog box opens.

 4 Click a permission tab. For example, click Defects. The tab displays the tasks 
available in the Defects module.

 5 Select a task. For example, select Modify Defect. The task expands and lists 
available fields.

For more information on the available tasks, see “Understanding the 
Permission Settings Tasks” on page 153.
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 6 Under the selected task, select a field. For example, select Status. The 
Transition Rules grid appears on the right pane of the Permission Settings 
dialog box. 

 7 Click Add to add a transition rule. The Transition Rules Editor dialog box 
opens. 

Transition 

Task

Field
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 8 Under From, you can: 

➤ Select $ANY to allow a user group to modify the field, irrespective of the 
currently displayed value. 

➤ Select a value from the list. A user group will be able to modify the 
selected field only when the field displays the value you select. For 
example, to allow a user group to edit the Status field of a defect only if 
“Fixed” is the current value, select Fixed.

 9 Under To, you can:

➤ Select $ANY to allow a user group to change the field to any value. 

➤ Select a value from the list. A user group will be able to change the value 
of the selected field to only the value that you specify. For example, to 
allow a user group to change the value of the Status field only to 
“Closed”, select Closed.

 10 Click OK to save and close the Transition Rules Editor dialog box. The new 
rules are displayed in the Transition Rules grid. 

 11 To modify a transition rule, select a rule from the Transition Rules grid and 
click the Edit button. In the Transition Rules Editor dialog box, modify the 
rule. Click OK.

 12 To delete a transition rule, select a rule from the Transition Rules grid and 
click the Delete button. Click OK to confirm.

 13 Click OK to close the Permission Settings dialog box.

 14 Click Save to save your changes to the Set Up Groups page.



Chapter 10 • Managing User Groups and Permissions

149

Hiding Data for a User Group 

You can instruct Quality Center to hide specific records that a user group 
can view in the Test Plan, Test Lab, and Defects modules. This includes the 
following options:

➤ Filtering Data: You can set filters for specific fields, limiting the records that 
the user group can view. For example, you can set the filter for the field 
Assigned To to “[CurrentUser]”. This instructs Quality Center to allow only 
the current user to view specific records that are assigned to him or her.

For more information on filtering, refer to the Mercury Quality Center User’s 
Guide. 

➤ Defining Visible Fields: You can select which fields in a module the user 
group can see and which should be hidden. This can help in simplifying the 
volume of data displayed. Users belonging to a specific user group need to 
view only data that relates to their work. For example, in the Test Plan tab, 
you may want to hide the Path field from user groups that should not be 
able to access test scripts from the file system. Note that you cannot hide 
required fields.

To hide data:

 1 In the Project Customization window, click the Set Up Groups link. The Set 
Up Groups page opens.

 2 In the Groups list, choose the user group for which you want to set 
permissions. 

 3 Click the View button. The Permission Settings dialog box opens.

 4 Click a permission tab. For example, click Defects. The tab displays the tasks 
available in the Defects module.
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 5 Click the Data-Hiding Filter link located at the bottom left corner of the 
dialog box. For example, in the Defects tab, click the Defects Data-Hiding 
Filter. The Defects Data-Hiding Filter dialog box opens and displays the 
Filter tab.

 6 Set one or more filters. The filter set determines the records that a user group 
can view in Quality Center. For more information, refer to the Mercury 
Quality Center User’s Guide.
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 7 Click the Visible Fields tab. 

 8 Select or clear the appropriate fields.

 9 Click OK to close the Data-Hiding Filter dialog box.

 10 Click Close to close the Permission Settings dialog box.

 11 Click Save to save your changes to the Set Up Groups page.
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Assigning Existing Sets of Permissions to User Groups

During the course of a project, you can assign one user group another user 
group’s permissions.

To assign an existing set of permissions to a user group:

 1 In the Project Customization window, click the Set Up Groups link. The Set 
Up Groups page opens.

 2 In the Groups list, select a group name. 

 3 Click the Set As button. The Set Group As dialog box opens. 

 4 In the Set As list, select a group name. 

 5 Click OK.

 6 Click Yes to confirm. 

Renaming User Groups

You can rename a user group. Note that all customization performed on the 
group remains.

To rename a user group:

 1 In the Project Customization window, click the Set Up Groups link. The Set 
Up Groups page opens.

 2 In the Groups list, select a group name. 

 3 Click the Rename button. The Rename Group dialog box opens.

 4 Type a new name for the group.

 5 Click OK to save your changes.
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Deleting User Groups

You can delete user groups that were added to a Quality Center project.

To delete a user group:

 1 In the Project Customization window, click the Set Up Groups link. The Set 
Up Groups page opens.

 2 In the Groups list, select a group name. 

 3 Click the Delete button.

 4 Click OK to confirm.

Understanding the Permission Settings Tasks

You can display the permissions of user groups in the Permission Settings 
dialog box. You can modify the permissions of custom user groups at any 
time. You cannot modify the permissions of the default user groups 
(TDAdmin, QATester, Project Manager, Developer, and Viewer). 

To display permissions for a custom user group, in the Set Up Groups page, 
select the user group in the Groups list, and click the View or Change 
button. For a default user group, click the View button. The Permission 
Settings dialog box opens. 

The Permission Settings dialog box contains the following tabs: 
Requirements, Business Components, Test Plan, Test Lab, Defects, and 
Administration. If you use Mercury Business Process Testing, refer to the 
Mercury Business Process Testing User’s Guide.
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Requirements Tasks

The Requirements tab displays the tasks available in the Requirements 
module.

The Requirements tab includes the following tasks:

Task Description

Add Requirement User group can add requirements to the 
requirements tree.

Modify Requirement User group can modify requirements in the 
requirements tree. Note that this task enables you to 
specify the fields that the selected user group can 
modify. To ensure that only the owner of the 
requirement can modify it, click the Can be 
modified by owner only check box.

Delete Requirement User group can delete requirements from the 
requirements tree. To ensure that only the owner of 
the requirement can delete it, click the Can be 
deleted by owner only check box.
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Test Plan Tasks

The Test Plan tab displays the tasks available in the Test Plan module. 

Add Tests to Coverage User group can add tests coverage to a requirement 
and requirements coverage to a test.

Remove Tests from 
Coverage

User group can remove tests coverage from a 
requirement and requirements coverage from a test.

Task Description
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The Test Plan tab includes the following tasks:

Task Description

Add Test User group can add tests to the test plan tree. 

Modify Test User group can modify tests in the test plan tree. 
Note that this task enables you to specify the fields 
that the selected user group can modify. To ensure 
that only the owner of the test can modify it, click 
the Can be modified by owner only check box.

Delete Test User group can delete tests from the test plan tree. 
To ensure that only the owner of the test can delete 
it, click the Can be deleted by owner only check 
box.

Add Design Step User group can add design steps in the Design Steps 
tab. 

Modify Design Step User group can modify design steps in the Design 
Steps tab. Note that this task enables you to specify 
the fields that the selected user group can modify. 

Delete Design Step User group can delete design steps from the Design 
Steps tab. To ensure that only the owner of the 
design step can delete it, click the Can be deleted by 
owner only check box.

Add Folder User group can add folders to the test plan tree.

Modify Folder User group can modify folders in the test plan tree. 
Note that this task enables you to specify the fields 
that the selected user group can modify. 

Delete Folder User group can delete folders from the test plan tree.

Move Folder User group can move folders in the test plan tree.

Copy Folder User group can copy folders in the test plan tree.

Generate Script User group can convert the test steps of a manual 
test, displayed in the Design Steps tab, into an 
automated test.
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Test Lab Tasks

The Test Lab tab displays the tasks available in the Test Lab module.

The Test Lab tab includes the following tasks:

Task Description

Add Test Set User group can add test sets. 

Modify Test Set User group can modify test sets. Note that this task 
enables you to specify the fields that the selected 
user group can modify.

Delete Test Set User group can delete test sets. 

Move Test Set User group can move test sets to different folders in 
the test sets tree.

Copy Test Set User group can copy test sets to folders in the test 
sets tree.

Add Folder User group can add folders to the test sets tree.
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Modify Folder User group can modify folders in the test sets tree. 
Note that this task enables you to specify the fields 
that the selected user group can modify.

Delete Folder User group can delete folders in the test sets tree.

Move Folder User group can move folders in the test sets tree.

Copy Folder User group can copy folders in the test sets tree.

Add Tests to Test Set User group can add tests to a test set.

Modify Test in Test Set User group can modify tests in a test set. Note that 
this task enables you to specify the fields that the 
selected user group can modify. To ensure that only 
the owner of the test set can modify it, click the Can 
be modified by owner only check box.

Remove Test from Test Set User group can remove tests from a test set. 

Run Test User group can run tests. 

Modify Run User group can modify test run information. Note 
that this task enables you to specify the fields that 
the selected user group can modify. To ensure that 
only the owner of the run can modify it, click the 
Can be modified by owner only check box. 

Delete Run User group can delete test run information. To 
ensure that only the owner of the run can delete it, 
click the Can be deleted by owner only check box.

Reset Test Set User group can clear all runs in a test set. 

Add Hosts User group can add hosts for running tests.

Modify Hosts User group can modify host information.

Delete Hosts User group can delete hosts.

Add Host Group User group can add host groups for running tests.

Modify Host Group User group can modify host group information.

Delete Host Group User group can delete host groups.

Task Description
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Defects Tasks

The Defects tab displays the tasks available in the Defects module.

The Defects tab includes the following tasks:

Task Description

Add Defect User group can add defects to the Defects Grid. Note 
that you can customize the fields that appear in the 
Add Defect dialog box. Under Visible Fields in Add 
Defect Dialog Box, select the fields you want to be 
visible. Fields that are marked in red are mandatory 
if they are visible.

Modify Defect User group can modify defects in the Defects Grid. 
Note that this task enables you to specify the fields 
that the selected user group can modify. To ensure 
that only the owner of the defect can modify it, 
click the Can be modified by owner only check box.

Delete Defect User group can delete defects from the Defects Grid. 
To ensure that only the owner of the defect can 
delete it, click the Can be deleted by owner only 
check box.
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Add Defect Link User group can add defect links to the Quality 
Center entities.

Modify Defect Link User group can modify defect links. This task 
enables you to specify the fields that the selected 
user group can modify. 

Remove Defect Link User group can remove defect links from the Quality 
Center entities. To ensure that only the owner of the 
defect can delete it, click the Can be deleted by 
owner only check box.

Task Description
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Administration Tasks

The Administration tab displays the administrative tasks available in Quality 
Center.

The Administration tab includes the following tasks: 

Task Description

Add Public Favorite Views User group can add public favorite views. 

Modify Public Favorite 
Views

User group can modify public favorite views.

Delete Public Favorite Views User group can delete public favorite views.

Add Private Favorite Views User group can add private favorite views.

Modify Private Favorite 
Views

User group can modify private favorite views.

Delete Private Favorite 
Views

User group can delete private favorite views.
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Clear History User group can clear the information displayed in 
the History table. For instructions on clearing 
history, refer to the Mercury Quality Center User’s 
Guide.

Change User Properties & 
Password

User group can change their properties and 
password, using the Change User Properties link in 
the Project Customization window.

Set Up Project Users User group can add and remove users from a Quality 
Center project, using the Set Up Project Users link 
in the Project Customization window.

Set Up Groups User group can assign privileges to user groups and 
specify permission settings, using the Set Up Groups 
link in the Project Customization window.

Customize Module Access User group can decide the type of access a user 
group can have for Quality Center, using the 
Customize Module Access link in the Project 
Customization window.

Customize Project Entities User group can customize fields in a Quality Center 
project, using the Customize Project Entities link in 
the Project Customization window. 

Customize Project Lists User group can add their own customized lists to a 
project, using the Customize Project Lists link in the 
Project Customization window.

Configure Automail User group can set up a mailing configuration to 
routinely inform users about defect repair activity, 
using the Configure Automail link in the Project 
Customization window.

Traceability Notification 
Rules

User group can set up traceability notification rules, 
using the Traceability Notification Rules link in the 
Project Customization window.

Set Up Workflow User group can write and/or generate scripts that 
dynamically change the user interface in the 
Quality Center modules, using the Set Up Workflow 
link in the Project Customization window.

Task Description
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Customizing Module Access for User Groups 

For each Quality Center project, you can control the modules that each user 
group can access. By preventing users from accessing unnecessary modules, 
you can better utilize your Quality Center licenses. For example, if a user 
group uses Quality Center only to add defects to a project, you can limit the 
group’s access to the Defects module only.

You can specify module access for a user group as follows:

➤ the Defects module only

➤ all Quality Center modules except the Business Components module

➤ all Quality Center modules including the Business Components module

Notes: 

➤ If access to the Business Components module is not enabled for a user 
group, those users can still view existing business process tests in read-
only mode. For more information, refer to the Mercury Business Process 
Testing User’s Guide.

➤ If you are working with the Quality Center Starter Edition, Business 
Process Testing is not supported.

You can monitor how many users are currently connected to a project, the 
time the users first logged in to the project, the time of the last action, and 
the type of access. For more information, see “Monitoring User 
Connections” on page 88. You can also determine the total number of 
Quality Center licenses in use. For more information, see “Managing 
Quality Center Licenses” on page 91.
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To customize module access for user groups:

 1 In the Project Customization window, click the Customize Module Access 
link. The Customize Module Access page opens.

The  icon indicates the modules that the user group can access.

To select or clear a cell in the table, double-click the cell, or select the cell 
and press the space bar.

 2 To select the Defects module only, select the Defects Module column. This 
clears the Quality Center column and the Business Process Testing column.

 3 To select the Quality Center modules, select the Quality Center column. This 
clears the Defects Module column.

 4 To select the Business Components module, select the Business Process 
Testing column. This selects the Quality Center column and clears the 
Defects Module column.

 5 Click Save to save your changes.
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11
Customizing Quality Center Projects 

As a Quality Center project administrator, you can customize a project to 
meet the specific needs of your testing team. For example, you can add or 
customize fields, and create categories and lists that reflect the needs of your 
testing project.

This chapter describes:

➤ About Customizing Quality Center Projects

➤ Customizing Project Entities

➤ Customizing Project Lists

About Customizing Quality Center Projects

Before you begin a project, you can customize your project to reflect your 
unique testing requirements. As a project progresses, you can further adjust 
the project to meet its changing needs.

Quality Center contains system fields in which you enter information about 
a requirement, test, test step, test set, test run, or defect. You can modify the 
behavior of these fields by restricting users to selecting values only from 
associated lists, by making entry in certain fields mandatory, and by 
preserving a history of values entered in the field. In addition, you can 
include data unique to your project by creating user-defined fields. You can 
associate these fields with Quality Center system and user-defined lists.

For example, if you are running tests on several builds of an application, you 
can add a Detected in Build field to the Add Defect dialog box. You can then 
create a selection list containing the values Build1, Build2, and Build3, and 
associate the list with the Detected in Build field.
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Customizing Project Entities 

Using the Customize Project Entities page, you can customize your Quality 
Center project to suit your testing environment. 

Each Quality Center project is divided into project entities. An entity is a 
table that contains data entered by users for a specific testing process. 

System fields

User-defined 
fields

Project entity
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The following entities are available:

Each entity contains system fields and user-defined fields:

➤ System fields are Quality Center default fields. You cannot add or delete 
system fields, you can only modify them.

➤ User fields are fields that you can define and include in a Quality Center 
project to customize for your specific project needs. You can add, modify, 
and delete user-defined fields. 

For detailed information on Quality Center entities and fields, to the 
Mercury Quality Center Database Reference.

Entity Description

DEFECT Defect data in the Defects module.

TEST Test data in the Test Plan module.

TEST STEP Design step data in the Test Plan module, and test step 
data in the Test Lab module.

RUN Test run data in the Test Lab module.

REQUIREMENT Requirement data in the Requirements module.

TEST IN TESTSET Test data in the Test Lab module.

TESTSET Test set data in the Test Lab module.
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The Field Settings section displays the field properties. The following 
properties are available:

Properties Description

Field Name Indicates the field name used in the Quality Center 
database table. 

Field Label Indicates the field name as it is displayed in Quality 
Center. You can type a new name or use the default 
name.

Field Type Specifies the type of data that the user can enter in the 
field. It includes the following types:

• Number: Enables integer entry only.

• String: Enables the entry of any character string.

• Date: Enables the selection of a date.

• Lookup List: Displays the Lookup List area and 
enables the selection from a drop-down list. 

• User List: Enables the selection of a user name from 
your Quality Center users list.

• Memo: Enables the entry of blocks of data. Note that 
you can add up to 3 memo fields to each Quality 
Center entity.

Field Length Indicates the field size. (Available only when the String 
type is selected.) 

Note: The maximum field length is 255 characters.

History Preserves a log of values entered in the selected field.

Required Indicates that a user must enter a value for the field.

Note: If you add a required String field or Memo field to 
a project that already contains data, users must enter 
data in the new field when they create a new record, but 
not when they modify an existing record.

Searchable Indicates a searchable field. (Available only when the 
Text Search option is enabled in the DB Servers tab. For 
more information, see “Defining Searchable Fields” on 
page 105.)
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Masked Indicates the input data mask for the field. (Available 
only when the String type is selected.) For more 
information, see “Defining Input Masks” on page 172.

Lookup List Includes a list of predefined lists. (Available only when 
the Lookup List type is selected.) To associate a field with 
a predefined list, select a list from the Lookup List box. To 
view or modify the selected list, click the Goto List 
button.

New List Creates a new list. (Available only when the Lookup List 
type is selected.) To associate a field with a new list, click 
the New List button. The Customize Project Lists dialog 
box opens. For more information on customizing a list, 
see “Customizing Project Lists” on page 175. 

Goto List Displays a predefined list. (Available only when the 
Lookup List type is selected.) To open a predefined list, 
select a list from the Lookup List box. Click the Goto List 
button. The Customize Project Lists dialog box opens. 
For more information on customizing a list, see 
“Customizing Project Lists” on page 175. 

Properties Description
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Adding User-Defined Fields

You can customize a Quality Center project by adding up to 99 user-defined 
fields to each Quality Center entity. 

To add a user-defined field:

 1 In the Project Customization window, click the Customize Project Entities 
link. The Customize Project Entities page opens.

 2 Under Project Entities, expand an entity.

 3 Click the User Fields folder.

Verify Value Limits the user to select a value only from the items that 
are listed in the list box. (Available only when the 
Lookup List type is selected.)

Allow Multiple Values For user-defined fields, this option allows the user to 
select more than one value in any field that is associated 
with a predefined lookup list. (It is only available when 
the Lookup List type is selected.) 

For example, if you create a Language user field in the 
Defect entity and enable the Allow Multiple Values 
option, a user can select English, French, and German 
language values at the same time when entering this 
field’s value.

Note: 

• This option is not available in the TEST STEP entity. 

• If you group a data grid or summary graph by a field 
containing multiple values, the information in each 
value is grouped as its entire value. This value is the 
category for grouping. For example, a value with 
English and French will be grouped once as 
English;French, and not as part of separate English and 
French categories. 

For more information on customizing a list, see 
“Customizing Project Lists” on page 175.

Properties Description
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 4 To add a user-defined field, you can:

➤ Click the New Field button to add a number, string, date, or list type 
field.

➤ Click the New Field arrow and choose New Memo Field to add a memo 
field. You can add up to 3 memo fields to each Quality Center entity. 

 5 In the Field Settings section, set properties for the field. For more 
information, see the “Field Settings” section on page 168.

 6 Click Save to save your changes to the Customize Project Entities page.

Modifying System and User-Defined Fields

You can modify the properties of system and user-defined fields in your 
Quality Center project.

Note: You can modify only the following properties for system fields: Field 
Label, History, Required, and Verify Value. For more information, see the 
“Field Settings” section on page 168.

To modify a system or user-defined field:

 1 In the Project Customization window, click the Customize Project Entities 
link. The Customize Project Entities page opens.

 2 Under Project Entities, expand an entity.

 3 Expand the System Fields folder or the User Fields folder.

 4 Click the field that you want to customize. The settings for that field appear 
under Field Settings.

 5 Modify the properties for the selected field. For more information, see the 
“Field Settings” section on page 168.

 6 Click Save to save your changes to the Customize Project Entities page.
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Deleting User-Defined Fields

You can delete user-defined fields from your Quality Center project.

To delete a user-defined field:

 1 In the Project Customization window, click the Customize Project Entities 
link. The Customize Project Entities page opens.

 2 Under Project Entities, expand an entity.

 3 Expand the User Fields folder.

 4 Click the field that you want to delete and click the Remove Field button. 

 5 Click OK to confirm. The field is removed from the User Fields folder.

 6 Click Save to save your changes to the Customize Project Entities page.

Defining Input Masks

The input mask option is used to prompt users for data input using a mask 
pattern. If the user attempts to enter a character that conflicts with the 
input mask, an error occurs. For example, to prompt the user to enter a 
phone number, you can define the following input mask:

!\(000\)000-0000

This input mask limits the user to numeric characters only. It is displayed in 
an edit box as follows:

(___) ___ - ____

Note: You can define input masks for string type fields only.
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To define an input mask:

 1 In the Field Settings section, select Masked. For more information, see the 
“Field Settings” section on page 168.

 2 Under Masked Edit Attributes, click the Define button. The Input Mask 
Editor dialog box opens.

 3 In the Input Mask box, type an input mask or select a predefined mask. 

You can use the following characters when defining input masks:

Mask 
Character

Description

! A space for a leading or trailing blank.

# A digit.

. A decimal. 

: A time separator. 

/ A date separator.

\ Treats the next character in the mask string as a literal. For 
example, you can include the (, ), #, &, A, and ? characters in the 
mask.



Part II • Project Customization

174

 4 In the Test Input box, you can test the input mask.

 5 Click OK to close the Input Mask Editor dialog box.

 6 Click Save to save your changes to the Customize Project Entities page.

> Converts all the characters that follow to uppercase.

< Converts all the characters that follow to lowercase.

A An alphanumeric character (entry required). For example: a – z, 
A – Z, or 0 – 9.

a An alphanumeric character (entry optional). For example: a – z, 
A – Z, or 0 – 9.

C A character (entry required). Valid values are ANSI characters in 
the following ranges: 32-126 and 128-255.

c A character (entry optional). Valid values are ANSI characters in 
the following ranges: 32-126 and 128-255.

L An alphabetic character or space (entry required). For example: a 
– z or A – Z.

l An alphabetic character or space (entry optional). For example: a 
– z or A – Z.

0 A digit (entry required). For example: 0 – 9.

9 A digit (entry optional). For example: 0 – 9.

_ Inserts spaces. When the user types characters in the field box, 
the cursor skips the _ character.

Mask 
Character

Description
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Customizing Project Lists 

Using the Customize Project Lists page, you can create, rename, and delete 
user-defined lists. 

A list contains items, which are values that you can enter in a field. For 
example, the selection list for the Languages user-defined field may contain 
the items English and European Languages. 

The list can also contain several levels of sub-items. For example, the item 
English can contain a sublist with the sub-items English (Australia), English 
(Canada), English (Great Britain), and English (US).
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You can allow the user to select more than one value from a list by enabling 
the Allow Multiple Values option for the relevant field in the Customize 
Project Entities page. For more information, see “Allow Multiple Values” in 
the Field Settings table on page 170. 

Note: To associate a list with a field, see “Customizing Project Entities” on 
page 166.

Creating Lists

You can create a list to be assigned to one or more fields.

To create a list:

 1 In the Project Customization window, click the Customize Project Lists link. 
The Customize Project Lists page opens. 

 2 Click the New List button. The New List dialog box opens.

 3 Type a name for the new list (maximum length 70 characters) and click OK. 
The list name appears in the Lists box.

 4 To add an item to the new list or to an existing list, select the list name in 
the Lists box and click the New Item button. The New Item dialog box 
opens. Type a name for the item and click OK.

Note: You should not use a semi-colon “;” as part of any list item if the list is 
to be used in a multiple value field. For more information on multiple value 
fields, see “Allow Multiple Values” in the Field Settings table on page 170.

 5 To create a sub-item, select an item in List Items and click the New Sub-Item 
button. The New Sub-Item dialog box opens. Type a name for the sub-item 
and click OK. 

 6 Click Save to save your changes to the Customize Project Lists page. 
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Renaming Lists, Items, or Sub-Items

You can rename user-defined lists, and system and user-defined items or 
sub-items.

Note: You cannot change some system list items. For example, the Y and N 
in the YesNo list. For more information on system items that cannot be 
changed, refer to the TestDirector for Quality Center Knowledge Base 
(http://support.mercury.com) and search for Problem ID 7165.

To rename a list: 

 1 In the Project Customization window, click the Customize Project Lists link. 
The Customize Project Lists page opens. 

 2 In the Lists box, select a list. 

 3 Click the Rename List button. The Rename List dialog box opens. 

 4 Type a new name for the list.

 5 Click OK to close the Rename List dialog box.

 6 Click Save to save your changes to the Customize Project Lists page.

To rename an item or sub-item: 

 1 In the Project Customization window, click the Customize Project Lists link. 
The Customize Project Lists page opens. 

 2 In the Lists box, select a list. 

 3 Under List Items, select an item.

 4 Click the Rename Item button. The Rename List Item dialog box opens.

 5 Type a new name for the item. Click OK.

 6 Click Save to save your changes to the Customize Project Lists page.
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Deleting Lists, Items, or Sub-Items

You can delete user-defined lists, and system and user-defined items or 
sub-items. 

Note: 

➤ You cannot delete a user-defined list that is being used as a lookup list for 
a field.

➤ You cannot delete some system list items. For example, the Y and N in 
the YesNo list. For more information on system items that cannot be 
deleted, refer to the TestDirector for Quality Center Knowledge Base 
(http://support.mercury.com) and search for Problem ID 7165.

To delete a list: 

 1 In the Project Customization window, click the Customize Project Lists link. 
The Customize Project Lists page opens.

 2 In the Lists box, select a user-defined list name. 

 3 Click the Delete List button. 

 4 Click Yes to confirm. 

 5 Click Save to save your changes to the Customize Project Lists page.

To delete an item or sub-item: 

 1 In the Project Customization window, click the Customize Project Lists link. 
The Customize Project Lists page opens. 

 2 In the Lists box, select a list name. 

 3 Under List Items, select a list item.

 4 Click the Delete Item button.

 5 Click Yes to confirm. 

 6 Click Save to save your changes to the Customize Project Lists page. 
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Configuring Automail

As a Quality Center project administrator, you can routinely inform your 
personnel about defect repair activity. You determine the conditions for 
sending defect messages to each recipient by defining a mailing 
configuration. 

This chapter describes:

➤ About Setting Automail

➤ Designating Automail Fields

➤ Defining Automail Conditions

➤ Customizing the Subject of Defect Mail

About Setting Automail

Quality Center enables you to automatically notify users through e-mail 
each time changes are made to specified defect fields. Configuring mail for a 
Quality Center project involves the following steps:

➤ Click the Configure Automail link to define the defect fields and specify the 
users and conditions. See “Designating Automail Fields” on page 180, and 
“Defining Automail Conditions” on page 182.

➤ In Site Administration’s Site Projects tab, enable the mail configuration for a 
project by selecting the Send mail automatically check box. Note that this 
check box must be selected for your mail configuration to work. For more 
information, see “Updating Project Details” on page 31.
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➤ In Site Administration’s Site Configuration tab, you can edit the 
MAIL_INTERVAL parameter, which defines the time interval for sending 
defect e-mail in all projects. You can also set parameters to define the format 
and character set of mail, and whether attachments or history are included 
in the mail. For more information, see “Setting Quality Center 
Configuration Parameters” on page 107.

➤ You can customize the subject line of defect e-mail for all projects or for a 
specific project. For more information, see “Customizing the Subject of 
Defect Mail” on page 183.

➤ In Site Administration’s Site Users tab, make sure you have specified the 
e-mail addresses of the users who should receive defect messages. For more 
information, see “Updating User Details” on page 78.

Designating Automail Fields

When you designate a field as a mail field, any changes made to that field 
will cause Quality Center to send an e-mail message in the next time 
interval. For example, suppose you designate Status as a mail field and then 
update the Status field for a particular defect. In the next time interval, the 
details of the defect, including the updated status information, will be sent 
to designated users.
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To designate Automail fields:

 1 In the Project Customization window, click the Configure Automail link. 
The Configure Automail page opens.

Available Defect Fields contains the names of the fields that appear in the 
Defects Grid. Mail On Change Of contains the names of the fields currently 
assigned as mail fields.

 2 Choose one or more fields and click the arrow buttons (> and <) to move the 
fields from one list to the other. Click the double arrow buttons (>> and <<) 
to move all the fields from one list to the other.

 3 Click Save to save your changes.
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Defining Automail Conditions

Mail conditions determine when various users receive defect messages. For 
each user, you can define separate mail conditions. For example, you can 
specify that a user will receive messages only for defects assigned an urgent 
priority.

To define Automail conditions:

 1 In the Project Customization window, click the Configure Automail link. 
The Configure Automail page opens.

 2 Click the Condition tab.
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 3 Choose a name from the Users list.

In addition, you can choose Detected By or Assigned To. Select these items 
to notify users when defects that they detected or are responsible for 
repairing are modified. 

 4 Select the All Defects check box to notify the selected user of every change 
to a defect.

 5 Alternatively, click the Condition button to define a filter under which the 
selected user will receive mail. Note that if you define multiple filters, the 
selected user will only receive mail if all of the conditions are met. For more 
information on filtering, refer to the Mercury Quality Center User’s Guide.

 6 Click Save to save your changes.

Customizing the Subject of Defect Mail

You can customize the subject line of defect e-mail sent automatically to 
users, for all projects or for a specific project. For example, you can define a 
subject line such as the following:

Defect # 4321 has been created or updated - Buttons on print dialog are not 
aligned

The line can contain the values of Quality Center fields. To include a field 
value from the defect that is being sent, prefix the field name with a 
question mark (?). Field names must be upper-case. For example:

Defect # ?BG_BUG_ID has been created or updated - ?BG_SUMMARY

To customize the subject of defect mail for all projects:

You can customize the subject line for all your projects by adding the 
AUTO_MAIL_SUBJECT_FORMAT parameter in the Site Configuration tab. For 
more information, see “Setting Quality Center Configuration Parameters” 
on page 107.
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To customize the subject of defect mail for a specific project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, double-click the project for which you want to customize 
the e-mail subject line.

 3 Select the DATACONST table.

 4 In the SQL pane, type an SQL INSERT statement to insert a row into the 
table with the following values:

➤ In the DC_CONST_NAME column, insert the parameter name 
AUTO_MAIL_SUBJECT_FORMAT.

➤ In the DC_VALUE column, insert the strings and the names of fields to be 
placed in the subject line.

For example, type the following SQL statement into the SQL pane:

insert into dataconst values ('AUTO_MAIL_SUBJECT_FORMAT',
’DEFAULT.TESTPROJ - Defect # ?BG_BUG_ID has been created or updated - 
?BG_SUMMARY’)

The subject line you define is specific to the project, so you can include the 
project name in the line.

For more information on modifying project tables, see “Querying Project 
Tables” on page 38.

 5 Click the Execute SQL button. The row is added to the DATACONST table to 
set the e-mail subject.
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Setting Traceability Notification Rules

As a Quality Center project administrator, you can activate traceability 
notification rules for your project. This instructs Quality Center to create 
alerts and send e-mail to notify those responsible when changes occur in 
your project that may impact the testing process.

This chapter describes:

➤ About Setting Traceability Notification Rules

➤ Setting Traceability Notification Rules

About Setting Traceability Notification Rules

You can keep track of your requirements, tests and defects as you perform 
your project testing process. When an entity changes, you can instruct 
Quality Center to notify those responsible for any associated entities.

The traceability rules you can activate are based on the following 
associations you can create in Quality Center:

➤ You can associate a test in the test plan tree with a requirement. This is 
performed by creating requirements coverage in the Test Plan module, or by 
creating tests coverage in the Requirements module.

➤ You can link a test with a defect. This is performed by creating Linked 
Defects in the Test Plan module, or by adding a defect during a manual test 
run.

After you have established associations in your project, you can then trace 
changes using these associations. When an entity in your project changes, 
Quality Center notifies you of any associated entities that may be impacted 
by the change. 
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Notification involves two steps. Quality Center flags the associated entity, 
and then sends e-mail to the user responsible for the entity.

There are four traceability notification rules you can activate:

For more information on traceability, refer to the Mercury Quality Center 
User’s Guide.

Rule
Entity 
Flagged

User Notified Entity Changed

1 Test Test designer.

(Displayed in the Test Plan 
module, Details tab, in the 
Designer box.)

Linked requirement 
has any change, 
excluding a change in 
the status. For 
example, an added 
attachment.

2 Test Instance Responsible tester.

(Displayed in the Test Lab 
module, Execution Grid, in the 
Responsible Tester column.)

Linked defect status 
changes to “Fixed”.

3 Defect User responsible for the defect.

(Displayed in the Defects module 
in the Assigned To column.)

Linked test run status 
changes to “Passed”.

4 Test Test designer and all project 
users. Also, note the following:

• Only the designer of the 
linked test is notified by e-
mail

• Only the designer of the 
linked test can delete the 
alert.

(Test designer name is displayed 
in the Test Plan module, Details 
tab, in the Designer box.)

Linked requirement 
has any change, 
excluding a change in 
the status. For 
example, an added 
attachment.
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Setting Traceability Notification Rules

You can activate four traceability notification rules.

To set traceability notification rules:

 1 In the Project Customization window, click the Set Traceability Notification 
Rules link. The Set Traceability Notification Rules page opens.

 2 Select Active to activate a traceability rule. This instructs Quality Center to 
flag the entity when the associated entity changes. 

 3 Select E-mail to instruct Quality Center to send notification e-mail to the 
specified user when the associated entity changes.

 4 Click Save to save your changes.
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14
Generating Workflow Scripts

Quality Center provides script generators to enable you to perform 
commonly needed customizations on the Defects module dialog boxes.

For information on writing workflow scripts to customize the user interface 
and to control user actions in any Quality Center module, see Part III, 
“Workflow Customization”.

This chapter describes the following:

➤ About Generating Workflow Scripts

➤ Customizing Defects Module Field Lists

➤ Customizing Defects Module Dialog Boxes
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About Generating Workflow Scripts

The Set Up Workflow page provides links to script generators and a script 
editor. You can use the script generators to perform customizations on the 
input fields of the Defects module dialog boxes. You can use the script editor 
to create scripts to control the workflow in any Quality Center module.

To open the Set Up Workflow page, click the Set Up Workflow link in the 
Project Customization window. 

The Set Up Workflow page contains the following links:

➤ The Script Generator - List Customization for Defects Module link enables 
you to customize the field lists displayed for fields on the dialog boxes of the 
Defects module. For more information, see “Customizing Defects Module 
Field Lists” on page 191.

➤ The Script Generator - Add Defect Field Customization link enables you to 
modify the appearance of the Add Defect dialog box. For more information, 
see “Customizing Defects Module Dialog Boxes” on page 194.
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➤ The Script Generator - Defect Details Field Customization link enables you 
to modify the appearance of the Defect Details dialog box. For more 
information, see “Customizing Defects Module Dialog Boxes” on page 194.

➤ The Script Editor link enables you to write VBScript code to customize the 
Quality Center workflow in any module. You place your code in the 
appropriate Quality Center event so that the script is triggered when the 
relevant user action takes place. You can also use the script editor to modify 
scripts created by the script generators. For more information, see 
Chapter 15, “Workflow Customization at a Glance”.

Customizing Defects Module Field Lists

A field list is a list of values displayed in a drop-down list, from which the 
user can choose a value for the field.

You can specify that a different field list be used for a Defects module field, 
depending on the value of another field. For example, you can set the 
Detected in Versions list to change depending on the value in the Project 
field.

Note: This script generator can be used to customize field lists in the Defects 
module only.

To customize a field list, you must define the following rules:

➤ Primary/Secondary Rule: Select the primary and secondary fields. When a 
primary field value is changed, the list of values in the secondary field 
changes automatically. For example, you could select Project as the primary 
field and Detected in Versions as the secondary field.

➤ List Match Rule: Select the list that you want to display in the secondary 
field for each value of the primary field.
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Note: When workflow customization has been used to change a list of 
values for a field that has transition rules defined, the field may only be 
modified in a way that satisfies both the workflow script and the transition 
rules. For more information, see “Setting Transition Rules” on page 146.

To customize a field list:

 1 In the Project Customization window, click the Set Up Workflow link. The 
Set Up Workflow page opens.

 2 Click the Script Generator - List Customization for Defects Module link. The 
Script Generator - List Customization dialog box opens. 
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 3 Under Primary/Secondary Rule, select the primary field and the secondary 
field:

➤ To set a rule, click <select primary> and select a field name. Click <select 
secondary> and select a field name.

➤ To add a new rule, click the Add Primary/Secondary Rule button. Select 
field names for <select primary> and <select secondary>.

➤ To delete a rule, select the rule and click the Delete Primary/Secondary 
Rule button. Click Yes to confirm.

 4 Under Primary/Secondary Rule, select the primary/secondary rule for which 
you want to set list match rules.
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 5 Under List Match Rule, select the field list to be used in the secondary field 
for specific values entered into the primary field:

➤ To set a rule for a defined primary field value, click <select list> and select 
a list name. 

➤ To set a rule for an undefined primary field value, click <enter value> and 
type a primary field value. Press Enter. Click <select list> and select a list 
name. 

➤ To add a new list match rule, click the Add List Match Rule button. Click 
<enter value> and type a primary field value. Click <select list> and select 
a list name. 

➤ To delete a list match rule, select the rule and click the Delete List Match 
Rule button. Click Yes to confirm.

 6 To save your changes, do one of the following:

➤ Click the Apply Script Changes button to save your changes and close 
the script generator.

➤ Click the Apply & View button to save your changes and view the 
generated script in the Script Editor. 

If you use the Script Editor to modify a script that was created by a script 
generator, your modifications are overwritten the next time you run that 
script generator. It is recommended that you rename the generated script 
before you modify it. For more information on the Script Editor, see 
Chapter 16, “Working with the Workflow Script Editor”.

Customizing Defects Module Dialog Boxes

You can modify the appearance of the Add Defect and Defect Details dialog 
boxes by setting different fields to be visible for each user group. You can 
also sort the order in which the fields are displayed on the dialog box for 
each user group.

For example, you may want the Assigned To and Priority fields to appear 
only for a user that has developer privileges. Also, you can customize the 
Assigned To field so that it is displayed before the Priority field for this user 
group.
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To perform a customization for all user groups, you can use the script editor 
to write a script. For more information, see “Example: Customizing a Defects 
Module Dialog Box” on page 253.

Note: These script generators can be used to customize dialog boxes in the 
Defects module only.

To customize Defects module dialog boxes by user group:

 1 In the Project Customization window, click the Set Up Workflow link. The 
Set Up Workflow page opens.

 2 To modify the appearance of the Add Defect dialog box, click the Script 
Generator - Add Defect Field Customization link. The Script Generator - Add 
Defect Field Customization dialog box opens.
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To modify the appearance of the Defect Details dialog box, click the Script 
Generator - Defect Details Field Customization link. The Script Generator - 
Defect Details Field Customization dialog box opens. 

Available Fields contains the names of all the fields you can display. Visible 
Fields contains the names of the fields that can currently be seen by the 
selected user group, and their sorting priority. 

 3 From the User Group list, select the user group to which the customizations 
are to apply.

 4 Choose field names and click the arrow buttons (> and <) to move a name 
between Available Fields and Visible Fields. Click the double arrow buttons 
(>> and <<) to move all the names from one list to the other. You can also 
drag the field names between lists.

 5 In Visible Fields, to set a field as a required field, select the check box next to 
it. For a required field, a value is mandatory. Its title is displayed in red in 
the Add Defect or Defect Details dialog box.
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 6 You can set the order in which fields are displayed for the selected user 
group by using the up and down arrows. You can also drag the field names 
up or down.

 7 You can set the Add Defect and Defect Details dialog boxes to include one or 
more input pages. By default, all fields are displayed on one page. Use the up 
and down arrows to move fields to the appropriate page.

 8 To save your changes, do one of the following:

➤ Click the Apply Script Changes button to save your changes and close 
the script generator.

➤ Click the Apply & View button to save your changes and view the 
generated script in the Script Editor.

If you use the Script Editor to modify a script that was created by a script 
generator, your modifications are overwritten the next time you run that 
script generator. It is recommended that you rename the generated script 
before you modify it. For more information on the Script Editor, see 
Chapter 16, “Working with the Workflow Script Editor”.
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15
Workflow Customization at a Glance

You can write workflow scripts to customize the Quality Center user 
interface, and to control the actions that users can perform.

To customize workflow:

 1 In the Project Customization window, click the Set Up Workflow link. The 
Set Up Workflow page opens.
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 2 To perform commonly-needed customization of a Defects module dialog 
box, click the appropriate Script Generator link on the Set Up Workflow 
page. You need not be familiar with VBScript, or with Quality Center events 
and objects to use this feature. For more information, see Chapter 14, 
“Generating Workflow Scripts”.

 3 To write or modify scripts by entering code into the appropriate event 
procedures, open the Script Editor. To create workflow scripts, you must be 
familiar with VBScript. You can open the Script Editor either from a script 
generator or directly:

➤ To write a script that is similar to a script created by a script generator, 
click the relevant Script Generator link and set the customization you 
want to perform. Click the Apply & View button on the script generator 
dialog box. The Script Editor opens to display the scripts that were 
generated.

➤ To create your own scripts, click the Script Editor link. The Script Editor 
opens to display a Scripts Tree that lists the existing event procedures.

For more information on the Script Editor, see Chapter 16, “Working with 
the Workflow Script Editor”.

 4 Decide which Quality Center event should trigger your script. You must 
place your code in the procedure of the appropriate module and event so 
that it is invoked for the relevant user action. For more information, see 
Chapter 17, “Workflow Event Reference”.

 5 Decide which Quality Center objects your script must access. Your script 
performs customizations based on information obtained from the relevant 
objects. You customize the workflow by using the methods and properties of 
the objects. For more information, see Chapter 18, “Workflow Object 
Reference”.
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 6 Examine the sample scripts to find one that can be adapted for your use. 
Sample scripts are provided in this guide and in the TestDirector for Quality 
Center Knowledge Base. Scripts generated by the workflow script generators 
can also be used as a basis for your scripts.

➤ For examples of common customizations that can be performed by using 
workflow scripts, see Chapter 19, “Workflow Examples”.

➤ For an index to Knowledge Base articles that provide examples of 
workflow scripts, refer to the TestDirector for Quality Center Knowledge 
Base (http://support.mercury.com) and search for Problem ID 29497.
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16
Working with the Workflow Script Editor

You can use the Script Editor to create workflow scripts to customize the user 
interface, and to control user actions.

This chapter describes the following:

➤ About Working with the Workflow Script Editor

➤ The Script Editor

➤ Creating a Workflow Script

➤ Adding a Button to a Toolbar

➤ Setting the Properties of the Script Editor

About Working with the Workflow Script Editor

You can use the Script Editor to create workflow scripts and to add a toolbar 
button to the window of a Quality Center module.

The Script Editor dialog box contains two tabs:

➤ Script Editor tab: You use the Script Editor tab to create and edit workflow 
scripts. The Script Editor assists you in placing your code in the appropriate 
Quality Center event procedure. For more information on using the Script 
Editor, see “Creating a Workflow Script” on page 209.

➤ Toolbar Button Editor tab: You use the Toolbar Button Editor tab to add a 
toolbar button to the window of a Quality Center module. For more 
information, see “Adding a Button to a Toolbar” on page 212.
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The Script Editor

You can use the Script Editor to modify scripts that have been generated by a 
script generator, or to create a user-defined workflow script. For information 
on opening the Script Editor, see Chapter 15, “Workflow Customization at a 
Glance”. 

The Script Editor tab contains the following elements:

➤ The Script Editor toolbar contains buttons used when creating scripts. For 
more information, see “Understanding the Script Editor Commands” on 
page 207.

➤ The Scripts Tree lists the event procedures to which you can add code. The 
event procedures are grouped by the module in which they are triggered. For 
more information, see Chapter 17, “Workflow Event Reference”.

➤ The Scripts pane displays the code of the selected event procedure. To create 
or modify a script, you add VBScript code to the event procedure. For more 
information, see “Creating a Workflow Script” on page 209.

➤ The Messages pane displays any syntax errors encountered when you save or 
validate a script.

Script Editor 
toolbar

Scripts Tree

Messages pane

Scripts pane
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Understanding the Script Editor Commands

The Script Editor toolbar, menu bar, and right-click menu contain the 
following buttons and menu commands:

Save: Saves the changes made to scripts in the selected module.

Print: Prints the displayed script.

Undo: Reverses the last command or deletes the last entry you typed.

Redo: Reverses the action of your last Undo command.

Cut: Removes the selected text and places it on the Clipboard.

Copy: Copies the selected text to the Clipboard.

Paste: Inserts the contents of the Clipboard at the insertion point.

Delete: Deletes the selected text.

Find: Searches for specified text in the scripts of the selected module.

Find Next: Finds the next occurrence of the text specified in the Find Text 
dialog box.

Replace: Replaces the specified text with replacement text.

Synchronize Tree with Script: Refreshes the Scripts Tree to reflect procedures 
you have added, deleted or renamed.

Field Names: Displays a list of field names in the project that you can insert 
into your script.

Code Complete: Displays a list of objects, properties, methods, or field 
names that you can insert into your script.

Code Template: Displays a list of templates for commonly used VBScript 
statements that you can insert into your script.

List Value: Opens the Select Value From List dialog box, to enable you to 
choose an item from a project list.

Syntax Check: Validates the syntax of your script and displays any messages 
in the Messages pane.
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Show/Hide Scripts Tree: Displays or hides the Scripts Tree. If you have 
opened the Script Editor from a script generator, this is not available.

Show/Hide Messages Pane: Displays or hides the Messages pane.

Properties: Opens the Properties dialog box, enabling you to change the 
properties of the Script Editor. For more information, see “Setting the 
Properties of the Script Editor” on page 215.

Save All: To save script changes in all modules, choose File > Save All.

Revert to Saved: To return to a saved version of a module, select a changed 
module and choose File > Revert to Saved.

Select All: To select all text in the scripts pane, choose Edit > Select All.

Expand All: To expand all nodes in the Scripts Tree, choose View > Expand 
All.

Collapse All: To collapse all nodes in the Scripts Tree, choose View > Collapse 
All.

Go to Line Number: To jump to a specific line in the Script Editor, choose 
Search > Go to Line Number.

Clear Messages: To clear syntax messages displayed in the messages pane, 
choose Tools > Clear Messages.

Sort Field Names by Field Labels: When you choose the Field Names option, 
the Script Editor sorts the list by the field name used in the Quality Center 
database table (for example, BG_BUG_ID). To sort the fields by the field label 
(for example, Defect ID) right-click the script pane and choose Sort Field 
Names by Field Labels.

VBScript Home Page: To get help for the VBScript language, choose Help > 
VBScript Home Page.
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Creating a Workflow Script

You use the Script Editor to add VBScript code to a Quality Center event 
procedure, or to create user-defined procedures that can be called from a 
Quality Center event procedure.

To create a workflow script:

 1 Click the Script Editor link on the Set Up Workflow window. The Script 
Editor opens.

For more information on the Script Editor window, see “The Script Editor” 
on page 206.

 2 Select a module name in the Modules list box to expand the node of the 
module for which you need to customize the workflow.

The Scripts Tree contains the Common script node in addition to the nodes 
for specific modules. When you create user-defined procedures that must be 
accessible from several modules, place them under the Common script 
node. To declare a global variable that can be used across all modules, 
declare the variable under the Common script node, outside of any 
function.
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 3 In the Events list box, select the event procedure to which you need to add 
code, depending on when you want your code to be triggered. The existing 
script for this event procedure is displayed in the Scripts pane.

For a description of Quality Center event procedures, see Chapter 17, 
“Workflow Event Reference”.

 4 Add your VBScript code lines to the script.

Note: A red indicator  next to a module name in the Scripts Tree indicates 
that there are unsaved script changes in that module.

 5 To use the code complete feature instead of typing in the names of Quality 
Center objects, properties, methods, and fields, place the insertion point at 
the location where you want to insert an object name and click the Code 
Complete button. For information about Quality Center objects, see 
Chapter 18, “Workflow Object Reference”.

 6 To use the code template feature instead of typing in commonly used 
VBScript statements, place the insertion point where you want to insert the 
code and click the Code Template button. Choose one of the following 
items from the code template list:

Template Code Added to Script

FVal: Fields value access Fields.Field("").Value

List: Quality Center list access Lists.List()

IfAct: Action “switch” If Block If ActionName = "" Then

End IF

Act: Actions access Actions.Action("")

Func: Function template Function
On Error Resume Next

On Error GoTo 0
End Function
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 7 To insert an item from a field list defined in the project, place the insertion 
point at the location where you want to add the item. Click the List Value 
button. In the Lists box of the Select Value From List dialog box, choose the 
name of the list. In the List Items box, select the list value.

 8 To insert a Quality Center field name, place the insertion point at the 
location where you want to add the field name. Click the Field Names 
button. Select a name from the list of system and user-defined fields in the 
Quality Center project.

 9 To validate the syntax of the script, click Syntax Check. Any messages are 
displayed in the Messages pane.

 10 Click the Save button to save the script.

 11 Close the Script Editor.

Sub: Sub Template Sub
On Error Resume Next

On Error GoTo 0
End Sub

Err: Error Handler On Error Resume Next

Template Code Added to Script
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Adding a Button to a Toolbar

You can use the Toolbar Button Editor to define a toolbar button to be 
displayed on the window of a Quality Center module, or on the Manual 
Runner dialog box.

To add a button to a toolbar:

 1 In the Script Editor, click the Toolbar Button Editor tab.
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 2 From the Command bar list, select the toolbar to which you want to add a 
button:

 3 Click Add. A default command name for the button is added to the 
Commands list.

 4 In the Caption box, type a new command name for the button, or use the 
default name.

 5 In the Hint box, type a tooltip for the button.

 6 In the Action Name box, type a new action name for the button, or use the 
default name.

 7 Under Images, select an icon for the button.

 8 Click Apply to apply your changes.

 9 To delete a button that you have created, select its command name in the 
Commands list, and click Remove.

 10 Click the Save button to save the new button definition.

 11 Click the Script Editor tab.

 12 In the Scripts Tree of the Script Editor, select the _ActionCanExecute event 
procedure for the module you selected from the Command bar list.

Option Toolbar Location

Requirements Requirements module window

TestPlan Test Plan module window

TestLab Test Lab module window

ManualRun Manual Runner dialog box

Defects Defects module window
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 13 In the procedure displayed in the scripts pane of the Script Editor, add 
statements to be performed if the user initiates an action with the action 
name you defined for the button. Set the return value to True or False.

For example, the following code opens a message box when the user clicks 
the Requirements_Action1 button on the tool bar of the Requirements 
module:

Function Requirements_ActionCanExecute(ActionName)
On Error Resume Next
Requirements_ActionCanExecute = True

If ActionName = "Requirements_Action1" Then
MsgBox "You clicked the Action1 button." 

End If
On Error GoTo 0

End Function

For more information, see “Example: Adding Button Functionality” on 
page 267.

 14 Click the Save button to save the script.
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Setting the Properties of the Script Editor

You can customize the behavior of the Script Editor.

To set the properties of the Script Editor:

 1 In the Script Editor, click the Properties button or choose Options > Editor 
Properties. The Properties dialog box opens.

 2 In the Editor tab, you can set the following options:

Option Description

Auto indent mode Places the cursor under the first non-blank character 
of the preceding non-blank line when you press 
Enter.

Smart tab Tabs to the first non-blank character in the 
preceding non-blank line. If Use tab character is 
selected, this option is cleared.
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Use tab character Inserts a tab character. If cleared, inserts space 
characters. If Smart tab is selected, this option is 
cleared.

Backspace unindents Aligns the insertion point to the previous 
indentation level when you press Backspace, if the 
cursor is on the first non-blank character of a line.

Show line numbers Displays line numbers. If this option is selected, 
Show line numbers on gutter is enabled.

Show line numbers on 
gutter

Displays line numbers in the gutter instead of in the 
left margin. If Show line numbers is selected, this 
option is enabled.

Group undo Reverses your last editing command and any 
subsequent editing commands of the same type, if 
you press Alt+Backspace or choose Edit > Undo.

Cursor beyond EOF Enables you to place the insertion point after the 
last line of code.

Cursor beyond EOL Enables you to position the cursor after the end of 
the line.

Selection beyond EOL Enables you to select characters beyond the end of 
the line.

Keep trailing blanks Keeps any blank spaces you have at the end of a 
line.

Persistent blocks Keeps marked blocks selected, even when the cursor 
is moved using the arrow keys, until a new block is 
selected.

Overwrite blocks Replaces a marked block of text with new text. If 
Persistent Blocks is also selected, text you enter is 
appended following the currently selected block.

Double click line Highlights the line when you double-click any 
character in the line. If disabled, only the selected 
word is highlighted.

Option Description
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 3 In the Display tab, you can set the following options:

Find text at cursor Places the text at the cursor into the Text To Find list 
box in the Find Text dialog box when you choose 
Search > Find. 

Force cut and copy 
enabled

Enables the Cut and Copy commands, even when 
there is no text selected.

Use syntax highlight Displays script elements according to colors and 
attributes defined in the Display tab and Colors tab. 

Overwrite cursor as block Controls the appearance of the caret when using 
the Overwrite mode. 

Disable dragging Disables dragging and dropping text.

Block indent Specifies the number of spaces to indent a marked 
block.

Tab stops Specifies the locations to which the cursor moves 
when you press Tab.

Keymapping Sets the keyboard mappings in the Script Editor. 
Supports the following keyboard mappings: Default, 
Classic, Brief, Epsilon, and Visual Studio.

Option Description

Editor gutter Enables you to set the visibility, width, color, and 
style of the gutter.

Editor margin Enables you to set the visibility, width, color, style, 
and position of the right margin.

Use mono font Displays only monospaced screen fonts, such as 
Courier, in the Editor font box.

Editor font Lists the available text fonts.

Editor color Lists the available background colors. 

Size Lists font sizes.

Option Description
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 4 In the Colors tab, you can set the following options:

Use Read-Only Color Enables you to select a color for displaying 
read-only text from the Read-Only Color box.

Draw Special Symbols Sets special characters for displaying end-of-file, 
end-of-line, space, and tab characters.

Option Description

Color SpeedSetting Enables you to configure the Script Editor display 
using predefined color combinations.

Element Specifies syntax highlighting for a particular code 
element.

Foreground color Sets the foreground color for the selected code 
element.

Background color Sets the background color for the selected code 
element.

Use defaults for Displays the code element using default system 
colors for the foreground, background, or both.

Text attributes Specifies format attributes for the code element.

Open Loads a color scheme from your computer.

Save Saves a color scheme to your computer.

Option Description
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17
Workflow Event Reference

You can write workflow scripts to customize the actions that Quality Center 
users can perform, and the fields that are available to users in dialog boxes. 
To write a workflow script, you add VBScript code to event procedures that 
are triggered by user actions.

This chapter describes the following:

➤ About Quality Center Events

➤ Naming Conventions for Quality Center Event Procedures

➤ Reference for Quality Center Events

About Quality Center Events

During a Quality Center user session, as the user initiates various actions, 
Quality Center triggers event procedures. You can place code in these 
procedures to customize the execution of the associated user actions.

The Script Editor lists the event procedures for each Quality Center module, 
and allows you to add your code to the appropriate procedure. For more 
information, see Chapter 16, “Working with the Workflow Script Editor”.

The code you add to the event procedures can access Quality Center objects. 
For more information, see Chapter 18, “Workflow Object Reference”.
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Event procedures can be functions or subroutines:

➤ Event functions: These procedures are triggered by Quality Center to check 
whether the user’s action should be performed. You can place code in these 
functions to determine whether Quality Center may execute the user’s 
request. If your code returns a value of False, Quality Center does not 
proceed with the action.

For example, when a user clicks the Submit button on the Add Defect dialog 
box, Quality Center invokes the function Defects_Bug_CanPost before 
posting the defect to the database on the server. You can add code to the 
Defects_Bug_CanPost function to control whether Quality Center posts the 
defect. For example, you can ensure that a user cannot reject a defect 
without adding a comment. For example, see “Example: Object Validation” 
on page 261.

➤ Event subroutines: These procedures are triggered to give you a chance to 
perform actions when an event takes place. 

For example, when a user opens the Add Defect dialog box, Quality Center 
invokes the subroutine Defects_Bug_New. You can add code to the 
Defects_Bug_New subroutine to perform actions that should be performed 
when a user opens the dialog box. For example, you can change the value of 
the Detection Mode field to BTW if the user is not in the QA Tester user 
group. For example, see “Example: Changing a Field Based on the User 
Group” on page 260.
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Naming Conventions for Quality Center Event Procedures

The naming convention for an event procedure is as follows:

<module>_<entity>_<event>

Note that some event procedure names do not include an entity name.

Module

The module name indicates the Quality Center module or dialog box from 
which the procedure is triggered. Module can be one of the following:

Note: You cannot access global variables from the Manual Runner event 
procedures. A workaround for passing a value to or from Manual Runner is 
to use the Settings object. For example, see “Example: Storing the Last 
Values Entered” on page 273.

Module Module from Which the Procedure is Triggered

Project These procedures are common to all modules. They 
are listed under the Common script node in the 
Script Editor.

Requirements Requirements module

TestPlan Test Plan module

TestLab Test Lab module

ManualRun Manual Runner dialog box

Defects Defects module
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Entity

Entity can be one of the following:

Event

The Event can be either a function name or a subroutine name. The event 
names are listed in “Reference for Quality Center Events” on page 223.

Entity Description

Req Requirements module: Requirement data

Test Test Plan module: Test data

DesignStep Test Plan module: Design step data

TestSet Test Lab module: Test set data

TestSetTests Test Lab module: Test data

Bug Defects module: Defect data

Step Manual Runner dialog box: Test run step data

Run Manual Runner dialog box: Test run data
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Reference for Quality Center Events

This section contains an alphabetical reference of the Quality Center event 
functions and subroutines. It includes the event name, description, syntax, 
type (Function or Sub), the value returned by a function, and the entities for 
which the event procedure is available.

For information on the naming conventions for event procedures, see 
“Naming Conventions for Quality Center Event Procedures” on page 221.

The following event functions are available:

Function Name When the Function is Triggered

“ActionCanExecute” on page 225 before performing a user action

“Attachment_CanDelete” on 
page 226

before deleting an attachment 

“Attachment_CanOpen” on page 227 before opening an attachment

“Attachment_CanPost” on page 227 before posting an attachment

“CanAddTests” on page 228 before adding tests to a test set

“CanCustomize” on page 229 before opening Customization window

“CanDelete” on page 229 before deleting an object from the server

“CanLogin” on page 231 before a user logs in to the project

“CanLogout” on page 231 before a user logs out of the project

“CanPost” on page 232 before posting an object to the server

“CanRemoveTests” on page 232 before removing tests from a test set

“DefaultRes” on page 233 before resetting project defaults

“FieldCanChange” on page 235 before changing a field value

“GetDetailsPageName” on page 237 before displaying Defect Details dialog 
box

“GetNewBugPageName” on page 237 before displaying Add Defect dialog box
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The following event subroutines are available:

Subroutine Name When the Subroutine is Triggered

“AfterPost” on page 226 an object has been posted to the server

“Attachment_New” on page 228 an attachment is added

“DialogBox” on page 233 a dialog box is opened or closed

“EnterModule” on page 234 user switches modules

“ExitModule” on page 234 user exits a module

“FieldChange” on page 236 a field value changes

“MoveTo” on page 238 user changes focus

“MoveToSubject” on page 238 user clicks a subject in the test plan tree

“New” on page 239 an object is added

“RunTests” on page 239 user clicks Run in the Test Lab module

“RunTestSet” on page 240 user clicks Run Test Set in the Test Lab 
module

“RunTestsManually” on page 240 user clicks Run > Run Manually in the 
Test Lab module
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ActionCanExecute

This event is triggered before Quality Center performs an action that has 
been initiated by the user, to check whether the action can be executed.

You can add code to this event procedure to perform actions when the user 
has initiated a particular action, or to prevent the action from being 
executed in specific cases. For example, see “Example: Controlling User 
Permissions” on page 266.

Syntax <module>_ActionCanExecute(ActionName)

where ActionName is the action that the user has initiated

Type Function

Returns True or False

Availability • Project_ActionCanExecute

• Requirements_ActionCanExecute

• TestPlan_ActionCanExecute

• TestLab_ActionCanExecute

• Defects_ActionCanExecute

• ManualRun_ActionCanExecute
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AfterPost

This event is triggered after an object has been posted to the server.

Project fields should not be changed after they have been posted, because 
then the new value is not stored in the database.

Attachment_CanDelete

This event is triggered before Quality Center deletes an attachment from the 
server, to check whether that attachment can be deleted.

Syntax <module>_<entity>_AfterPost

Type Sub

Availability • Requirements_Req_AfterPost

• TestPlan_Test_AfterPost

• TestLab_TestSet_AfterPost

• Defects_Bug_AfterPost

• ManualRun_Step_AfterPost

• ManualRun_Run_AfterPost

Syntax <module>_Attachment_CanDelete(Attachment)

where Attachment is the Attachment interface. For more 
information, refer to the Mercury Quality Center Open Test 
Architecture API Reference.

Type Function

Returns True or False

Availability • Requirements_Attachment_CanDelete

• TestPlan_Attachment_CanDelete

• TestLab_Attachment_CanDelete

• Defects_Attachment_CanDelete

• ManualRun_Attachment_CanDelete
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Attachment_CanOpen

This event is triggered before Quality Center opens an attachment from the 
server, to check whether the attachment can be opened.

Attachment_CanPost

This event is triggered before Quality Center posts an attachment to the 
server, to check whether the attachment can be posted.

Syntax <module>_Attachment_CanOpen(Attachment)

where Attachment is the lAttachment interface. For more 
information, refer to the Mercury Quality Center Open Test 
Architecture API Reference.

Type Function

Returns True or False

Availability • Requirements_Attachment_CanOpen

• TestPlan_Attachment_CanOpen

• TestLab_Attachment_CanOpen

• Defects_Attachment_CanOpen

• ManualRun_Attachment_CanOpen

Syntax <module>_Attachment_CanPost(Attachment)

where Attachment is the lAttachment interface. For more 
information, refer to the Mercury Quality Center Open Test 
Architecture API Reference.

Type Function

Returns True or False

Availability • Requirements_Attachment_CanPost

• TestPlan_Attachment_CanPost

• TestLab_Attachment_CanPost

• Defects_Attachment_CanPost

• ManualRun_Attachment_CanPost
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Attachment_New

This event is triggered when an attachment is added to Quality Center.

CanAddTests

This event is triggered before Quality Center adds tests to a test set, to check 
whether the specified tests can be added.

Syntax <module>_Attachment_New(Attachment)

where Attachment is the lAttachment interface. For more 
information, refer to the Mercury Quality Center Open Test 
Architecture API Reference.

Type Sub

Availability • Requirements_Attachment_New

• TestPlan_Attachment_New

• TestLab_Attachment_New

• Defects_Attachment_New

• ManualRun_Attachment_New

Syntax <module>_<entity>_CanAddTests(Tests_List)

where Tests_List is an array of Test IDs.

Type Function

Returns True or False

Availability TestLab_TestSet_CanAddTests



Chapter 17 • Workflow Event Reference

229

CanCustomize

This event is triggered when a user attempts to open the Customization 
window, to check whether the specified user can customize the specified 
project.

CanDelete

This event is triggered before Quality Center deletes an object from the 
server, to check if the object can be deleted. 

It applies to the following objects: requirements, tests or subject folders (in 
the Test Plan module), test sets or test set folders (in the Test Set module), 
and defects. The syntax is different for different objects.

➤ For requirements and defects:

Syntax <module>_
CanCustomize(DomainName, ProjectName, UserName)

where DomainName is the domain name, ProjectName is the 
project name, and UserName is the user name.

Type Function

Returns True or False

Availability Project_CanCustomize

Syntax <module>_<entity>_CanDelete

Type Function

Returns True or False

Availability • Requirements_Req_CanDelete

• Defects_Bug_CanDelete
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➤ For tests or subject folders in the Test Plan module:

➤ For test sets or test set folders in the Test Set module:

Syntax <module>_<entity>_CanDelete(IsTest, Entity)

where:

• If IsTest is True, Entity refers to an ITest object. 
If IsTest is False, Entity refers to an ISubjectNode object. For 
more information on ITest and ISubjectNode, refer to the 
Mercury Quality Center Open Test Architecture API Reference.

• Entity is the test or subject folder.

Type Function

Returns True or False

Availability TestPlan_Test_CanDelete

Syntax <module>_<entity>_CanDelete(IsTestSet, Entity)

where:

• If IsTestSet is True, Entity refers to an ITestSet object. 
If IsTestSet is False, Entity refers to an ITestSetFolder object. 
For more information on ITestSet and ITestSetFolder, refer to 
the Mercury Quality Center Open Test Architecture API Reference.

• Entity is the test set or test set folder.

Type Function

Returns True or False

Availability TestLab_TestSet_CanDelete
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CanLogin

This event is triggered to check whether the specified user can log in to the 
specified project.

CanLogout

This event is triggered to check whether the current user can log out of the 
current project.

Syntax <module>_CanLogin(DomainName, ProjectName, UserName)

where DomainName is the domain name, ProjectName is the 
project name, and UserName is the user name.

Type Function

Returns True or False

Availability Project_CanLogin

Syntax <module>_CanLogout

Type Function

Returns True or False

Availability Project_CanLogout
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CanPost

This event is triggered before Quality Center posts an object to the server, to 
check whether the object can be posted.

You can add code to this event procedure to prevent an object from being 
posted in specific cases. For example, see “Example: Object Validation” on 
page 261.

CanRemoveTests

This event is triggered to check whether the specified tests can be removed 
from a test set.

Syntax <module>_<entity>_CanPost

Type Function

Returns True or False

Availability • Requirements_Req_CanPost

• TestPlan_Test_CanPost

• TestLab_TestSet_CanPost

• TestLab_TestSetTests_CanPost

• Defects_Bug_CanPost

• ManualRun_Step_CanPost

• ManualRun_Run_CanPost

Syntax <module>_<entity>_CanRemoveTests (Tests_List)

where Tests_List is an array of Test IDs.

Type Function

Returns True or False

Availability TestLab_TestSet_CanRemoveTests
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DefaultRes

This event is triggered when a user attempts to reset the defaults for Quality 
Center events. If the function returns False, the defaults are not reset.

DialogBox

This event is triggered when a dialog box is opened or closed.

Syntax <module>_DefaultRes

Type Function

Returns True or False

Availability Project_DefaultRes

Syntax <module>_DialogBox(DialogBoxName, IsOpen)

where DialogBoxName is the name of the dialog box, and 
IsOpen indicates whether the dialog box is open.

Type Sub

Availability • Requirements_DialogBox

• TestPlan_DialogBox

• TestLab_DialogBox

• Defects_DialogBox

• ManualRun_DialogBox
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EnterModule

This event is triggered when the user switches to this Quality Center 
module.

You can add code to this event procedure to perform an action whenever 
the user switches to the specified module. For example, see “Example: 
Detecting an Empty Password” on page 270.

ExitModule

This event is triggered when the user exits the specified module.

Syntax <module>_EnterModule

Type Sub

Availability • Requirements_EnterModule

• TestPlan_EnterModule

• TestLab_EnterModule

• Defects_EnterModule

• ManualRun_EnterModule

Syntax <module>_ExitModule

Type Sub

Availability • Requirements_ExitModule

• TestPlan_ExitModule

• TestLab_ExitModule

• Defects_ExitModule

• ManualRun_ExitModule
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FieldCanChange

This event is triggered before Quality Center changes a field value, to 
determine whether the field can be changed.

You can add code to this event procedure to prevent a field from being 
changed in specific cases. For example, see “Example: Field Validation” on 
page 262.

The code for hiding a field that depends on another field should be placed 
in the FieldChange event procedure (not in the FieldCanChange event 
procedure).

Syntax <module>_<entity>_FieldCanChange(FieldName, NewValue)

where FieldName is the name of the field and NewValue is the 
name of the field value.

Type Function

Returns: True or False

Availability • Requirements_Req_FieldCanChange

• TestPlan_Test_FieldCanChange

• TestPlan_DesignStep_FieldCanChange

• TestLab_TestSet_FieldCanChange

• TestLab_TestSetTests_FieldCanChange

• Defects_Bug_FieldCanChange

• ManualRun_Step_FieldCanChange

• ManualRun_Run_FieldCanChange
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FieldChange

This event is triggered when the value of the specified field changes.

Every change of value triggers the field change event when the field loses 
focus.

You can add code to this event procedure to perform an action when the 
value of a particular field is changed. For example, you can hide or display 
one field depending on the value the user enters into another field. For 
example, see “Example: Changing One Field Based on Another Field” on 
page 259.

When a user changes a field value using the Find > Replace command, 
workflow events are not triggered. If restrictions implemented in workflow 
scripts are critical, consider disabling the Replace command for specific user 
groups, to ensure that your restrictions cannot be bypassed.

Syntax <module>_<entity>_FieldChange(FieldName)

where FieldName is the name of the field.

Type Sub

Availability • Requirements_Req_FieldChange

• TestPlan_Test_FieldChange

• TestPlan_DesignStep_FieldChange

• TestLab_TestSet_FieldChange

• TestLab_TestSetTests_FieldChange

• Defects_Bug_FieldChange

• ManualRun_Step_FieldChange

• ManualRun_Run_FieldChange
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GetDetailsPageName

This event is triggered by Quality Center to retrieve the name of the Defect 
Details dialog box page (tab) that has the index number specified in 
PageNum.

You can add code to this event procedure to customize the tab names on the 
Defect Details dialog box. For example, see “Example: Changing Tab 
Names” on page 257.

GetNewBugPageName

This event is triggered by Quality Center to retrieve the name of the Add 
Defect dialog box page (tab) that has the index number specified in 
PageNum.

You can add code to this event procedure to customize the tab names on the 
Add Defect dialog box. For example, see “Example: Changing Tab Names” 
on page 257.

Syntax <module>_GetDetailsPageName(PageName, PageNum)

where PageName is the default page name (for example, Page 1) 
and PageNum is the page number.

Type Function

Returns String containing the page name

Availability Defects_GetDetailsPageName

Syntax <module>_GetNewBugPageName(PageName, PageNum)

where PageName is the default page name (for example, Page 1) 
and PageNum is the page number.

Type Function

Returns String containing the page name

Availability Defects_GetNewBugPageName
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MoveTo

This event is triggered when the user changes focus from one object to 
another. 

You can add code to this event procedure to perform actions when the user 
changes the focus. For example, see “Example: Presenting a Dynamic Field 
List” on page 263.

MoveToSubject

This event is triggered when the user moves to the specified subject in the 
test plan tree.

Syntax <module>_<entity>_MoveTo

Type Sub

Availability • Requirements_Req_MoveTo

• TestPlan_Test_MoveTo

• TestPlan_DesignStep_MoveTo

• TestLab_TestSet_MoveTo

• TestLab_TestSetTests_MoveTo

• Defects_Bug_MoveTo

• ManualRun_Step_MoveTo

Syntax <module>_MoveToSubject(Subject)

where Subject is the ISysTreeNode interface. For more 
information, refer to the Mercury Quality Center Open Test 
Architecture API Reference.

Type Sub

Availability TestPlan_MoveToSubject
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New

This event is triggered when an object is added to Quality Center.

You can add code to this event procedure to perform an action when a new 
object is added. For example, see “Example: Customizing a Defects Module 
Dialog Box” on page 253. 

RunTests

This event is triggered when the user clicks the Run button to run tests in 
the Test Lab module.

Syntax <module>_<entity>_New

Type Sub

Availability • Requirements_Req_New

• TestPlan_Test_New

• TestPlan_DesignStep_New

• TestLab_TestSet_New

• Defects_Bug_New

• ManualRun_Step_New

Syntax <module>_RunTests(Tests)

where Tests is an array of Test IDs.

Type Sub

Availability TestLab_RunTests
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RunTestSet

This event is triggered when the user clicks the Run Test Set button to run a 
test set in the Test Lab module.

RunTestsManually

This event is triggered when the user clicks the Run arrow and chooses Run 
Manually to run tests in the Test Lab module.

Syntax <module>_RunTestSet(Tests)

where Tests is an array of Test IDs.

Type Sub

Availability TestLab_RunTestSet

Syntax <module>_RunTestsManually(Tests)

where Tests is an array of Test IDs.

Type Sub

Availability TestLab_RunTestsManually
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18
Workflow Object Reference

Workflow scripts can reference Quality Center objects to obtain information 
and to change project values. This chapter lists the Quality Center objects 
that are available to workflow scripts.

This chapter describes the following:

➤ About Quality Center Objects

➤ Actions Object

➤ Action Object

➤ Fields Objects

➤ Field Object

➤ Lists Object

➤ TDConnection Object

➤ User Object

About Quality Center Objects

Workflow scripts can obtain information, make decisions based on that 
information, and change values in the project based on those decisions.

You can obtain information such as the user group to which the current user 
belongs, and the value of a field, by accessing objects such as the User object 
or the Field object.

Your script can change the value of a field, or field list. To do so, the script 
modifies the Value property or the List property of the appropriate Field 
object.
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For information on the event procedures in which you place VBScript code 
to create workflow scripts, see Chapter 17, “Workflow Event Reference”.

The following table lists the Quality Center objects that are available when 
you write a script.

Object Description

Actions The list of actions that are available for the following 
modules: Project, Requirements, Test Plan, Test Lab, 
Defects, and the Manual Runner dialog box. See “Actions 
Object” on page 243.

Action The Action object is handled by the Actions object. See 
“Action Object” on page 244.

Fields The following objects provide access to specific fields:

• Req_Fields: the Requirements module. 

• Test_Fields: tests in the Test Plan module. 

• DesignStep_Fields: design steps in the Test Plan 
module.

• TestSet_Fields: test sets in the Test Lab module. 

• TestSetTest_Fields: tests in the Test Lab module. 

• Bug_Fields: defects in the Defects module and the 
Manual Runner dialog box. 

• Step_Fields: steps in the Manual Runner dialog box. 

• Run_Fields: test runs in the Manual Runner dialog box. 

See “Fields Objects” on page 245.

Field The Field object is handled by the Fields objects. See “Field 
Object” on page 246.

Lists Includes the lists that are available in a Quality Center 
project. See “Lists Object” on page 248.

TDConnection Provides access to open test architecture (OTA) objects. 
See “TDConnection Object” on page 249.

User Includes the properties of the current user. This object is 
available in all modules. See “TDConnection Object” on 
page 249.
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Note: In some cases, a function returns the object itself instead of the ID 
property of the object. For example, after the following statement has been 
executed, testsetf is a reference to a TestSetFolder object: 
Set testsetf = TestSet_Fields("CY_FOLDER_ID").Value.

For information on the Script Editor used to write workflow scripts, see 
Chapter 16, “Working with the Workflow Script Editor”.

For each Quality Center object, this chapter lists the properties of the object. 
The list includes the property name, a description, and the data type of the 
property. It indicates whether the property is read-only (R) or whether your 
script can modify it (R/W).

Actions Object

You can use the Actions object to manipulate toolbar buttons, menu 
commands, and dialog boxes.

For example, to set the Add Defect dialog box to open automatically when a 
user enters the Defects module, place the following code in the 
Defects_EnterModule event procedure:

NewDefectAction=Actions.Action(“BugAddAction1”)
NewDefectAction.Execute

The Actions object has the following property:

Property R/W Type Description

Action R Object Allows access to every action in a list. The 
index for this property is the action name.
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Action Object

You can use the Action object to verify whether a button or command is 
enabled, checked, or visible. You can also use it to execute actions.

For example, to set the Defect Details dialog box to open automatically 
when the user moves from one defect to another in the Defects Grid, place 
the following code in the Defects_Bug_MoveTo event procedure:

NewDefectAction=Actions.Action(“DefectDetailsAction1”)
NewDefectAction.Execute

To obtain the name of an action, add the following lines to the 
ActionCanExecute event procedure for the module, perform the action, and 
note the action name that is printed in the message:

Sub <module>_ActionCanExecute(ActionName)
On Error Resume Next
MsgBox “You have performed an action named: “ & ActionName
On Error GoTo 0

End Sub

This object has the following properties:

Property R/W Type Description

Checked R/W Boolean Indicates whether an action is checked in 
Quality Center. 

Enabled R/W Boolean Indicates whether an action is enabled. A 
disabled action cannot be invoked by the 
user, but can be invoked from the 
workflow script.

Visible R/W Boolean Indicates whether an action is visible in 
Quality Center. 
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The Action object includes the following method:

When a workflow script invokes an action using the Execute method of the 
Action object, the workflow events that would be triggered if a user initiated 
the action from a dialog box, are not triggered. Therefore, when using 
Action.Execute, you must ensure that you do not bypass the site policies you 
are enforcing with workflow events.

Fields Objects

You can use the following objects in workflow scripts to access the fields of 
Quality Center modules: 

Method Description

Execute Executes the action.

Object Description

Req_Fields Provides access to the fields of the Requirements module.

Test_Fields Provides access to the fields of tests in the Test Plan 
module.

DesignStep_Fields Provides access to the fields of the design steps in the Test 
Plan module.

TestSet_Fields Provides access to the fields of the test sets in the Test Lab 
module.

TestSetTest_Fields Provides access to the fields of the tests in the Test Lab 
module.

Bug_Fields Provides access to the fields of the defects in the Defects 
module and the Manual Runner dialog box.

Step_Fields Provides access to the fields of the steps in the Manual 
Runner dialog box.

Run_Fields Provides access to the fields of the test runs in the Manual 
Runner dialog box.
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For example, to set a certain property for all fields in the Req_Fields object, 
you can refer to each field by its ID number (Req_Fields.FieldById). To set all 
fields to be visible (IsVisible) in a dialog box, you can use the following code:

For i = 1 to Req_Fields.Count
Req_Fields.FieldById(i).IsVisible = True

Next

These objects have the following properties:

Field Object

You can use the Field object to access the properties of an entity field.

For example, to display a message box when a user does not have 
permission to change a value in the Status field, you can use the following 
code:

Msgbox "You do not have permission to change <" & _
Bug_Fields.Field("BG_STATUS").FieldLabel & "> field."

Property R/W Type Description

Count R Long Returns the number of fields in the current 
object.

Field
(FieldName)

R Object Accesses the fields by field name or field 
label. 

FieldById
(FieldID)

R Object Accesses the field by the field ID number.
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The Field object has the following properties:

Property R/W Type Description

FieldLabel R String The displayed label of the field.

FieldName R String The logical name of the field.

IsModified R Boolean Specifies whether the value was modified.

IsMultiValue R Boolean Specifies whether the field can contain 
multiple values from a lookup list. 

IsNull R Boolean Specifies whether the field value is absent. 

IsReadOnly R/W Boolean Specifies whether the field is read-only. 

IsRequired R/W Boolean Specifies whether a field value is required. 
This enables you to override field 
customization information. To modify the 
IsRequired property of a field, the IsVisible 
property must be True. Changes to 
IsRequired are ignored if the field is not 
visible. 

Note: This property cannot be used with 
the Run_Fields object to set the fields of a 
run as required.

IsVisible R/W Boolean Specifies whether the field is displayed. 

List R/W List Sets or retrieves the field list attached to a 
field of type lookup list.

PageNo R/W Integer Sets or retrieves the page (tab) on which 
the field is displayed in the Add Defect and 
Defect Details dialog boxes. 

Value R/W Variant Sets or retrieves the value of the field. 

ViewOrder R/W Integer Sets or retrieves the order in which the 
field appears in the Add Defect and Defect 
Details dialog boxes. 
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Lists Object

You can use the Lists object to limit field input to a specific list of values.

For example, to set the list in the Planned Closing Version field, depending 
on the Project field value, you can use the following code:

If Bug_Fields.Field("BG_PROJECT").Value = "Project 1" Then
Bug_Fields.Field("BG_PLANNED_CLOSING_VER").List _
= Lists("All Projects")
...

End If

For more information, see “Example: Presenting a Dynamic Field List” on 
page 263.

The Lists object has the following properties:

Note: When workflow customization has been used to change a list of 
values for a field that has transition rules defined, the field may only be 
modified in a way that satisfies both the workflow script and the transition 
rules. For more information, see “Setting Transition Rules” on page 146.

Property R/W Type Description

List R ISysTreeNode Accesses the Quality Center lists.
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TDConnection Object

In workflow scripts, the only objects that are available are the objects of the 
module in which the code is written and a limited number of global objects. 
One of the global objects is the TDConnection object. TDConnection 
provides access to the open test architecture (OTA) objects.

You can use the TDConnection object to access objects from other modules, 
and to access general session parameters. You can access TDConnection 
properties in any procedure, from any module. 

For more information about the TDConnection object, and a list of 
TDConnection properties, refer to the Mercury Quality Center Open Test 
Architecture API Reference.

For examples of using the TDConnection object in workflow scripts, see 
Chapter 19, “Workflow Examples”.

User Object

You can access the User object to retrieve the user name of the current user 
and to check whether the user belongs to a particular user group. You can 
retrieve or modify the first and last name of the user.

For example, to have a message box open when the user has project 
administrator permissions, use the following code:

If User.IsInGroup("TDAdmin") Then
MsgBox "The user " & User.FullName & _
" has administrative permissions for this project."

End If

For more information, see “Example: Changing a Field Based on the User 
Group” on page 260, and “Example: Controlling User Permissions” on 
page 266.

To access user properties such as the user password, that cannot be accessed 
by the User object, you can use the TDConnection object of the Quality 
Center open test architecture (OTA). For more information, see “Example: 
Detecting an Empty Password” on page 270.
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The User object has the following properties:

Property R/W Type Description

FullName R/W String Sets or retrieves the first and last name of 
the current user.

IsInGroup 
(GroupName)

R Boolean Checks whether or not the current user is 
a member of a predefined/user-defined 
group. 

UserName R String Returns the user name used when logging 
in to Quality Center. 
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19
Workflow Examples

This chapter provides the following examples of workflow scripts:

➤ About the Workflow Examples

➤ Example: Customizing a Defects Module Dialog Box

➤ Example: Changing Tab Names

➤ Example: Adding a Template to a Memo Field

➤ Example: Changing One Field Based on Another Field

➤ Example: Changing a Field Based on the User Group

➤ Example: Object Validation

➤ Example: Field Validation

➤ Example: Presenting a Dynamic Field List

➤ Example: Changing Field Properties when a Field Changes

➤ Example: Controlling User Permissions

➤ Example: Adding Button Functionality

➤ Example: Error Handling

➤ Example: Obtaining the Session Context

➤ Example: Obtaining Session Properties

➤ Example: Detecting an Empty Password

➤ Example: Sending Mail

➤ Example: Storing the Last Values Entered

➤ Example: Copying Field Values to Another Object
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About the Workflow Examples

The workflow examples presented in this chapter perform several types of 
task. The following table lists the examples that illustrate each type of task.

Workflow Task See Examples

dialog box 
customization

Example: Customizing a Defects Module Dialog Box

Example: Changing Tab Names

field value 
automation

Example: Adding a Template to a Memo Field

Example: Changing One Field Based on Another Field

Example: Changing a Field Based on the User Group

data validation Example: Object Validation

Example: Field Validation

dynamic field 
customization

Example: Presenting a Dynamic Field List

Example: Changing Field Properties when a Field Changes

user permission 
control

Example: Controlling User Permissions

functionality Example: Adding Button Functionality

error handling Example: Error Handling

using OTA to obtain 
session parameters

Example: Obtaining the Session Context

Example: Obtaining Session Properties

Example: Detecting an Empty Password

sending mail Example: Sending Mail

the Settings object Example: Storing the Last Values Entered

copying values 
between modules

Example: Copying Field Values to Another Object
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Example: Customizing a Defects Module Dialog Box

This example shows how you can customize the field layout and other field 
properties in the Add Defect dialog box. You can create similar code to 
arrange the layout of the Defect Details dialog box.

This example illustrates a solution that customizes field properties for all 
user groups. You can also use the script generators to customize the layout of 
the Defects module dialog boxes. If you use the script generators, you must 
perform customization separately for each user group. For information on 
these script generators, see “Customizing Defects Module Dialog Boxes” on 
page 194.

This example involves the following two procedures:

➤ SetFieldApp is a general purpose procedure that receives a field name and 
its properties as parameters, and assigns the properties to the field. See 
“SetFieldApp” on page 254.

➤ FieldCust_AddDefect calls SetFieldApp for each field in the Add Defects 
dialog box, to set the properties of the field. For some of the fields, 
FieldCust_AddDefect checks the user group to which the current user 
belongs, and customizes the field properties accordingly. A call to 
FieldCust_AddDefect is placed in the Defects_Bug_New event procedure. 
See “FieldCust_AddDefect” on page 254.

Note: To implement this example, you can run the Add Defect Field 
Customization script generator and then modify the resulting scripts.

➤ Rename the generated function WizardFieldCust_Add to 
FieldCust_AddDefect and modify it as necessary. (Before you modify a 
generated script, you must rename it so that it is not overwritten the next 
time you run the script generator.)

➤ The script generator places a call to WizardFieldCust_Add in the event 
procedure Defects_Bug_New. Change this to FieldCust_AddDefect.

➤ The function SetFieldApp is generated when you run the script generator. 
You do not need to rename or modify this function.
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SetFieldApp

The function SetFieldApp receives a field name and its properties as 
parameters, and assigns the properties to the field.

The function assigns the following field properties: field visibility, whether 
the field is required, the number of the page (tab) on which the field should 
be displayed, and the view order (from left to right and from top to bottom).

Add a call to the function SetFieldApp in the user-defined function 
FieldCust_AddDefect.

Sub SetFieldApp(FieldName, Vis, Req, PNo, VOrder)
On Error Resume Next
With Bug_Fields(FieldName)

.IsVisible = Vis

.IsRequired = Req

.PageNo = PNo

.ViewOrder = VOrder
End With
PrintError “SetFieldApp”
On Error GoTo 0

End Sub

FieldCust_AddDefect

The user-defined function FieldCust_AddDefect calls the function 
SetFieldApp.

The function first sets all fields to be invisible, not required, and to appear 
on page 100 at location 0. This ensures that if you add a new field using the 
Customize Project Entities link on the Project Customization window, the 
layout will not be changed.

Add a call to FieldCust_AddDefect in the Defects_Bug_New event procedure 
so that it will be triggered when a user adds a new defect:

Sub Defects_Bug_New
FieldCust_AddDefect

End Sub
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First, the code handles the fields that are common to all user groups. It uses 
conditional statements for the fields that will appear in the dialog box only 
for specific user groups, or that will have different properties for different 
users.

Sub FieldCust_AddDefect
On Error Resume Next
For i= 0 To Bug_Fields.Count
SetFieldApp Bug_Fields.FieldByID(i), False, False, 100, 0

Next

ViewNum = 0
PageNum = 0

SetFieldApp "BG_BUG_ID", True, True, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_DESCRIPTION", True, False, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_SUMMARY", True, True, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_DETECTED_BY", True, True, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_DETECTION_DATE", True, True, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_DETECTION_VERSION", True, True, PageNum, _
ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_SEVERITY", True, True, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_PRIORITY", True, True, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_PROJECT", True, False, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_REPRODUCIBLE", True, False, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_STATUS", True, False, PageNum, ViewNum
ViewNum = ViewNum + 1



Part III • Workflow Customization

256

‘ Now handle fields that are different for different user groups 

If User.IsInGroup("Developer") Then
SetFieldApp "BG_PLANNED_CLOSING_VERSION", True, False, _
PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_PLANNED_FIX_TIME", True, False, PageNum, _
ViewNum
ViewNum = ViewNum + 1

End If

If User.IsInGroup("QATester") Then
PageNum = PageNum + 1
SetFieldApp "BG_USER_01", True, False, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_USER_02", True, False, PageNum, ViewNum
ViewNum = ViewNum + 1

End If

SetFieldApp "BG_ACTUAL_FIX_TIME", True, False, PageNum, _
ViewNum
ViewNum = ViewNum + 1

:

PrintError “FieldCust_AddDefect”
On Error GoTo 0

End Sub
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Example: Changing Tab Names

You can change the names of the tabs on the Add Defect dialog box. This 
example sets the tabs to General, Environments, and Business Case.

Add the following code to the Defects_GetNewBugPageName event 
procedure, which is triggered before Quality Center opens the Add Defect 
dialog box. To change the tab names on the Defect Details dialog box, add 
similar code to the event procedure Defects_GetDetailsPageName.

Function Defects_GetNewBugPageName(PageName, PageNum)
On Error Resume Next
Select case PageNum

case "1"
Defects_GetNewBugPageName="General"

case "2"
Defects_GetNewBugPageName="Environments"

case else
Defects_GetNewBugPageName="Business Case"

End Select
PrintError “Defects_GetNewBugPageName”
On Error GoTo 0

End Function
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Example: Adding a Template to a Memo Field

You can use workflow scripts to add a default template to a memo field. This 
example adds text to a memo field called Business Case to display the 
following template:

Perform this customization by placing the HTML code for the text into the 
BG_USER_25 field when a defect is added. This example assumes that the 
user-defined field BG_USER_25 is used to store a business case string.

Add the code to the Defects_Bug_New event procedure, which is triggered 
when a user adds a new defect.

Sub Defects_Bug_New
On Error Resume Next
Bug_Fields("BG_USER_25").value = _
"<html><body><b>Step by step scenario:</b>" & _
"<br><br><br><b>How it affects the user:</b></body></html>"
PrintError “Defects_Bug_New”
On Error GoTo 0

End Sub
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Example: Changing One Field Based on Another Field

This example demonstrates how you can change a field value based on the 
value entered into another field.

For example, you can cause defects to be assigned to user alex_qc when 
UI Suggestion is entered into the Category field, and to user alice_qc when 
Security Issues is entered.

The example assumes that the user-defined field BG_USER_05 is used to 
store the category. When the Category field is changed in the Defects 
module, the BG_RESPONSIBLE field is assigned the appropriate value.

Add the code to the Defects_Bug_FieldChange event procedure so that it is 
triggered when a user changes a field value in the Defects module.

Sub Defects_Bug_FieldChange(FieldName)
On Error Resume Next
If FieldName = "BG_USER_05" then

Select case Bug_Fields("BG_USER_05").Value
case "UI Suggestion"

Bug_Fields("BG_RESPONSIBLE").value="alex_qc"
case "Security Issue"

Bug_Fields("BG_RESPONSIBLE").value="alice_qc"
End Select

End If
PrintError “Defects_Bug_FieldChange”
On Error GoTo 0

End Sub
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Example: Changing a Field Based on the User Group

This example demonstrates how you can change a field value according to 
the user group of the user entering the defect.

In this example, the user-defined field BG_USER_01 is a detection mode field 
in which the user who detected the defect can enter the way in which it was 
discovered. Possible values are Formal testing, Informal testing, and BTW.

The example sets the value of the detection mode field to BTW when a 
defect is opened by a user who is not in the QA Tester group.

Add the code to event procedure Defects_Bug_New, so that it is triggered 
when a defect is added.

Sub Defects_Bug_New
On Error Resume Next
If not User.IsInGroup("QATester") then

Bug_Fields("BG_USER_01").Value = "BTW"
End If
PrintError “Defects_Bug_New”
On Error GoTo 0

End Sub
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Example: Object Validation

This example demonstrates how you can perform validations of all fields by 
using the CanPost event procedure. For example, this code segment ensures 
that a user cannot reject a defect without adding a comment.

In this example, a user may not post a defect where the defect status 
(BG_STATUS) has been changed to Rejected unless some explanatory text 
has been entered in the R&D Comment field (BG_DEV_COMMENTS).

Add the code to the Defects_Bug_CanPost event procedure so that the check 
is performed when the user attempts to submit the defect.

Function Defects_Bug_CanPost
On Error Resume Next
If Bug_Fields("BG_STATUS").IsModified and _
Bug_Fields("BG_STATUS").Value = "Rejected" and _
not Bug_Fields("BG_DEV_COMMENTS").IsModified then

Defects_Bug_CanPost = False
msgbox "You must enter a comment when rejecting a defect."

Else
Defects_Bug_CanPost = True

End If
PrintError “Defects_Bug_CanPost”
On Error GoTo 0

End Function
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Example: Field Validation

This example demonstrates how to validate a single field value. For example, 
the following code segment shows how you can ensure that a user in a 
specific group cannot lower the priority of a defect.

In this example, if the user is in the QATester group and the BG_PRIORITY 
field is being modified, the new value of the BG_PRIORITY field cannot be 
lower than the current value. 

This example assumes that in the Priority field list for the project, lower 
priorities come first when the values are sorted in ascending order. For 
example, the list meets this requirement if the elements are as follows: 
1-Low, 2-Medium, 3-High.

Add the code to the Defects_Bug_FieldCanChange event procedure so that it 
is triggered when the user attempts to change a field value in the Defects 
module.

Function Defects_Bug_FieldCanChange(FieldName, NewValue)
On Error Resume Next
If User.IsInGroup("QATester") and FieldName ="BG_PRIORITY" Then

If NewValue < Bug_Fields("BG_PRIORITY").Value then
Defects_Bug_FieldCanChange = False
msgbox "You do not have permission to lower defect priority."

Else
Defects_Bug_FieldCanChange = True

End If
End If
PrintError “Defects_Bug_FieldCanChange”
On Error GoTo 0

End Function
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Example: Presenting a Dynamic Field List

This example demonstrates how you can present a different field list in a 
field, depending on the value of another field.

The user-defined function SW_SetLists_Environment checks the value of the 
Environment Specification field and assigns the appropriate field list to the 
Environment Type field.

This example assumes that the field lists have been defined in the project. 
For more information, see “Customizing Project Lists” on page 175.

Note: To use workflow scripts to change or create lists that can be assigned 
to fields, you must use the open test architecture (OTA) interface.

Add code to the Defects_Bug_MoveTo event procedure so that the 
user-defined function SW_SetLists_Environment is called when the user 
changes focus in the defects module.

Sub Defects_Bug_MoveTo()
On Error Resume Next
SW_SetLists_Environment
PrintError “Defects_Bug_MoveTo”
On Error GoTo 0

End Sub

Add code to the Defects_Bug_FieldChange event procedure so that the 
user-defined function SW_SetLists_Environment is called when a user 
changes the value of the Environment Type field in the Defects module.

Sub Defects_Bug_FieldChange(FieldName)
On Error Resume Next
If FieldName = "BG_USER_01" then
SW_SetLists_Environment

End If
PrintError “Defects_Bug_FieldChange”
On Error GoTo 0

End Sub
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The user-defined function SW_SetLists_Environment checks the value of the 
Environment Specification field (BG_USER_02) and assigns the appropriate 
field list to the Environment Type field (BG_USER_01).

Sub SW_SetLists_Environment()
Dim listName
On Error Resume Next
Select Case Bug_Fields("BG_USER_01").Value
Case "Browser"

listName = "Browsers"
Case "Database Type"

listName = "Database Type"
Case "Operating System"

listName = "Platform"
Case "Web Server"

listName = "Web Server"
Case Else

listName = "Environment Specification"
End Select
Bug_Fields("BG_USER_02").List = Lists(listName)
PrintError ("Set Environment List")
On Error GoTo 0

End Sub
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Example: Changing Field Properties when a Field Changes

This example demonstrates how you can change the properties of a field 
when a different field is changed.

In this example, if the status of the defect (BG_STATUS) is changed to 
Closed, the user must provide a value in the field Closed in Build 
(BG_CLOSING_VERSION).

Add the code to the Defects_Bug_FieldChange event procedure, to make the 
Closed in Build field a required field if the status is changed to Closed.

Sub Defects_Bug_FieldChange(FieldName)
On Error Resume Next
If FieldName= "BG_STATUS" and _
Bug_Fields("BG_STATUS").value="Closed" then

Bug_Fields("BG_CLOSING_VERSION").IsRequired=True
End If
PrintError “Defects_Bug_FieldChange”
On Error GoTo 0

End Sub
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Example: Controlling User Permissions

This example demonstrates how you can prevent members of specific user 
groups from performing an action.

The code allows a user to replace a defect field value only if the user belongs 
to the Admin user group.

Add the code to the Defects_ActionCanExecute event procedure so that the 
check is performed when a user attempts to execute an action.

Function Defects_ActionCanExecute(ActionName)
On Error Resume Next
If ActionName = "BugReplaceAction1" _

And Not User.IsInGroup("Admin") then
Defects_ActionCanExecute = False
msgbox "You do not have permission to perform this action"

Else
Defects_ActionCanExecute = True

End If
PrintError “Defects_ActionCanExecute”
On Error GoTo 0

End Function
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Example: Adding Button Functionality

This example opens a calculator when a user clicks a button defined with 
action name Calculator.

Add the code to the Defects_ActionCanExecute event procedure, so that it is 
triggered when a user initiates an action.

For information about the Wscript.Shell object, refer to the Microsoft 
documentation. To access help for the VBScript language, choose Help > 
VBScript Home Page in the Script Editor.

Function Defects_ActionCanExecute(ActionName)
On Error Resume Next
If ActionName = "Calculator" Then

Set shell = CreateObject("Wscript.Shell")
shell.Run "Calc"
set shell = Nothing

End If
Defects_ActionCanExecute = Project_DefaultRes
PrintError “Defects_ActionCanExecute”
On Error GoTo 0

End Function

Example: Error Handling

This example demonstrates how you can display a standard error message. 
Error handling should be added to each workflow script that you write, 
because errors that are not detected by the workflow code can cause the 
user’s browser to crash.

The user-defined function PrintError receives the name of the calling 
procedure as a parameter. If an error has occurred, PrintError prints out the 
error number, description and severity, and the name of the procedure in 
which the error occurred.
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You do not need to create an Err object, because it is intrinsic to VBScript. 
For more information about the Err object, refer to the Microsoft 
documentation.

Sub PrintError(strFunctionName)
If Err.Number <> 0 Then

MsgBox "Error #" & Err.Number & ": " & Err.Description, _
vbOKOnly+vbCritical, _
"Workflow Error in Function " & strFunctionName

End If
End Sub

The following code segment illustrates how you can add error handling to 
your subroutines.

Sub <sub_name>()
On Error Resume Next
:
[Your code here]
:
PrintError "<sub_name>"

End Sub

The following code segment illustrates how you can add error handling to 
your functions.

Function <function_name>()
On Error Resume Next
:
[Your code here]
:
PrintError "<function_name>"

End Function
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Example: Obtaining the Session Context

You can use the TDConnection object in a workflow script to retrieve 
information about the session in which the user is working at the time that 
the script is executed. 

In the following example, the server time is displayed in a message box:

MsgBox "The current time on the server is: " & TDConnection.ServerTime

Example: Obtaining Session Properties

This example demonstrates how to use the TDConnection object to obtain 
the properties of the current session. Add the code to the procedure where 
these properties are needed. The properties do not depend on each other, so 
each of the properties can be retrieved separately.

The following are examples of session properties: 

TDConnection.ServerName
TDConnection.ServerTime
TDConnection.DomainName
TDConnection.ProjectName
TDConnection.Password
User.UserName

Note that there is no need to use TDConnection to retrieve the user name 
because the workflow has a predefined User object. For more information, 
see “TDConnection Object” on page 249.

The example below tests the first five characters of the server URL to 
determine whether the user is connected to the server using HTTP or HTTPS:

If Left(UCase(TDConnection.ServerName), 5) = "HTTPS" Then
MsgBox "You are currently connected to the server using SSL."

Else
MsgBox "You are not using SSL."

End If
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Example: Detecting an Empty Password

This example accesses TDConnection to retrieve the password of the current 
user. It prints a message if the user has an empty password.

The following user-defined function is added to the common script section 
so that it can be accessed from all modules. 

Function CheckPassword
On Error Resume Next
If isObject(TDConnection) Then

Set tdc = TDConnection
currentPwd = tdc.Password
If len(currentPwd) < 1 Then

MsgBox "Your password is empty (null).” & _ 
“Please change your password (Tools -> Change Password).", 0, _
"Your Password Is Empty"

End If
End If
On Error GoTo 0

End Function

Add the following lines to the EnterModule event procedure for each module 
so that a user with an empty password receives a message when they enter 
the module. This example is for the Defects module:

Sub Defects_EnterModule
On Error Resume Next
CheckPassword
On Error GoTo 0

End Sub
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Example: Sending Mail

These examples demonstrate how to use the TDConnection object to send 
mail from the Defects module, and to send mail when a field value changes 
in the Test Plan module.

Sending Mail from the Defects Module

This example sends mail from the Defects module. 

Add a call to the SendDefect procedure in the Defects_Bug_AfterPost event 
procedure. 

Note: If the SendDefect procedure is called before the defect is submitted, 
the values that were changed in the current modification will not be 
included. The database is updated with the new values only after the defect 
is posted.

Sub SendDefect (iObjectId, strTo, strCc, strSubject, strComment)
On Error Resume Next
Dim objBugFactory, objBug
Set objBugFactory = TDConnection.BugFactory
Set objBug = objBugFactory.Item(iObjectId)
objBug.Mail strTo, strCc, 2, strSubject, strComment
Set objBug = Nothing
Set objBugFactory = Nothing
PrintError "SendDefect"
On Error Then GoTo 0

End Sub

The constant 2 in the call to objBug.Mail indicates that the history should be 
included with the mail. For a list of the constants that can be used to 
customize e-mail, refer to the tagTDMAIL_FLAGS enumeration in the 
Mercury Quality Center Open Test Architecture API Reference. In workflow 
scripts, use numeric constants and not the enumeration values.
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Sending Mail When a Test Plan Module Field Value Changes

The example below demonstrates how a similar function could be called 
when the value of the status field is changed in the Test Plan module.

The code is added to the TestPlan_Test_FieldChange event procedure. It 
constructs a subject and comment for the e-mail, and calls a user-defined 
function, SendTest. SendTest sends mail from the Test Plan module. You 
would code SendTest similarly to the SendDefect subroutine shown in 
“Sending Mail from the Defects Module” on page 271.

Sub TestPlan_Test_FieldChange(FieldName)
On Error Resume Next
Dim strSubject, strComment
If FieldName = "TS_STATUS" Then

strSubject = "Test Change Notification" & _
" for project " & TDConnection.ProjectName & _
" in domain " & TDConnection.DomainName

strComment = "The user " & User.FullName & _
" changed the status of the test " & _
Test_Fields("TS_NAME").Value & _
" to " & Test_Fields("TS_ STATUS").Value

SendTest Test_Fields("TS_TEST_ID").Value, _
Test_Fields("TS_RESPONSIBLE").Value, "[QA Testers]", _
strSubject, StrComment

End If
End Sub
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Example: Storing the Last Values Entered

This example shows how to use the TDConnection object to implement 
persistent data between actions. The lifetime of a variable in a routine is 
only for the routine run. Therefore, persistent data must be stored if it must 
be available later. It is recommended that you use the Quality Center API to 
store persistent data whenever possible instead of using external objects, 
files, or the registry.

In this example, a user-defined function SW_KeepLastValue uses the 
Settings object to save the values entered into the fields 
BG_DETECTION_VERSION, BG_USER_01, and BG_USER_03 when a user 
posts a defect. These values are retrieved and assigned as default values 
when this user adds a new defect.

The user-defined function is called with the SET action from 
Defects_Bug_CanPost, before a new defect is posted by the user. The values 
in the fields are stored.

Function Defects_Bug_CanPost() 
If Bug_Fields("BG_BUG_ID").Value = "" Then
SW_KeepLastValue ("SET")

End If
End Function

The function is called with the GET action from the Defects_Bug_New event 
procedure. When a user adds a new defect, the values stored in the fields for 
this user are entered into these fields.

Sub Defects_Bug_New()
SW_KeepLastValue ("GET")

End Sub 
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Depending on the action passed as a parameter, the user-defined function 
SW_KeepLastValue stores the values of the fields in the common settings 
table for the current user, or reads the values from the Settings object and 
assigns the values to the appropriate fields.

Sub SW_KeepLastValue(action)
Dim tdc, vals, flds
Dim uset, pairs, pair
Dim bld
On Error Resume Next

bld = ""
Set tdc = TDConnection
Set uset = tdc.UserSettings

If action = "SET" Then
flds = Array("BG_DETECTION_VERSION", _
"BG_USER_01", "BG_USER_03")
vals = ""
For i = 0 To UBound(flds)

If vals <> "" Then vals = vals & ";"
vals = vals & flds(i) & "=" & Bug_Fields(flds(i)).Value

Next
'Open category KeepLValueSetting
uset.Open ("KeepLValueSetting")
'Setting KeepValueFields in category KeepLValueSetting
uset.Value("KeepValueFields") = vals
uset.Close

End If ‘SET
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If action = "GET" Then
uset.Open ("KeepLValueSetting")
vals = uset.Value("KeepValueFields")
If vals <> "" Then

pairs = Split(vals, ";")
For i = 0 To UBound(pairs)

pair = Split(pairs(i), "=")
If UBound(pair) = 1 Then

Select Case pair(0)
Case "BG_USER_03"

bld = pair(1)
Case Else

If Bug_Fields(pair(0)).Value = "" Then
Bug_Fields(pair(0)).Value = pair(1)

End If
End Select
If Bug_Fields("BG_DETECTION_VERSION").Value <> "" _
And bld <> "" Then

SW_SetLists_VersionsBuilds _
"BG_DETECTION_VERSION", _
"BG_USER_03"
Bug_Fields("BG_USER_03").Value = bld
If Err.Number <> 0 Then Err.Clear

End If ‘Bug_Fields
End If ‘UBound(pair)

Next
End If ‘vals <> ""

End If ‘GET

uset.Close

PrintError ("Keep Last Value (" & action & ")")
On Error GoTo 0

End Sub
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Example: Copying Field Values to Another Object

This example shows how to use the TDConnection object to copy the value 
from the Build Number field of a Run (RN_USER_02) to the Last Ran On 
Build field of a Test in a Test Set (TC_USER_03). 

Add the code to the ManualRun_Run_AfterPost event procedure.

Sub ManualRun_Run_AfterPost
On Error Resume Next
Set TSFactory = TDConnection.TestSetFactory
Set TS = TSFactory.Item(Run_Fields("RN_CYCLE_ID").value)

Set TSTestFactory =TS.TSTestFactory
Set TSTest = TSTestFactory.Item(Run_Fields("RN_TEST_ID").Value)

TSTest.Field("TC_USER_03") = Run_Fields("RN_USER_02")
TSTest.Post

Set TSFactory = Nothing
Set TS = Nothing
Set TSTestFactory =Nothing
Set TSTest = Nothing

PrintError ("ManualRun_Run_AfterPost")
On Error GoTo 0

End Sub
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A
Verifying Quality Center Server 
Components

After installing Quality Center, you can use the Quality Center Checker to 
verify that the main Quality Center server components are successfully 
installed. You can also verify information such as directory paths, operating 
systems, and port availability.

The Quality Center Checker is a diagnostic tool that tests many of the 
Quality Center server components that Quality Center uses. Running the 
Quality Center Checker can pinpoint the cause of many server side 
problems associated with accessing Quality Center. 

The following components are verified by the Quality Center Checker:

Component Description

Computer Information Verifies information about the operating system.

<application server name> 
Application Server

Verifies information about your application server 
such as directory paths, operating system, ports, 
and service packs.

File System Verifies that sufficient disk space is available.

Site Administrator 
Information

Verifies the configuration of the database server and 
the Site Administration database. Also verifies your 
Quality Center license.

Application 
Communication

Verifies the connection between Quality Center and 
Site Administration.
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To verify Quality Center server components:

 1 To open the Quality Center Checker:

➤ From Windows: Choose Start > Programs > Mercury Quality Center > 
Mercury Quality Center Checker. Alternatively, run the qcchecker.bat file 
from the ..\MercuryInteractive\Quality Center\qcchecker\bin directory.

➤ From Linux or Solaris: Run the qcchecker.sh file from the 
..\MercuryInteractive\Quality Center\qcchecker\bin directory.

The Quality Center Checker window opens.

You can expand and collapse all branches in the components tree. To 
expand all branches, right-click any branch and choose Expand All. To 
collapse all branches, right-click any branch and choose Collapse All.
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 2 To verify the status of the server components, you can:

➤ Select a branch and click the Run Selected button or choose Run > Run 
Selected. 

➤ Click the Run All button or choose Run > Run All to verify all 
components.

 3 If a parameter value is required to run a component, the Required 
Parameters dialog box opens.

Click the Value box of the required parameter and type the value. Click 
Continue. The verification process continues.

Note that to view whether parameters are required before you start verifying 
a component, select the branch and choose Run > Required Parameter. If 
parameters are required the Required Parameters dialog box opens.
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 4 In the right pane of the Quality Center Checker window, you can view a 
report of the verified components.

The report displays description, status, and information on each branch that 
was verified. To view additional report information, choose View > Show 
Properties.

The status bar indicates the status of the verified components. Passed 
components are displayed in green with a check mark. Failed components 
are displayed in red with an X. Components that may lead to problems and 
require the attention of the Quality Center site administrator are displayed 
in yellow with an exclamation point. 

 5 To clear all results, click the Clear All Results button or choose File > Clear All 
Results.

 6 To save all results, click the Save All Results button or choose File > Save All 
Results.

 7 To close the Quality Center Checker, choose File > Exit.
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